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1. Introduction

Thank you for choosing Zetadocs for Microsoft Dynamics NAV. The aim of this document is to guide you
through the installation of Zetadocs for NAV. The document contains a brief overview of Zetadocs and then
provides a step by step guide as to how to install Zetadocs for NAV. It is recommended that you read the
installation guide before starting an installation.

1.1 Microsoft Dynamics NAV Compatibility

This product has been developed and tested against Microsoft Dynamics NAV version 4.0, 5.0 and 6.0. SP1

1.2 Installation Pack Contents
The software is supplied on a CD and contains the following:

Zetadocs NAV Server Components
Folder containing the updates for NAV and installation support files:
o NAV .fob files containing code/table/form/pages etc. objects to import into NAV

Zetadocs for NAV Client
Installs everything that is needed on the end user desktop:
e Zetadocs Client application with NAV extensions
e Zetadocs API runtime
Target OS: Windows Server 2008, Windows Server 2003, Windows 7, XP, Vista,

Zetadocs SharePoint Extensions
Contains:
e SharePoint Extensions installer

Target OS: Windows Server 2008, Windows Server 2003,
SharePoint 2007 MOSS and (WSS) v3.0 and SharePoint 2010 full and foundation.

Zetadocs Server
Contains:
e Zetadocs Server Installer
Target OS: Windows Server 2008, Windows Server 2003,

Documentation
e Documentation (installation, configuration and deployment instructions)
e Zetadocs for NAV help files

Supported Languages

e Dutch
e French
e English

Note: NAV objects available for NAV database language versions NA, NL, BE, W1 and GB.

1.3 Technical Specifications
This section details the minimum system requirements suitable for using Zetadocs for NAV.

Client Operating systems supported
e Windows 7 (32-bit and 64-bit)
e Windows Vista Business, Ultimate and Enterprise (32-bit and 64-bit)
e Windows XP Professional (32-bit)
e Windows Server 2008 R2 (64-bit)
e Windows Server 2008 R2 with Remote Desktop Services
e Windows Server 2008 Standard Edition (32-bit and 64-bit)
e Windows Server 2008 with Windows Terminal Services
e  Windows Server 2008 with Citrix Presentation Server 4.5
e  Windows Server 2003 Standard Edition (32-bit and 64-bit)
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e Windows Server 2003 with Windows Terminal Services
e Windows Server 2003 with Citrix Presentation Server 4.5

e Requires Microsoft.NET Framework® version 2.0

e Integrates with Microsoft Office Outlook® 2003 SP2, Microsoft Office Outlook 2007 and Microsoft
Office Outlook 2010

e Integrates with Lotus® Notes® V6.5 and above

e Integrates with SMTP email systems

e Active Directory® integration for rapid and easy deployment to all network users

Client Hardware requirements
e |tis recommended that systems have Pentium® class CPUs of 1 GHz or higher with 1GB RAM or

more

PDF capabilities

e Create PDF files which are readable using Adobe® Reader® software version 5 and later

e Supports PDF attachments created in PDF 1.2, 1.3, 1.4 and 1.5 standards
Specify PDF security options such as allow printing, content extraction and password protection
Password protection using 40-bit and 128-bit encryption

Other software requirements
e Integrates with NAV version 4.0, version 5.0 and version 6.0 SP1 (x86 or running 32 bit on x64).
e Supports Microsoft Office SharePoint Server (MOSS) 2007 and Windows SharePoint Services
(WSS) v3.0 (x86 or running 32 bit on x64).
e Supports Microsoft Office SharePoint 2010

Glossary of Terms

Term Description

Document Any printable document that can be printed to the Zetadocs printer.
Typically refers to an NAV Report in this document.

Report A NAV Report
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2. Overview of Zetadocs for NAV

Zetadocs for NAV helps accounts departments streamline business processes, reduce the costs of handling
paper documents and enhance customer service. It enables Microsoft Dynamics NAV users to create and
deliver statements, invoices, remittances and other financial documents instantly from their PC. Zetadocs
archives documents to Microsoft SharePoint so they can be retrieved promptly, enabling users to respond
to queries instantly.

Zetadocs for NAV enhances document workflows in NAV in 3 main areas:

2.1 Document Delivery

Producing, packaging and posting statements, invoices and remittances is a time consuming and costly
process. Zetadocs for NAV enables users to deliver accounting documents instantly by email or fax,
removing the cost of printing and postage and reducing the time accounts staff spend on administrative
tasks. Simple rules can be set up to deliver business documents appropriately by email and fax, as well as
being printed, so that customers can have the choice of how they receive information. Zetadocs for NAV
makes it straightforward for users to create and send NAV documents singly or in batches.

2.2 Document Archiving and Retrieval

Zetadocs for NAV automatically archives copies of all documents that have been sent, allowing for quick
retrieval. Accounts staff will no longer waste time searching for paper documents and storage costs will be
reduced, helping companies to meet compliance guidelines. Zetadocs for NAV archives to SharePoint so
that non NAV users such as sales people can access key documents easily, without relying on assistance
from the accounts team.

2.3 Document Capture

Zetadocs for NAV manages the capture and storage of paper and electronic documents that are entered on
NAV. For example, it can store copies of inbound sales orders electronically, whether they are received on
paper, by fax or by email. This reduces the risk of incoming documents being lost or misfiled. If you choose
to install the Zetadocs Server it will automatically convert compatible documents into pdf in preparation for
storage in SharePoint. Capture can also provide a range of other features such as Optical Character
Recognition (OCR), Barcode recognition and Document Queues.

2.4 How Zetadocs Delivers Documents from NAV

When printing a report that has been setup for Zetadocs, a Sales Order report for example, you are actually
running a special Zetadocs stub report. This stub report alerts Zetadocs that you are running a Sales Order
report and instructs NAV to run the report. After selecting the desired records and selecting print Zetadocs
analyses each record in turn against the Zetadocs Rules. These rules will be covered in more depth later in
the system configuration section 10.6 but basically a rule is a collection of settings which are applied when
sending a document. These include details such as the recipient, delivery method (Email, Fax, Hard Copy),
Archiving settings and the Zetadocs Template to apply.

Zetadocs for NAV rules come in four levels which allow you to automate your document delivery, on printing
a document to Zetadocs the rules are applied in descending order until one matches the situation.

Using rules it is possible to be highly specific about the way documents are handled allowing a great deal of
automation of the delivery process.

Rules Levels:
1. The Default Rule — a basic rule that can be used by any Zetadocs enabled report.
2. Per Document Set — specific settings for Zetadocs enabled documents by type.
3. Per Company — specific settings for Zetadocs enabled documents by company.
4. Per Company, per Document Set — specific settings applied to specific document types when sent
to a specific company.

Rule levels are much easier to understand by looking at an example. The diagram in Figure 1 demonstrates
the delivery process which should help you trace the document delivery process as we work through the
example.

Our NAV user needs to send out three Sales Orders to different customers called Sample Company 1, 2 and

3. In an effort to cut down on delivery costs the standard way of sending documents (default level 1 rule) is
to send using email and SharePoint archiving is on, the standard way of sending Sales Orders is via Email
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using the Sales Order Template (Lv2 rule per document set). There are numerous other settings available
when creating rules but we will focus on delivery method to keep this example simple.

Record 1 Sales Order 33659
Company Sample Company 1
Rule Setup No specific company rules (Lv3 and Lv4 rules).

Record 2 Sales order 33660

Company Sample Company 2
Rule Setup This company likes to receive all correspondence via Fax (Lv3 per Company Rule).

Record 3 Sales Order 33661
Company Sample Company 3
Rule Setup This company likes to receive most correspondence via fax however they are happy to receive

Sales Orders via email (Lv3 and Lvy4 rules).

On selecting Print in the Sales Order card they are asked to filter to the desired records, on pressing Print
again each record in the print job will be processed in turn. On processing the Zetadocs rule settings are
interrogated to determine the delivery information to associate with the record.

For our first record this would set delivery to email and the template to the Sales Order template. The
details necessary to delivery and archive are attached as Embedded Commands.

The second record is then considered, the level 3 rule for this means that Fax is the chosen delivery method
again the details necessary to delivery and archive are attached as Embedded Commands.

The final record has both level 3 and 4 rules, as level 4 rules override those below the document is set to be
delivered by email. The records are then gathered together and sent as a single print job to the Zetadocs
Client. Here the embedded commands are removed and analysed, the templates are applied and the email
message body is created as shown below with values from NAV in red. This provides automated generation
of personalised correspondence, with the delivery information also set the documents are ready to be
delivered and archived.

Subject: Order Confirmation for order number: 33659 for Sample Company 1
Message Body:
FAQ: John Smith
Dear Customer,

I'm pleased to attach your order confirmation, reference number 33659.
Kind regards,

Sales Team
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Print NAV Report
Filter to Desired Records

Zetadocs Zetadocs Zetadocs
Embedded Embedded Embedded
Commands Commands Commands

The report is selected for printing, options are provided to filter out the desired
records.

Each record has embedded commmands created and attached based on the
Zetadocs rules.

Once all selected records are processed they are passed to Zetadocs as a single
print job.

Zetadocs removes the embedded commands and analyes them for the delivery
information.

Addressing, stationery and the message body are created and the documents are
delivered to the recipients and archived.

Figure 1 - Zetadocs for NAV Document Delivery Overview
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3. Assessing your Installation Requirements

We would recommend that before you begin your installation that you assess which of the various Zetadocs
elements you are adding to your system. Zetadocs for NAV offers four main product offerings tailored to suit
various needs.

3.1 Zetadocs Delivery Essentials
Provides the core functionality of Zetadocs for NAV, with delivery rules to automate document delivery and
SharePoint archiving.

3.2 Zetadocs Capture Essentials

Capture essentials provides you with our drag and drop capture facility, this means that documents and
emails can be dragged into the specifically created areas in our Zetadocs for NAV modified forms within the
NAV Role Tailored Client. These are then added to your archive.

3.3 Zetadocs Delivery Plus

Note: Can only be installed by Advanced Solution Partners

Delivery Plus provides a whole host of customisation options for Zetadocs. It is designed for use by NAV
VARs and systems integrators with experience in programming within NAV, but can also be used by Equisys
to fulfil bespoke requirements for individual systems. For full details on what can be achieved and
suitability for your requirements please contact Equisys technical support.

3.4 Zetadocs Capture Plus
Note: Can only be installed by Advanced Solution Partners
Zetadocs Capture Plus provides document capture for on screen reference and approval, providing a
complete transactional document management system for Microsoft Dynamics that is based upon Microsoft
SharePoint. It contains a wide range of features for customising the behaviour of the Capture functionality
in a Zetadocs for NAV system. It is designed for use by NAV VARs and systems integrators with experience
in programming within NAV, but can also be used by Equisys to fulfil bespoke requirements for individual
systems.
Features Include:

e Capture and conversion of inbound documents to PDF/A format

e Custom Document Queues

e Optical Character Recognition

e Barcode Recognition

e On screen approval with workflows

e Document Association

For full details on what can be achieved and suitability for your requirements please contact Equisys
technical support.

SharePoint Archiving and Integration (Included as Standard with all systems)

In a SharePoint enabled company, Zetadocs for NAV offers the ability to archive backup copies of
correspondence in a highly customizable archive. It does this by storing metadata against the archived
document that makes it easy to locate records or customer related documents, or to search based on your
own criteria. If you are intending archive to SharePoint from Zetadocs for NAV we would recommend
carrying out that part of this installation first before carrying on with the rest of the Zetadocs for NAV
installation.

3.5 ldentifying the Required Installation Elements

Zetadocs can aid your document handling in a variety of ways depending on the modules you are installing.
Several of these modules share core components of Zetadocs with others and as such those installing
Capture Essentials will be installing several components from throughout this guide. To aid you in locating
those chapters relevant to your install simply look for the coloured indicators next to the chapter headings.

Capture Essentials Chapters @

Delivery Chapters

Capture Plus Chapters O
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4. Installation Overview

The aim of this section is to provide you with an overview of the installation process. Shown next is an
outline of the major steps involved when performing a full install using the standard configuration data. If
you are installing a Capture Essentials System only then the process is largely the same as the components
installed will depend on the selections from the our setup program. For example customers installing the
Zetadocs Client as part of a Capture only install would install all components save Zetadocs PDF which is
only required for Zetadocs Delivery.

Installation Overview
Server Install

Install Zetadocs SharePoint Extensions

Install Zetafax Server Module

Install Zetadocs for NAV Client

Install Zetadocs for NAV Connector

Configuring Zetadocs for NAV

Install Zetadocs Capture Features

Client Install

7 Install Zetadocs for NAV Client

Install Zetafax Client

Testing the Zetadocs for NAV Solution

Zetadocs for NAV Delivery shown in Blue boxes.
Zetadocs for NAV Capture shown in Red boxes.
Zetadocs for NAV Fax Add-on Module shown in Green boxes.

Figure 2 - Zetadocs Install Process
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4. Starting your Product Installation

Zetadocs is fulfilled via either a product CD or a software download, to begin your install simply insert the
CD into a suitable drive or extract the download to a suitable location. The Zetadocs Setup program will
automatically run and appear. To begin your install simply select the module or combination of modules
you are installing.

equisys X
ZETAOOCS"

Please select the option which matches your
Installation Requirements:

© Zetadocs Delivery

Zetadocs Capture
Zetadocs Delivery and Capture
Free trials

Contact us

Figure 3 - Zetadocs Setup Program

This will display a list of the components relevant to your installation as shown in the figure below.

|
cquisys
®
ZETAOOCS

Zetadocs Delivery and Capture

© Latest Install Notes
Zetadocs Installation Guide
SharePoint 2007 Extensions
SharePoint 2010 Extensions

Zetadocs NAV Client 32 bit

Zetadocs NAV Client 64 bit

Zetadocs for NAV Connector

Zetadocs Server

Figure 4 - Zetadocs Setup Program - Delivery and Capture Options
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4.2 Installation steps to be performed on the server or servers

1. Installing the Zetadocs SharePoint Extensions (Optional)

e Creation of the Zetadocs Archive Document library and installation of the Zetadocs for NAV
search web parts, including user access control.

2. Installing the Zetafax Server Engine (Requires the Zetafax Upgrade Module)

e Installation and configuration procedure of the fax engine, including licensing and
registration, enabling users and setting up fax devices.

3. Installing the Zetadocs for NAV Client

e Installation and configuration procedure for the Zetadocs for NAV client, including
licensing and registration, enabling users and setting up shared folders.

4. Importing the Zetadocs for NAV Connector

e Installation of the Zetadocs for NAV granules within Microsoft Dynamics NAV. Using the
NAV Pane Designer to configure them, including setting up the Zetadocs for NAV System
tables and adding code to existing NAV objects.

5. Zetadocs for NAV Configuration
¢ Importing the standard configuration data.
e Adjusting standard data to fit in your requirements.
6. Installing Zetadocs Capture Essentials/Advanced (requires additional licence)
e Essentials: Installs the drag and drop document capture feature.
e Advanced: Installs the Zetadocs Server which converts documents placed in the document
queue folders into pdf format. Configuration of other Capture Plus features as required.
4.3 Installation steps to be performed on each client machine
7. Installing the Zetadocs for NAV Client

e Installing the Zetadocs for NAV Client Installation and configuration procedure for the
Zetadocs for NAV client, including licensing and registration, enabling users and setting up
shared folders.

8. Installing the Zetafax Client (optional requires the purchase of the additional Zetafax module)

9. Testing the Zetadocs for NAV Solution

e Verify the functionality end to end and gain customer acceptance.
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5. Zetadocs SharePoint Extensions O @ 0

The Zetadocs SharePoint Extensions installer provides a set of components that sit on a

Windows SharePoint machine, these components comprise web services, web parts and ASPX pages. The
purpose of these components is to provide a means of integrating Zetadocs for Microsoft Dynamics
products with a SharePoint installation.

SharePoint Requirements
The Zetadocs SharePoint Extensions installer will only install successfully on a machine that is running the
following versions of SharePoint.

Windows SharePoint Services 3.0 (WSS)
Microsoft Office SharePoint Server (MOSS ) 2007
Windows SharePoint Foundation 2010

Microsoft SharePoint 2010

Those installing on SharePoint 2010 should proceed to section 5.8 for installation details.

5.1 Installation of the Extensions with SharePoint 2007

Before running the installer, you must be logged onto the machine using an account that has SharePoint
Site Collection Administrator privileges for the front-end web application and the Central Administration
program. This account should be used for all rollout and configuration steps on the SharePoint machine.

To check which accounts are listed as Site Collection Administrators, you should do the following:

e On the SharePoint machine, run the application SharePoint 3.0 Central Administration from the
Start menu.

e Click on the Application Management option in the left-hand navigation panel.

e Select the Site Collection Administrators option from the SharePoint Site Management section of
the page. The resulting page will show you which accounts are listed as the Primary and
Secondary Site Collection Administration accounts.

Central Administration > Application Management = Site Collection Owners

Site Collection Administrators

Use this page to view and change the primary and secondary ske collection administrators For a site collection, As site collection administrators, these users recaive any quota or suto-deletion natices and have Full cortral
aver all content in the site collectian,
Site Collection site Collection: | httpy/ /zdnav-serv:32014/ssp/admin *
Select & Collecti " "
Select a Sibe Collection. Change Site %cum
Primary Site Collection Administrator Primary site callaction admiristrator:
The primary site collection administrator is displaved, Type a user name, and then click OK to save Administrator 8, w
the change
Secondary Site Collection Administrator Secordary site collection administrator:
The secondary site collection sdministrator is an optional entry For & web ste callection. The & W
secondary site collection adminstrstor 5 displayed. Type a user name, and then click 0K to save
the change
Ok I Cancel

Figure 5 - SharePoint Site Collection Administrators

e Select the Site Collection drop-down at the top of this dialog and choose Change Site Collection.
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Select Site Collection

URL Search | L ‘Web Apphcation: | http://zdnav-serv:32014/ ~
h. Applicati
LR URL http:,’fzdnav—seru| --._F. = \ffeb ppkcation
/ssp/admin Title Shared Services Administration: SharedService
51
Description Shared Services Administration Site
Primary CrHAMIC S administrator

administrator:

E-mail address:

SharedServicesContent_aa04f995-e106-4861-
B59c-17f5acs7 6490

Database Mame

Figure 6 - SharePoint Site Collection

e Select the web Application drop-down at the top of this dialog and choose Change Web
Application.

g Select Web Application -- Webpage Dialog I I ll

Select Web Application

Name! URL
SharePoint - 8D http://win-k746pinb)3n/
SharePoint Central Administration v3 http: ffwin+746pinbjin: 15485/

Figure 7 - SharePoint Site Web Application

e Add your chosen Administrator account to both the Central Administration and front-end Web
Applications. The front end web application can be identified as it uses the root URL for your
SharePoint site and often uses port 8o.

5.2 Installing Zetadocs SharePoint Extensions
To install the Zetadocs SharePoint Extensions, you should do the following:
e Run the Zetadocs for Microsoft Dynamics product CD or download file, the CD will auto-run and the
download should be extracted to a suitable location.
e The Zetadocs installer window should appear asking you to select the type of install you are doing.
e Choose the relevant option e.g. Zetadocs Delivery, and you will be directed to the install options
window.
e Choose the SharePoint Extensions option relevant to your version of SharePoint (2007/2010).

Work through the installation wizard setting the destination install folder as appropriate until the following
dialog is displayed:
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it Zetadocs SharePoint Extensions - InstallShield Wizard E3 l

Deployment equisys
ZETAOOCS
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Choose the deployment options.

Would yvou like to make the features available to SharePoint users automatically when the
install completes?

¢ Make available {activate) for all SharePoint sites {recommended).

" Deploy only, to allow later activation by an administrator.

(" Install solution files only.

Mote: Deploying or activating a SharePoint solution requires some SharePoint services to be
restarted and the administrative timer jobs to be run. SharePoint may become unavailable
for a short time {usually less than 1 minute).

Installshield

Cancel |

Figure 8 — Zetadocs SharePoint Extensions Installer

You have three installation options to choose from:

Make available (activate) for all SharePoint sites (recommended)

Choosing this option will install, deploy and activate all the files required for the Zetadocs SharePoint
Extensions. This includes the Zetadocs Web Services, Advanced Search web part and search pages. When
choosing this option, no further manual steps are required to roll out the Zetadocs SharePoint Extensions.

Deploy only, to allow later activation by an administrator

This option will install all required files onto the SharePoint machine and then deploy the Zetadocs
SharePoint Extensions within SharePoint. This will make the features available for activation on all
SharePoint web applications (sites). The activation operation must then be performed manually by a site
administrator (see below for further details).

Install solution files only

This is the basic install option. Choosing this option will install all required files onto the SharePoint
machine. The SharePoint administrator must then deploy the features and activate them on the SharePoint
web applications (sites). See below for further details.

You will then be asked to select the Dynamics product you are operating:

e Select the product you are using.
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e Click Next to continue.

i Zetadocs SharePoint Extensions - InstallShield Wizard X|

Content Types and Columns equisys

ZETAOOCS®

Capture. Deliver. Share.

Choase the Content Types and Columns that wou want to create,

Select the product that you want to integrake with, This will create the reguired SharePoink
Content Types and Columns automatically.

MicrosaF: Crenamics MAY
Microsaft Dynamics GP

This installer will create Content Types and Columns wikthin SharePoint, IF vou already have
your Zetadocs Conkent Tyvpes and columns defined, then wou should select the 'Mong'
opkion,

Inskallshield

< Back I Mext = I Cancel

Figure 9 — Selecting the Dynamics product

The following dialog is now displayed:

i?é! Zetadocs SharePoint Extensions - InstallShield Wizard

Web Address equisys
ZETAQOOCS

Capture. Deliver. Share.

Enter your SharePoint web address

To activate the Zetadocs SharePoint Extensions on all sites, vou must provide your top-level
site web address.

Web address (URL): |
e.q. http:/fintranet

Mate: To retrieve this, browse to your SharePoint home page and copy the first part of the
web address into the box above, e.q. if your home page is http:f/intranet/homepage. aspx
copy http:Jfintranet above,

InstallShield

Cancel |

Figure 10 — SharePoint Web Address Configuration

You should enter the web address (URL) of your top-level SharePoint site into the box provided. To obtain
this, open your SharePoint home page in Internet Explorer and note the URL in the address bar. The table
below lists some examples of what you should enter in the above dialog.

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved Page 17



equisys
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

URL in Internet Explorer address bar What to enter in the installer
http://intranet/Sales/default.aspx http://intranet/
http://sharepoint- http://sharepoint-server:1492/
server:1492/Sales/default.aspx
http://sharepoint-server/Sales/International/ http://sharepoint-server/

On adding the site web address and selecting Next you will be asked if you wish to start the installation,
click Install. A warning message will appear asking whether you wish to create Content Types and columns
within SharePoint. If you have already specified your Zetadocs Content Types and columns select No as you
should not create these again otherwise select Yes to continue the installation.

Once the install completes, and if you chose the installer recommended option of ‘Make available (activate)
for all SharePoint sites (recommended)’, the software is now ready to use. Please see the Checklist section
later for details of how to test that everything is installed correctly and then continue from there to set up
your SharePoint Document Library.

If you selected either of the other two installer options, please follow the advice in the following section
first.

5.3 Deploying and Activating in SharePoint

In choosing either the ‘Deploy only, to allow later activation by an administrator* or ‘Install solution files
only* options in the installer, you have elected to perform some manual steps in order to complete the
installation of the Zetadocs SharePoint Extensions.

I chose the ‘Install solution files only’ option
If you chose to just install the Zetadocs SharePoint solution files, you need to deploy and then activate the
software. To do this, you should do the following:

e On the SharePoint machine, run the application SharePoint 3.0 Central Administration from the
Start menu.

e Click on the Operations option in the left-hand navigation panel.
e Select the Solution Management option from the Global Configuration section on the displayed
page.

Note: There are SharePoint solutions listed: Zetadocsmossextensions.wsp or Zetadocswssextensions.wsp
(depending on your SharePoint installation type), Zetadocswebservices.wsp (common across both WSS and
MOSS) and either zetadocsgpcts.wsp or zetadocsnavcts.wsp depending on your Dynamics product. Each of
these needs to be deployed using the following steps:

For each of these solutions, you should do the following:

e C(lick on the filename.
e Choose the Deploy Solution option on the resulting page, as shown in the diagram below:
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Central Administration > Operations > Solution Management > Solution Properties

Solution Properties

Deploy Solution | Remove Solution | Back to Solutions

MName: zetadocsmossextensions.wsp

Type: Core Solution

Contains Web Application Resource: Yes

Contains Global Assembly: Yes

Contains Code Access Security Policy: MNo

Deployment Server Type: Front-end Web server

Deployrment Status: Mot Deployed

Deployed To: Mone

Last Operation Result: The solution was successfully retracted,

Last Operation Details: MOSS-2003SVR : http://moss-2003svr:150467 : The solution was successfully retracted.
MOSS-20035WR : http://moss-2003svr/ : The solution was successfully retracted.

Last Operation Time: 2/25/2008 10:25 AM

Figure 11 - SharePoint Solution Properties

e Onthe Deploy Solution screen that is now displayed, choose when you want to deploy the
solution. For each solution, we recommend that you accept the default options.

The software is now deployed. To activate the features, please follow the advice in the next section.

I chose the ‘Deploy only, to allow later activation by an administrator’ option
To activate the Zetadocs Web Services feature and NAV content types on the SharePoint sites, you should
do the following:

e Open your top-level site in Internet Explorer.

e Choose Site Settings > Modify All Site Settings from the Site Actions menu if running MOSS
2007, or Site Settings from the Site Actions menu if running WSS v3.0. Please note that if the
Modify All Site Settings option is not available on a MOSS 2007 machine, you may be logged on as
a user with insufficient permissions to activate SharePoint features.

e Select the Site Collection Features option from the Site Collection Administration section.

e Find the Zetadocs SharePoint Web Services feature in the list and Zetadocs Content Types (NAV)
then click the Activate button for each.

To activate the Zetadocs Extensions feature on each site (including the top-level and Search sites), you
should do the following:

e Open the site in Internet Explorer.

e Choose Site Settings > Modify All Site Settings from the Site Actions menu if running MOSS
2007, or Site Settings from the Site Actions menu if running WSS v3.o.

e Select the Site Features option from the Site Administration section.

e Find the Zetadocs SharePoint Extensions feature in the list, and click the Activate button.

The software is now activated, and you are ready to check that the operations have been successful. To do
this, please review the Checklist below.

Checklist SharePoint 2007

Operation Expected Result

On each site that you activated the Zetadocs SharePoint Extensions, browse to | The Zetadocs Advanced

the following web address (URL): Search page is
displayed.

http://<sharepoint_url>/<site_name>/Pages/ZetadocsSearch.aspx
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Operation

On each site that you activated the Zetadocs SharePoint Extensions, browse to
the following web address (URL):

http://<sharepoint_url>/<site_name>/Pages/ZetadocsSearchResults.
aspx

Expected Result

The Zetadocs Search
Results page is
displayed.

If you have a Search Center site (MOSS 2007):

Open the main search page (the one that displays the All Sites and
People search tabs).

A Zetadocs search tab is
visible. Clicking this tab
opens the Zetadocs
Advanced Search page.

Checking the Site Columns and Content Types:

Navigate to the root site, i.e. the web address that you entered at install time.
Select Site Actions > Site Settings > Modify All Site Settings from the Site
Actions menu if running MOSS 2007, or Site Settings from the Site Actions
menu if running WSS (v3.0).

Select Site Columns under the Galleries section.

Check the Site Columns are as expected and then repeat selecting Site Content
types from the galleries section.

Columns to include:
NAV Record No.
NAV Company No.
Zetadocs Archive ID
Recipient Name
Organization

Configuring SharePoint Archive

In order to use the Zetadocs SharePoint Extensions, you will need to create and configure a Document
Library for storing your archived documents. Please review the following advice on how to do this. This
information should be read in conjunction with the SharePoint general help files as appropriate. It is
possible to create document libraries for both Sales and Purchase documents, if you wish to keep these
separate simply do the instructions in this section for each giving them distinct names.

Browse to the site that you want to create the Document Library on e.g. http://intranet/docs.

[ ]
e Select Create from the Site Actions menu.
[ ]

Select the Document Library option from the Libraries section on the displayed page.

e Give your Document Library a suitable name like Archive.

Note: This is the naming used in the standard configuration data, if you wish to use another name you will

need to adjust the Archive library setting on the Zetadocs System Rule Card.

e Next add a suitable description, etc. and leave the Document Template as the default option.
e Do not turn on version control for the Document Library — versioned document libraries are not

supported in the current version of the software.
e Click Create when finished.

You should now configure the permissions for the document library.

Configuring the document library permissions
e Browse to the Document Library through your SharePoint/IE browser.
e Select Document Library Settings from the Settings menu.

e Select the Permissions for this Document Library option from the Permissions and Management

section.

e Ensure that all users who will be archiving/uploading document to this library have at least

Contribute access permissions.

o Ifrequired, select Edit Permissions from the Actions menu to modify these settings for the relevant

Users/Groups.

5.4 Enabling Search

At this point, the Zetadocs Advanced Search functionality will not work. This is because SharePoint has not
been given the opportunity to create Mapped Properties for the custom fields that the Zetadocs Advanced

Search relies on.
To enable the search functionality, please perform the following steps:

Associate the Zetadocs Content Type with your document library
e Browse to your created Document Library.
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Select Document Library Settings from the Settings pull-down menu.

Click on Advanced Settings from the General Settings Menu.

Change Allow management of content types to Yes and click OK.

From the Content Types section, select the Add from existing site content types option.

Add the Zetadocs content type and click OK.

Select the Change new button order and default content type.

Make the Zetadocs content type the default for the document library by giving it a Position from
Top value of 1 and click OK.

Upload a document
e Browse to your created Document Library.
e From the Upload menu, select the Upload Document option, browse to a document you can upload
as a test file and click OK.
e You will be shown a screen where you can edit the properties for the uploaded document.
e Ensure that Zetadocs is the selected content type and enter some test data for EACH field. Then
click OK.

Perform a full crawl on MOSS systems
e Bring up a command prompt.
Type IISRESET and press enter and wait for the system to stop and restart the internet services.
Perform a full crawl of your SharePoint database. The steps required to do this are as follows:
Launch the SharePoint Central Administration Utility.
Click on SharedServices1 on the left-hand menu.
Select Search Settings from the Search section.
Select Content Sources and Craw!| Schedules.
Select Start Full Crawl from the Local SharePoint Server sites pull-down menu.
Wait until the full crawl is complete.

Performing a full crawl on WSS systems
e Bring up a command prompt.
e Type cd c:\Program Files\Common Files\Microsoft Shared\web server extensions\12\BIN and press
return.
o Next enter stsadm -o spsearch and press return.
e Then enter stsadm —o spsearch —action fullcrawlstart
e  Wait until the crawl is complete.

Testing the document library

It is recommended that you check that the process has been completed successfully. Please note that this
step can be performed at any point before you begin using your Zetadocs system, but requires the
completion of the remaining Zetadocs installation steps. At the end of the installation you will be prompted
to do the following to ensure the document library works as expected.

e Archive a single document from NAV or GP into your chosen document library.
e Ensure that the document exists in the document library.

5.5 Modifying the Zetadocs Advanced Search web part (MOSS only)

The Zetadocs Advanced Search web part is not required for SharePoint 2010 users as its functionality is
included as standard. From within Microsoft Dynamics NAV you can display the document archive history
for a specified customer. To enable this functionality, it is necessary to modify the Zetadocs Advanced
Search web part on each SharePoint site (including the top-level site and your Search Center). The
procedure for doing this is detailed below.

e Browse to the Zetadocs Advanced Search page, e.g. http://intranet/Pages/ZetadocsSearch.aspx
for the top-level site and http://intranet/<site_name>/Pages/ZetadocsSearch.aspx for the sub-
sites.

e Click Site Actions - Edit Page.

e On the Zetadocs Advanced Search web part, click the edit box in the top right-hand corner and
select Modify Shared Web Part.
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e The Zetadocs Advanced Search configuration panel will appear to the right-hand side of your
browser.

e Under Custom search fields, add a custom field where for a NAV system Property = NAV Company
No. and Label = NAV Company Number:

e C(lick OK.

e Click Exit Edit Mode in the top right-hand area of the screen.

e You may be asked to save your changes, click OK to continue.

The site search feature will only operate after you have successfully archived a document.

5.6 Installing the Adobe PDF IFilter on a 32-bit system
The Ifilter is required to make PDF files indexable and therefore text searchable as well as being required for
the correct formatting of search results.

e On 32-bit systems, download the Adobe PDF IFilter or the latest version of Adobe Acrobat Reader.

e Stop the IIS Admin service: Start = Run = services.msc = IIS Admin Service - Stop.

e Double-click the installer executable to start the installation (ensuring that you are logged onto the

machine as a domain and SharePoint administrator).
e Runthrough the Install Wizard - accepting the defaults for each screen.
e Perform an IISRESET: Start > Run - IISRESET

Assigning a specific icon for your pdf files in SharePoint (Optional)

Should you wish to assign a recognisable icon to the pdf files in your archive it is possible to have any
suitable image represent your content. If you do not wish to add a specific icon simply skip the steps below
and continue with the additional steps relevant to your SharePoint version.

e Firstly you need to locate a suitable icon to represent pdf files in your SharePoint system.

e Copy this icon file to C:\Program Files\Common Files\Microsoft Shared\Web Server
Extensions\12\Template\Images

e Go to C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\12\Template\XML
and open the Docicon.xml file in a text editor such as Notepad.exe.

e Adjust the file to include the .pdf extension by adding <Mapping Key="pdf" Value="<your image
file name with extension>"/> and saving the file.

Additional steps required on MOSS Systems
These next steps are relevant to MOSS systems only, if you are using WSS please proceed to the next step.

e launch the SharePoint Central Administration program.

e Navigate to the Shared Services Administration for your site (often SharedServices1) - Search
Settings —>File Types

e  Click New File Type.

e Enter pdf in the File Extension text box and click OK.

e Perform a Search Service stop: Start >Run - net stop spsearch

e Perform a Search Service start: Start >Run 2> net start spsearch

Additional steps required on WSS systems
On WSS systems you will also have to carry out the following steps.

e (lick Start > Run > REGEDIT and then locate the following registry subkey:
e WSS Systems
o HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\12.0\Search\Applications\<GUID>\Gather\Search\Extensions\ExtensionList
Select Edit > New - String Value
Assign the name 38 to the new string.
Give it the value pdf
Perform a Search Service stop: Start > Run - net stop spsearch
Perform a Search Service start: Start > Run - net start spsearch
Recrawl the site as per the crawl instructions in section 5.4.
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5.7 Installing the Adobe PDF IFilter on a 64-bit system

For 64-bit systems please refer to the following advice:

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4025

5.8 Installation of the Extensions with SharePoint 2010

Preparing SharePoint for Installation of the Extensions with SharePoint 2010

Before running the installer, you must be logged onto the machine using an account that has SharePoint
Site Collection Administrator privileges for the front-end web application and the Central Administration
program. This account should be used for all rollout and configuration steps on the SharePoint machine.

To check which accounts are listed as Site Collection Administrators, you should do the following:

e  On the SharePoint machine, run the application Central Administration from the Start menu.

e C(lick on the Application Management option in the left-hand navigation panel.

e Select the Change Site Collection Administrators option from the Site Collections section of the
page. The resulting page will show you which accounts are listed as the Primary and Secondary
Site Collection Administration accounts.

e Select the Site Collection drop-down at the top of this dialog and choose Change Site Collection.

e Select the web Application drop-down at the top of this dialog and choose Change Web
Application.

e Add your chosen Administrator account to both the Central Administration and front-end Web
Applications. The front end web application can be identified as it uses the root URL for your
SharePoint site and often uses port 8o.

5.9 Installing Zetadocs SharePoint Extensions
To install the Zetadocs SharePoint Extensions, you should do the following:
e Runthe Zetadocs for Microsoft Dynamics product CD or download file, the CD will auto-run and the
download should be extracted to a suitable location.
e The Zetadocs installer window should appear asking you to select the type of install you are doing.
e Choose the relevant option e.g. Zetadocs Delivery, and you will be directed to the install options
window.
e Choose the SharePoint Extensions option relevant to your version of SharePoint (2007/2010).

Work through the installation wizard setting the destination install folder as appropriate until the following
dialog is displayed:
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it Zetadocs SharePoint Extensions - InstallShield Wizard E3 l

Deployment equisys
ZETAOOCS

Capture. Deliver. Share.

Choose the deployment options.

Would yvou like to make the features available to SharePoint users automatically when the
install completes?

¢ Make available {activate) for all SharePoint sites {recommended).

" Deploy only, to allow later activation by an administrator.

(" Install solution files only.

Mote: Deploying or activating a SharePoint solution requires some SharePoint services to be
restarted and the administrative timer jobs to be run. SharePoint may become unavailable
for a short time {usually less than 1 minute).

Installshield

Cancel |

Figure 12 — Zetadocs SharePoint Extensions Installer

You have three installation options to choose from:

Make available (activate) for all SharePoint sites (recommended)

Choosing this option will install, deploy and activate all the files required for the Zetadocs SharePoint
Extensions. This includes the Zetadocs Web Services, Advanced Search web part and search pages. When
choosing this option, no further manual steps are required to roll out the Zetadocs SharePoint Extensions.

Deploy only, to allow later activation by an administrator

This option will install all required files onto the SharePoint machine and then deploy the Zetadocs
SharePoint Extensions within SharePoint. This will make the features available for activation on all
SharePoint web applications (sites). The activation operation must then be performed manually by a site
administrator (see below for further details).

Install solution files only

This is the basic install option. Choosing this option will install all required files onto the SharePoint
machine. The SharePoint administrator must then deploy the features and activate them on the SharePoint
web applications (sites). See below for further details.

You will then be asked to select the Dynamics product you are operating:

e Select the product you are using.
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e Click Next to continue.

i Zetadocs SharePoint Extensions - InstallShield Wizard X|

Content Types and Columns equisys

ZETAOOCS®
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Choase the Content Types and Columns that wou want to create,

Select the product that you want to integrake with, This will create the reguired SharePoink
Content Types and Columns automatically.

MicrosaF: Crenamics MAY
Microsaft Dynamics GP

This installer will create Content Types and Columns wikthin SharePoint, IF vou already have
your Zetadocs Conkent Tyvpes and columns defined, then wou should select the 'Mong'
opkion,

Inskallshield

< Back I Mext = I Cancel

Figure 13 — Selecting the Dynamics product

The following dialog is now displayed:

i?é! Zetadocs SharePoint Extensions - InstallShield Wizard

Web Address equisys
ZETAQOOCS

Capture. Deliver. Share.

Enter your SharePoint web address

To activate the Zetadocs SharePoint Extensions on all sites, vou must provide your top-level
site web address.

Web address (URL): |
e.q. http:/fintranet

Mate: To retrieve this, browse to your SharePoint home page and copy the first part of the
web address into the box above, e.q. if your home page is http:f/intranet/homepage. aspx
copy http:Jfintranet above,

InstallShield

Cancel |

Figure 14 — SharePoint Web Address Configuration

You should enter the web address (URL) of your top-level SharePoint site into the box provided. To obtain
this, open your SharePoint home page in Internet Explorer and note the URL in the address bar. The table
below lists some examples of what you should enter in the above dialog.
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URL in Internet Explorer address bar What to enter in the installer
http://intranet/Sales/default.aspx http://intranet/
http://sharepoint- http://sharepoint-server:1492/
server:1492/Sales/default.aspx
http://sharepoint-server/Sales/International/ http://sharepoint-server/

On adding the site web address and selecting Next you will be asked if you wish to start the installation,
click Install. A warning message will appear asking whether you wish to create Content Types and columns
within SharePoint. If you have already specified your Zetadocs Content Types and columns select No as you
should not create these again otherwise select Yes to continue the installation.

Once the install completes, and if you chose the installer recommended option of ‘Make available (activate)
for all SharePoint sites (recommended)’, the software is now ready to use. Please see the Checklist section
later for details of how to test that everything is installed correctly and then continue from there to set up
your SharePoint Document Library.

If you selected either of the other two installer options, please follow the advice in the following section
first.

5.10 Deploying and Activating in SharePoint 2010

In choosing either the ‘Deploy only, to allow later activation by an administrator* or ‘Install solution files
only* options in the installer, you have elected to perform some manual steps in order to complete the
installation of the Zetadocs SharePoint Extensions.

I chose the ‘Install solution files only’ option
If you chose to just install the Zetadocs SharePoint solution files, you need to deploy and then activate the
software. To do this, you should do the following:

e  On the SharePoint machine, run the application Central Administration from the Start menu.

e C(lick on the System Settings option in the left-hand navigation panel.

e Select the Manage farm solutions option from the Global Configuration section on the displayed
page.

Note: There are SharePoint solutions listed: Zetadocsmossextensions.wsp or Zetadocswssextensions.wsp
(depending on your SharePoint installation type), Zetadocswebservices.wsp (common across both WSS and
MOSS) and zetadocsnavcts.wsp. Each of these needs to be deployed using the following steps:

For each of these solutions, you should do the following:
e Click on the filename.
e Choose the Deploy Solution option on the resulting page.
e Onthe Deploy Solution screen that is now displayed, choose when you want to deploy the
solution. For each solution, we recommend that you accept the default options.

The software is now deployed. To activate the features, please follow the advice in the next section.

I chose the ‘Deploy only, to allow later activation by an administrator’ option
To activate the Zetadocs Web Services feature and NAV content types on the SharePoint sites, you should
do the following:

Open your top-level site in Internet Explorer.

Choose the Site Actions menu and then Site Settings.

Select the Manage site features option from the Site Actions section.

Find the Zetadocs SharePoint Web Services feature in the list and Zetadocs Content Types (NAV)
then click the Activate button for each.

To activate the Zetadocs Extensions feature on each site (including the top-level and Search sites), you
should do the following:

e Open the site in Internet Explorer.
e Choose the Site Actions menu and then Site Settings.
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e Select the Manage site features option from the Site Actions.
e Find the Zetadocs SharePoint Extensions feature in the list, and click the Activate button.

The software is now activated, and you are ready to check that the operations have been successful. To do
this, please review the Checklist below.

Checklist SharePoint 2010

Checking the Site Columns and Content Types: Columns to include:
Navigate to the root site, i.e. the web address that you entered at install time. NAV Record No.
Select Site Actions > Site Settings NAV Company No.

Zetadocs Archive ID
Recipient Name
Organization

Select Site Columns under the Galleries section.
Check the Site Columns are as expected and then repeat selecting Site Content
types from the galleries section.

Configuring SharePoint Archive

In order to use the Zetadocs SharePoint Extensions, you will need to create and configure a Document
Library for storing your archived documents. Please review the following advice on how to do this. This
information should be read in conjunction with the SharePoint general help files as appropriate. It is
possible to create document libraries for both Sales and Purchase documents, if you wish to keep these
separate simply do the instructions in this section for each giving them distinct names.

Browse to the site that you want to create the Document Library on e.g. http://intranet/docs.
Select the Create button.
Select the Document Library option from the create page.
e Give your Document Library a suitable name like Archive in the right hand field.
Note: This is the naming used in the standard configuration data, if you wish to use another name you will
need to adjust the Archive library setting on the Zetadocs System Rule Card.
e Select the More Options button and add a suitable description, etc. and leave the Document
Template as the default option.
e Do not turn on version control for the Document Library — versioned document libraries are not
supported in the current version of the software.
e Click Create when finished.

You should now configure the permissions for the document library.

Configuring the document library permissions

e Browse to the Document Library through your SharePoint/IE browser.

e Select the Library option from Library Tools.

e Select the Library Permissions option, located on right hand side in the settings section.

e Ensure that all users who will be archiving/uploading document to this library have at least
Contribute access permissions.

e Ifrequired, select the user whose permissions you wish to edit by choosing its checkbox, select
Edit User Permissions to modify these settings for the relevant Users/Groups.

Archived documents are stored in SharePoint as PDFs. To ensure that these are indexed correctly and that
SharePoint recognizes them as ‘Documents’ in the search results, it is recommended that you install the
Adobe PDF IFilter. The instructions for doing this are detailed later in section 5.11.

Testing the document library

It is recommended that you check that the process has been completed successfully. Please note that this
step can be performed at any point before you begin using your Zetadocs system, but requires the
completion of the remaining Zetadocs installation steps. At the end of the installation you will be prompted
to do the following to ensure the document library works as expected.

e Archive a single document from NAV or GP into your chosen document library.
e Ensure that the document exists in the document library.
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5.11 Installing the Adobe PDF IFilter on a 32-bit system
The Ifilter is required to make PDF files indexable and therefore text searchable as well as being required for
the correct formatting of search results.
e On 32-bit systems, download the Adobe PDF IFilter or the latest version of Adobe Acrobat Reader.
e  Stop the IIS Admin service: Start = Run - services.msc = [IS Admin Service = Stop.
e Double-click the installer executable to start the installation (ensuring that you are logged onto the
machine as a domain and SharePoint administrator).
Run through the Install Wizard - accepting the defaults for each screen.
Perform an [ISRESET: Start > Run > IISRESET

Assigning a specific icon for your pdf files in SharePoint (Optional)

Should you wish to assign a recognisable icon to the pdf files in your archive it is possible to have any
suitable image represent your content. If you do not wish to add a specific icon simply skip the steps below
and continue with the additional steps relevant to your SharePoint version.

e Firstly you need to locate a suitable icon to represent pdf files in your SharePoint system.

e Copy thisicon file to C:\Program Files\Common Files\Microsoft Shared\Web Server
Extensions\12\Template\Images

e Go to C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\12\Template\XML
and open the Docicon.xml file in a text editor such as Notepad.exe.

e Adjust the file to include the .pdf extension by adding <Mapping Key="pdf" Value="<your image
file name with extension>" /> and saving the file.

Additional steps required on SharePoint 2010 Systems
These next steps are relevant to SharePoint 2010 systems only, if you are using foundation please proceed
to the next step.

Launch the SharePoint Central Administration program.

Click General Application Settings from the left-hand menu.
Select Farm Search Administration from the Search section.
Select the Search Service Application option.

Select File Types from the Crawling section.

Click New File Type.

Enter pdf in the File Extension text box and click OK.

Perform a Search Service stop: Start > Run - net stop spsearch
Perform a Search Service start: Start > Run - net start spsearch

Additional steps required on foundation systems
On foundation systems you will also have to carry out the following steps.

e (lick Start > Run > REGEDIT and then locate the following registry subkey:
Foundation Systems
o HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\14.0\Search\Applications\<GUID>\Gather\Search\Extensions\ExtensionList\
Select Edit > New - String Value
Assign the name 38 to the new string.
Give it the value pdf
Perform a Search Service stop: Start > Run - net stop spsearch
Perform a Search Service start: Start > Run - net start spsearch

5.12 Installing the Adobe PDF IFilter on a 64-bit system

For 64-bit systems please refer to the following advice:

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4025
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6. Zetadocs NAV Client

This section describes the installation of client applications which includes the Zetadocs Client, the runtime
APl and the NAV Extensions. Zetadocs for NAV operates in conjunction with the Zetadocs Client version 4.1
or later and requires a Zetadocs Client “Automation” license to enable the batch document management
features used by NAV.

Zetadocs for NAV Installation Guide

Prerequisites
Before embarking on the install of the Zetadocs Client it is recommended that if you install the items listed
below if you intend to make use of them.

e [nstall the Zetadocs SharePoint Extensions

6.1 Installing Zetadocs for NAV Client

Zetadocs for NAV needs to be installed onto the server as well as any intended client machines; the
principle difference is the type of install selected from the installation dialog with server installations
requiring either Administration or Custom installations. These options are clearly marked in the steps
outlined below.

Note: If you are installing in a Terminal Services Environment please see the section 26.4 Installing in a
Terminal Services Environment.

e Ensure the currently logged in user has local administration rights on the machine that is being
installed upon.
o Thisisrequired to install pre-requisite components used in Zetadocs. These permissions
can be elevated temporarily for the installation.
e Insert the Zetadocs for NAV CD or extract your product download.
e The Zetadocs setup program will autorun, choose the option pertinent to your install:
o Zetadocs Delivery
o Zetadocs Capture
o Zetadocs Delivery and Capture
e Select either the 32 or 64 bit link for the Zetadocs for NAV Client as required to begin the install.
e You will be asked to select the installation language.

e Theinstallation program will open prepared to install the Zetadocs API Runtime which is a pre-
requisite of the Zetadocs for NAV Client.
Click Install to Install the Zetadocs API Runtime.
The Zetadocs for NAV Client Installer will appear, select Next to begin the installation.
The software licence agreement will appear, select accept once you have reviewed its contents.
You will be asked to select the Install Type, this depends on the machine you are installing on with
the Typical install generally being used for client machine setup. Administrator or Custom installs
are generally done on the server as per your requirements.
o Typical
= s generally used for additional client users.
o Administrator
= Installs all the Zetadocs NAV client feature components required including the
product licensing and configuration application.
o Custom
= Allows you to manually specify the install locations for Delivery and Capture
components.
e Select Next and users performing a Zetadocs Delivery Installation will be asked to create a shared
folder for their Templates.
e Select the folder location and select Next to setup the network folder, you will be asked to click
Install to begin the installation.
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6.2 Install Zetadocs for NAV Help Files

Classic Client

The Zetadocs for NAV help files need to be copied to the Microsoft Dynamics NAV help folder on each
machine and given names that will not clash with other help files. This folder may contain other help files
which may already use the ‘a’ post-fix name. In this case you should change the file names to an unused
post-fix letter between a and j (e.g. change to addin_f.chm and addin_f.hh). Note that the post-fix on both
file names must match.

There are 2 files:

e addin_a.chm
e addin_a.hh

They should be copied from:

<CD Browser>\Zetadocs NAV Client\NAV Help
For NAV 4.0 & 5.0 systems copy to:

Program Files\Microsoft Dynamics NAV\CSIDE Client\ENG

Substitute ENG for the language pertinent to the install e.g. ENU for US systems.
For NAV 6.0 systems copy to:

Program Files\Microsoft Dynamics NAV\6o\Classic\ENG

Substitute ENG for the language pertinent to the install e.g. ENU for US systems.

Alternatively it can be copied to the equivalent installation folder of Microsoft Dynamics NAV on the
machine.

Role Tailored Client
The Zetadocs for NAV help files need to be copied to the Microsoft Dynamics NAV help folder and given
names that will not clash with other help files. There are 2 files:

e addin_a.chm

This should be copied from:
<CD Browser>\Zetadocs NAV Client\NAV Help

To:
Program Files\Microsoft Dynamics NAV\6o\RoleTailored Client\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.

e addin_a.hh

This should be copied from:
<CD Browser>\Zetadocs NAV Client\NAV Help
To:
Program Files\Microsoft Dynamics NAV\6o\Service\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.

You may need to restart the Microsoft Dynamics NAV server to get the help files to appear as expected.

e To do this got to Start and then click Run, in the Open box, type services.msc, and then press
ENTER.
e Under Services, right-click Microsoft Dynamics NAV Server, and then click Restart.

6.3 Configuring Zetadocs Client Licensing

Before you can start using Zetadocs you must license and register it, enable users and setup file sharing
folders for storage of company accessories (templates, stationery and attachments). The Zetadocs PDF
configuration program is automatically installed as part of your Zetadocs system when you select the
Administration install option during installation. This program allows you to manage your Zetadocs PDF
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program across your network, allowing licensing, registration, shared folders and user accounts to be
modified.

Note: When installing on a client machine following a successful server installation you do not need to
licence Zetadocs. Further the recommended Zetadocs install type for client setups is Typical which does not
install the Zetadocs PDF Configuration program.

Zetadocs Client Licensing and Setup

Launch the Zetadocs PDF Configuration.
Choose the license location (General Tab).
o Active Directory (requires that user has access rights to write to AD)
o Shared Network Folder
Enter your Zetadocs license number and company name and register online.
Enter your registration key on receiving the registration success email.
Add the required users.
Set up a shared network folder for NAV Templates (Recommended that you select the location
specified in the Zetadocs for NAV Client install earlier, it is required if you intend to use the NAV
templates provided).
e Leave Network Archiving off if you are using SharePoint as an archive.

Zetadocs Client

e Start the client.

e |fusing Active Directory licensing, Zetadocs should locate the license automatically, otherwise, go
to Tools—> Options\Licensing and enter the path to the network folder containing the Zetadocs
license.

e Restart client if necessary.

¢ You can confirm that you are successful if the splash screen shows the Automation tag beside the
number of users.

Zetadocs Client
Version 6.0.74

License Details:

License Number: 55500000
Users: 50, Automation
Registered to Equisys

Copyright © 2007-2009 Equisys plc and its licensors. All rights
reserved. Zetadocs is a registered trademark of Equisys plc.

ccluisv.s

ZETACOCS®
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Figure 15 - Zetadocs Client Splash Screen

Please refer to the Zetadocs Client Help for further information on configuring the Zetadocs Client.
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7. Zetadocs for NAV Connector 0 @ o

This section details how to install the Zetadocs for NAV Connector, the connector contains
the elements which need to be imported into NAV to enable documents to be passed to the Zetadocs Client
for delivery.

Zetadocs for NAV Installation Guide

Installing the connector consists of:
e Importing of Zetadocs for NAV objects fob file

e Importing of Zetadocs for NAV tables fob file (optional)
e Importing of Zetadocs for NAV forms fob file (optional)
e Importing the Standard Configuration Data

To reduce downtime and ensure that no complications occur on the live system it is recommended that you
perform the importing of the NAV objects and configuration data on a duplicate of your live database. Once
the objects and configuration have been imported the system can be adjusted to match your requirements.
When you have a Zetadocs configuration that you are happy with this can be exported using the Zetadocs
Configuration Export form. This will produce an xml file which will enable you to transfer the setup onto the
live system much more quickly and with more confidence.

7.1 Creating a test NAV system

Creating a test NAV system is recommended as in conjunction with our Zetadocs Configuration Export form
you are able to create your Zetadocs for NAV system in a test environment. The configuration can then be
exported meaning that the live system will operate as desired immediately after completing the importing
of the Zetadocs for NAV objects and config.xml file. If you are not intending to setup your system in a test
environment then continue from section 7.2 below and skip section 22 Migrating to the live database.

There are a number of ways to create a copy of your existing NAV database, depending on the version of
NAV and the type of database being used. If the method outlined below doesn’t match your setup then
please refer to your NAV support documentation for additional details.

Creating a copy of your NAV database
e Open the NAV client and open the database in question.
e From the main menu select Tools>Backup.
e Save a copy of your NAV database in a safe location.
o Select File>Database>New and create a new duplicate system.
o Next select Tools->Restore and select the backup database you just created.

You are now ready to begin importing the Zetadocs for NAV objects and Standard Configuration.

7.2 Terminology
e Zetadocs for NAV Objects
e Thisis how we define the NAV objects that we add to the database and are all within our object
range 9009959 - 9001018.
e This is how we define the existing NAV objects which we modify to integrate Zetadocs for NAV with
an existing database. To assist in the installation of our interfaces we provide many interface .fob
and .txt files for different languages and versions.

7.3 NAV License
To successfully install Zetadocs for NAV you require a Zetadocs for NAV VAR NFR granule to be added to
your license.

Required Granules
To use Zetadocs for NAV you require the Zetadocs for NAV Granule to be added to your license.

Granule 9009961 — Zetadocs Execute Granule
Granule 9009970 — Zetadocs for NAV Granule

Optional Granules
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To take advantage of Zetadocs for NAV integration with NAV Contacts you require the Contact Management
Granule.

Granule 5500 — Contact Management

Granule 5510 — Contact Management - Basic

Optionally you can also purchase the Zetadocs for NAV SDK Granule which allows the running of
customizations made in the Zetadocs Customization codeunit 9009962.

Granule 9009980 — Zetadocs for NAV SDK

Note: To activate the code of this granule you must create a record in the Zetadocs System Settings table as
follows:

e From the Object Designer, run table 9009959
e On an empty row, create a new record with:
e Name = SDKEnabled

e Bool=True

£5 Zetadocs System Settings - Table

Mame User ID Bool String Mumnber
ArchivingEnabled

FaxEnabled

LoggingEnabled v

LogLevel

| » SDKEnabled

SharePointSite 1}

Figure 16 - Enabling the Zetadocs SDK

7.4 Backing up the existing NAV Objects
In order to be able to uninstall Zetadocs for NAV software it is necessary to backup the Navision objects
before installing the Zetadocs for NAV objects. Please perform the following tasks:

Open the Navision client and connect to/open the Navision database.

Open the Object Designer (Tools=>Object Designer).

Click on All button in the designer menu.

Select All objects (CTRL + A).

Select File>Export.

Export objects to a Backup of Objects before Zetadocs for NAV4.o.fob file.
Keep the Backup of Objects before Zetadocs for NAV4.0.fob in a safe place.

7.5 Importing Zetadocs for NAV Objects

Before you import the Zetadocs for NAV objects, you must ensure that you have completed the instructions
on installing the Zetadocs for NAV Client as a local administrator on the machine from which you intend to
import the Zetadocs for NAV objects into your NAV database. This ensures that relevant automation objects
are installed on that machine to enable compilation of the Zetadocs for NAV objects when imported into
NAV.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and import the relevant file to the NAV system you are
running from the table below by selecting File>Import.

e The files are included on your Zetadocs for NAV CD or download. They can be found in <CD
Drive>:\Zetadocs NAV Server Components\ followed by the relevant country code and NAV version
e.g. <CD Drive>:\Zetadocs NAV Server Components\DE\5.00\Zetadocs for NAV V4.0 Objects -
NAV5.00.fob
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NAV Version Fob file to use

NAV 6.01 (2009) Zetadocs for NAV V4.0 Objects - NAV6.o1.fob
NAV 6.00 Zetadocs for NAV V4.0 Objects - NAV6.0o.fob
NAV 5.00 Zetadocs for NAV V4.0 Objects - NAV5.00.fob
NAV 4.00 Zetadocs for NAV V4.0 Objects - NAV4.00.fob

e Assuming there are no collisions with existing objects continue importing objects and ensure that
there have been no compilation errors. If you have object collisions or compilation errors refer to
the troubleshooting section at the end of this document.
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8. Zetadocs Feature Specific Steps

This section will detail the setup of those features which are not required for all installs. These features
should be installed on a per feature basis if you require them. For those installing Zetadocs Capture you are
required to install all the options below, for Zetadocs Delivery customers they should be installed as
required.

Zetadocs offers a number of features which can be installed as required, each of these features has its own
setup instructions in this section so please follow them as required.

1. SharePoint Archiving Support (Required for Capture Functionality)
= Allows users to archive and retrieve items sent via Zetadocs to SharePoint, when
used in conjunction with the SharePoint extensions.
2. Role Tailored Client Support (Required for Capture Essentials Functionality)
= Enables use of the Role Tailored Client with Zetadocs for NAV.
3. Customer/Vendor cards modifications for SharePoint Archiving and Zetadocs Rules
= Adds Zetadocs Archive and/or Zetadocs Rules options to the Customer and/or the
Vendor Card. This facilitates access to these features from the particular
customer/vendors card speeding modification of their specific delivery settings
and archive searches.

8.1 SharePoint Archiving Support

For systems which intend to make use of archiving you will need to adjust to some existing NAV tables to
add a Zetadocs Archive ID field. This field is required to successfully archive documents from NAV and in the
case of SharePoint archives to retrieve them from within NAV. The table changes required for archiving can
be performed in two different ways. Firstly there is a set of fob files located on the product CD which can be
imported; these versions of the tables are based upon the original vanilla tables provided as part of your
version of NAV. To these the relevant fields have been added, as such if your system does not contain
modified versions of these tables you can import these tables. NAV will check for collisions on import, if
these occur they should be reviewed whereby you will be able to decide whether to import the fob file or
ignore this step and perform the adjustments manually.

Importing the Tables fob file
The following actions must be followed by someone using a world 1 database version 5.00. If your system is
different, you need to select the file that is relevant to your system.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and import the interfaces file included on your Zetadocs for
NAV CD.

o Zetadocs for NAV V4.olnterfaces - NAVW15.00 (Tables).fob
It can be found in <CD Drive>:\Zetadocs NAV Server Components\<language code>\<database
version>\.

e |Ifthere are no collisions continue with the import. Should collisions occur it is recommended that
you export your existing objects, and then compare the version of the objects with the text file
versions of the interfaces detailed above. This will determine the safety of the available
merge/replace options available in the import worksheet.

If it is impossible to merge to tables in your database, please refer to below for instructions on how to
modify the tables manually.

Modifying NAV Tables Manually

To enable archiving and retrieval of reports using Zetadocs for NAV you must add a field to a number of
tables in your database. This is done to link the records from the table with the archived documents. This is
done by adding a custom Zetadocs GUID field to the table. This must be done to the table before attempting
to send a report based upon it. The following actions will guide you through the process.

e loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.
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Before adding the field you need to pick a field no. from the free range which is available in all
related tables. This is to maintain documents referencing after operations such as posting. For
example: If | add the “Zetadocs Archive ID” field to Table 36 — Sales Header with field no. 50000,
then | should add the same field in Table 112 — Sales Invoice Header with the same field no.

Add a field called “Zetadocs Archive ID” of type GUID with your chosen field no. You must enter
the name exactly as stated. Upper and lower casing must be correct as well as spacing.

To enable archiving and retrieval of reports to and from SharePoint Zetadocs for NAV fields are added to the
following tables. This is to link that record with the archived documents.

Table No. \ Table Name Field No. Name Data Type
18 Customer 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
36 Sales Header 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
110 Sales Shipment 9009959 or your choice from the | Zetadocs Archive ID GUID
Header free range of Field No.’s
112 Sales Invoice 9009959 or your choice from the | Zetadocs Archive ID GUID
Header free range of Field No.’s
114 Sales Cr.Memo 9009959 or your choice from the | Zetadocs Archive ID GUID
Header free range of Field No.’s
6660 Return Receipt 9009959 or your choice from the | Zetadocs Archive ID GUID
Header free range of Field No.’s
23 Vendor 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
38 Purchase Header 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
120 Purch Rcpt. Header | 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
122 Purch. Inv. Header 9009959 or your choice from the | Zetadocs Archive ID GUID
free range of Field No.’s
124 Purch. Cr. Memo 9009959 or your choice from the | Zetadocs Archive ID GUID
Hdr. free range of Field No.’s
6650 Return Shipment 9009959 or your choice from the | Zetadocs Archive ID GUID
Header free range of Field No.’s

8.2 Role Tailored Client Compatibility
To enable the operation of Zetadocs for NAV with the Role Tailored Client, Page Interfaces are provided for
the W1 versions of NAV 6.01. These pages will add the Related Documents Grid to your RTC, the drag and
drop functionality is installed as part of this process and is thus required for Capture Essentials users.
Note: Those systems without a valid Capture Essentials license will be not see the drag and drop control
displayed.
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Log into Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.
Open the object designer (Shift + F12) and import the interfaces file included on your Zetadocs for
NAV CD relevant to your NAV version. E.g. Zetadocs for NAV V4.0 Interfaces - NAVW16.01

(Pages).fob

It can be found in <CD Drive>:\Zetadocs NAV Server Components\<language code>\<database

version>\.
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If there are no collisions continue with the import. If there is a collision it is recommended that you
export your existing objects and compare version of the objects with the text file versions of the
interfaces detailed above to determine the safety of the available merge/replace options in the
import worksheet.

Manually adding the related documents grid to existing pages in NAV

Should you decide not to install the Zetadocs for NAV V4.0 Interfaces (Pages).fob file relevant to your NAV
version, or merge it with your existing file, the instructions below can be performed to add the related
documents grid, including the Capture Essentials features if licensed, to your Role Tailored Client pages as
required.

Log into Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

Open the object designer (Shift + F12) and select the page that needs to be modified and click the
Design button.

Locate the part on the page where you wish to locate the related documents grid, often after the
general tab. For example on the Customer card we can place it below the General tab in between it
and the Communication tab, on viewing the card we can see that this starts after the Last Date
Modified field before the Communication tab.

In the Page Designer scroll down to the Last Date Modified field and select the row below this and
right click on it and choose New.

In the blank line that has been created enter the name as Zetadocs.

Change the Type field value to Part.

Select the new line and press Shift+F4 to show the properties window.

Change the PagepartID to Zetadocs Related Docs List. It should look something like the
screenshot displayed below:

8 Zetadocs - Properties = || =] £8
Property Value
ID 1000000000 -
Name Zetadocs
Visible <TRUE>=>
Enabled <TRUE>
Editable <TRUE>=>
Caption <Zetadocs >
CaptionML <lndefined >
ToolTip =
ToolTipML <Undefined =
Description <
SubFormView <Undefined >
SubFormLink <Undefined =
ProviderID <0
PartType <Page>
PageFartID Zetadocs Related Docs List
SystemPartID <MNone>
ChartPartlD <Undefined >

Figure 17 — Zetadocs Properties

Press Fg to display the code window.

In the OnAfterGetRecord() trigger add a local variable:
Name: RecRef

DataType: RecordRef

In the trigger add the following code:
RecRef.GETTABLE(Rec);
CurrPage.Zetadocs.FORM.SetRecordID(RecRef.RECORDID);
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e C(lose the page designer windows.
e C(lick Yes when prompted to compile and save the changes.

8.3 Customer/Vendor card modifications for Archiving and Zetadocs Rules
These form interface changes enable users of the NAV system to access the Zetadocs Rules and Archive
from throughout various cards and appears in NAV, as shown in the figure below.

Zetadocs Rules: Opens the Zetadocs Customer Rule Card for the customer selected.

Zetadocs Archive: Opens the Related Documents form containing documents that have been dragged and
dropped into the archive using Zetadocs Capture Essentials. You can drag and drop documents into the
archive by dragging then into the ”Drag and Drop documents here” area.

To make the required changes we have provided a Form Interfaces fob file for each of the supported
languages.

p Contact _____
f=5 10000 The Cannon Group PLC - Customer Card . = @
Statistics F9
General | Communication I Invaicing I Payments | Shipping | Fa Statistics by Currencies
[ T 10000 (e ﬂ Entry Statistics
Mame., . . ... .. .. The Cannon Group PLC Sales
Address . . .. .. .. 192 Market Square Trr=aie e
Address 2, .. . .. ..
) — Service Contracts
Post Code/City . . . . . B27 4T [#] |Birmingham (
Country/Region Code . . |GB &) Service ltems
PhomeMo. . . . .. .. A Johs
Primary Contact Mo.. . . [#] Online Map
Contact. . . .. .... Mr. Andy Teal
Zetadocs Rules
Zetadocs Archive
Customer v] [ Sales v] [ Functions w Help

Figure 18 — Customer Card with Zetadocs Rules menu item added

Importing the Forms fob file

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and import the interfaces file included on your Zetadocs for
NAV CD relevant to the version and language of your install. e.g. Zetadocs for NAV V4.0 Interfaces —
NAVW16.01 (Forms).fob

It can be found in <CD Drive>:\Zetadocs NAV Server Components\<language code>\<database version>\.

e |Ifthere are no collisions continue with the import. If there is a collision it is recommended that you
export your existing objects and compare the version of the objects with the text file versions of the
interfaces detailed above, to determine the safety of the available merge/replace options in the
import worksheet. If it is impossible to replace or modify the existing forms in your database,
please refer to the following section for instructions on how to modify the existing forms manually.

Modifying NAV Forms Manually

If when attempting to import the Zetadocs for NAV forms into NAV you have collisions which make it
impractical to import the forms the following manual steps can be performed to provide the same
functionality.
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Zetadocs Rules

To allow users to adjust the rules for a customer or vendor from an option on the relevant card we require a
modification of the customer and vendor rule cards. The steps outlined below will add the Zetadocs Rules
menu item to the Customer button on the Customer card, see the above figure, and the Vendor button on
the Vendor card.

Adding the Zetadocs Rules to the Customer Card
e Open the object designer (Shift + F12)

e Open the Form in Design View.
e Select the Customer button.
e Right Click and select menu items.
e Scroll down and create the new menu item Zetadocs Rules.
e Set the Action to RunObject.
e Inthe RunObiject field enter Form Zetadocs Customer Rule Card.
e Select View > Properties menu item or press Shift+F4.
e Set the run form link to Customer No. = FIELD(No.).
Repeat this process for the Vendor Card using Vendor No. = FIELD(No.).

SharePoint Archiving

The following changes enable searching of SharePoint for existing archived documents from the card in
question by adding the Zetadocs Archive search menu item. Unlike the Zetadocs Rules which pertain to a
particular Customer and Vendor Before making these form changes you must ensure that you have applied
the tables changes detailed earlier.

The Zetadocs Archive search menu item can be added to the cards listed in the table below:

Form No. Form Name

21 Customer Card

26 Vendor Card

41 Sales Quote

42 Sales Order

43 Sales Invoice

44 Sales Credit Memo

507 Blanket Sales Order
6630 Sales Return Order

130 Posted Sales Shipment
132 Posted Sales Invoice
134 Posted Sales Credit Memo
6660 Posted Return Receipt
49 Purchase Quote

50 Purchase Order

51 Purchase Invoice

52 Purchase Credit Memo
509 Blanket Purchase Order
6640 Purchase Return Order
138 Posted Purchase Invoice
6650 Posted Return Shipment
140 Posted Purchase Credit Memo
136 Posted Purchase Receipt

Adding the Zetadocs Archive menu item can be done manually in several manners, we have provided details
for two of these methods below. Which you choose to implement is a matter of personal preference
however the second method is generally more efficient if you are rolling the feature out across a large
number of the above listed forms, which the first is better suited for small numbers of form modifications.

Method 1
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Log into Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

Open the object designer (Shift + F12) and select the form that needs to be modified and click the
Design button.

In this example we will look at modifying a Sales Quote form, for other form modifications please
follow these steps and select the relevant option to your form when prompted.

Right-click on the Quote button, or the corresponding button on your form, and select Menu Items.
Scroll down and at the bottom add a separator by using the Separator button.

Add a menu item with caption Zetadocs Archive.

While still on the Zetadocs Archive menu item, open up the C/AL Code editor by pressing F9.

Add the following code into the OnPush() function of the menu item:

ZetadocsUtilities.ShowRelatedDocsDialog('ZDARCHID', "Zetadocs Archive ID", STRSUBSTNO('%1-%2",
CurrForm.CAPTION, "No."));

Next add a local variable to the same function, called ZetadocsUtilities with data type Codeunit
and a subtype of Zetadocs-Utilities.

Close the form designer windows. Click Yes when prompted to compile and save the changes.
Repeat this process for any other required forms.

Method 2

Open the form in the object designer.

Select the FORM button.

Select all the forms you require from the table above using CTRL + Left Click.

Export the objects to text file. File>Export.

Locate the appropriate Zetadocs for NAV Interfaces (Forms) text file for your NAV version (4.0, 5.0,
6.0 or 6.01) on your Zetadocs for NAV CD or download from the W1 folder.

Either use a file comparison tool or search for Zetadocs Archive ID to identify the menuitem code to
copy and paste into the respective objects.

NOTE: the code differs between the company cards Customer/MNendor and the other record cards so you
should copy and paste from the correct objects.

Copy and Paste the separator and menuitem code from the Zetadocs for NAV Interfaces text file
and paste it into the respective area in your exported forms text file.

Save the changes and import your updated text file in to NAV.

Add the “EQX.XX” identifier to the Version List for each of the modified forms. (Where X.XX is the
Zetadocs for NAV version).

Compile the modified forms.

Check that the appropriate menu items have been created by running the form and check the
modified menu buttons.

If you commonly update databases of this version it is recommended that you label and save your
updated objects in a .fob file for use in future installations.
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File Edit Format View Help

currrForm. salesLines. FORM. openpPurchorderForm;
END;

{ Ip=202;
CaptionML=ENU=Speci&al order }
ID=203;
MenuLevel=l;
CaptionML=ENU=Furchase &order;
OnPush=BEGIN
currfForm. SalesLines. FORM.OpenspecialPurchorderForm;
END;

~

-~

ID=1000000000;
MenuItem pe=5eparator }
ID=1000000001;
CaptionML=[DAl

DE!

onPush=vAR|
Z

by
{ 66 ;MenuButton ;6820 ;12210;2200 ;550 ;HorzGlue=Right;
vertGlue=sottom;
CaptionML=ENU=F&unctions;
Menu=MENUITEMS

{ ID=67;
CaptionML=ENU=Calculate &Invoice Discount;
onPush=BEGIN

ApproveCalcInvDisc;

END;

{ ID=169;
Ellipsis=ves;
captionML=ENU=GeT Price;

4 m

Figure 19 - Zetadocs Archive Menuitem Code
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9. Modifying NAV Reports to work with Zetadocs 0 e
This section details the changes required to enable a NAV report to be sent using Zetadocs.

To make the process simpler and faster there is a sample report fob which you should have imported earlier
which contains a modified version of some of the standard NAV reports with the changes necessary to
enable it for sending with Zetadocs. It is recommended that you complete the previous sections of this
installation document before attempting to create a Zetadocs for NAV report, because much of the code to
be added to an existing report depends upon other Zetadocs for NAV objects.

9.1 Report Modification Methods

The sample NAV reports provided are based upon the standard NAV reports as shipped, as such if you have
any other modifications to your reports swapping the Zetadocs sample report for your existing report will
remove these changes.

As such there are three options available to you to enable your reports to work with Zetadocs:

e Use the sample Zetadocs report in place of the existing report of the same type.

e Use the Zetadocs NAV Report Modification Tool to update your existing reports.

e Manually make the required changes, either by updating your existing reports using the manually
steps outlined later. Alternatively if you are more familiar with performing the existing non
Zetadocs modifications you can modify the Zetadocs Sample reports with your existing changes.

Note: You do not need to use the same method for each report as you may have a mixture of standard and
modified reports in your existing system.

9.2 Backup Reports

In order to be able to uninstall the Zetadocs for NAV software it is necessary to backup any NAV reports you
are editing before installing the Zetadocs for NAV objects. Alternatively, reports can be duplicated and
saved with new report ID’s before adding the Zetadocs for NAV changes. Either way it is important to add
the Version List EQ4.0 after saving the completed report.

Open the NAV client and connect to/open the NAV database.

Open the Object Designer (Tools—> Object Designer).

Click on Report button in the designer menu.

Select all the reports that you are going to edit for Zetadocs for NAV.

Select Export objects in file menu (File->Export).

Export objects to a Backup of Reports before Zetadocs for NAV4.o.fob file.
Keep the Backup of Objects before Zetadocs for NAV4.o.fob in a safe place.

9.3 Importing the Sample Reports Forms fob file

Regardless of whether you wish to utilise our sample reports if you are intending to utilise Zetadocs
Delivery they need to be imported even if only reference material for you to review. This is because the
standard configuration files used later in the installation process will require them.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.
e Open the object designer (Shift + F12) and import the reports file included on your Zetadocs for
NAV CD.
e It can be found in <CD Drive>:\Zetadocs NAV Server Components\W1\<database version>\
e File options:
o Zetadocs for NAV v4.0 Sample Reports — NAVW16.01.fob
o Zetadocs for NAV v4.0 Sample Reports — NAVW15.00.fob

Sample Reports in fob file:

ReportID | Report Name

9009960 ZD-Blanket Purchase Order
9009961 ZD-Blanket Sales Order
0009962 ZD-Order Confirmation
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9009963 ZD-Order

9009964 ZD-Purchase — Credit
9009965 ZD-Purchase — Quote
9009966 ZD-Purchase - Invoice
9009967 ZD-Sales — Credit Memo
9009968 ZD-Sales - Invoice

9009969 ZD-Sales — Quote

9009970 ZD-Statement

9009973 ZD-Return Order Confirmation
9009974 ZD-Return Order

9.4 Using the Zetadocs Sample Reports

If you are able to use our sample modified reports in place of your reports, if they were unmodified for
example, then simply proceed to the steps in section 9.9 to assign these reports in NAV so they run in place
of the existing reports. Otherwise use the steps below to configure any remaining reports which you
require.

9.5 The Zetadocs NAV Report Modification Tool

Zetadocs for NAV comes with a Report Modification Tool which will edit your existing Classic Client Reports
enabling them to work with Zetadocs. We are continuing to develop the report modification tool with
lessons learned from ongoing system installations, please see our installation notes page for access to the
latest version of the tool and any other updates relevant to your installation.

The following should be taken into consideration when using this tool:

e The Report Modification Tool is currently only compatible with NAV 5.x and NAV 6.x classic clients.

e The tool does not perform all the changes required for Role Tailored Client reports, to adjust Role
Tailored Client reports we recommend running the reports through the tool and then performing
the additional edits in section 9.8.

e Anappropriate NAV license is required for exporting and importing the reports.

Using the Zetadocs NAV Report Modification Tool

e Open the NAV client and connect to/open the NAV database.

e Open the Object Designer (Tools=>Object Designer) and select the Report view.

e Select each report requiring modification from the list.

e Click on File>Export. Save the reports as a text file in a suitable location.

e Explore your product download and select the Zetadocs for NAV Report Modification Tool folder.

e Select and run the ZdNAVReportTool.exe, the Zetadocs NAV Report Modification Tool will open.

e Click on the Load Reports option.

e The tool will ask you to select the version of NAV your reports have been exported from.

e Next the tool will ask you to browse to the folder containing your exported reports.

e When selected any valid reports will be loaded into the table display, with any invalid reports
reported in a message dialog after the load operation has completed.

e Check that the reports listed are the correct set of reports that you wish to modify.

e  Click the Start button and the Conversion Options window will appear.

e Modify the new report ID range if required. This specifies the starting ID that the Report
Modification Tool will use for the first modified report. Subsequent reports will use values
incremented from this base value.

e Modify the report name prefix if required. This specifies a o to 3 character prefix that all reports will
have appended to their names. Leaving the prefix blank will allow the existing report name to be
used.

e The Merge output into a single file for importing into NAV option will be checked by default, if you
wish to produce a separate file for each report uncheck this option.
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o Adialog may pop up asking to delete the existing output directory if there already is one. You may
wish to back up this directory before proceeding.

e During the conversion process, a progress bar at the bottom of the Report Modifier window gives
an indication of the progress of the conversion job.

e Astatus column in the report list shows the status of the conversion process. If a report cannot be
modified, the reason will be listed in this column. For successful conversions, the new report ID and
report name are given.

e The modified reports are now available in the folder containing the original reports, in an Output
subfolder.

e Return to NAV and open the Object Designer (SHIFT + F12) and select the Report view.

e Click on File=>Import and select the txt file to import, or files if you have had the tool produce
separate txt files.

e Deal with any merge and conflict messages that may appear.

e Should you be modifying Role Tailored Client Reports you now need to perform the manual steps in
section 9.8.

e Once Zetadocs for NAV has been correctly installed and configured, perform a test delivery with the
imported report(s) to ensure they operate as expected.

9.6 Manually modifying your existing reports
The following instructions need to be followed to modify an existing report to work with Zetadocs, simply
repeat these steps for each report you wish to configure.

e Open the report designer for the report that you want to modify.

e Scroll to the empty row at the bottom and create a new Integer data item called Zetadocs.
e Indent this data item once.

e Change the DataltemTableView property to SORTING(Number).

e Change the MaxIteration property to 1.

e Now add the following global variables:

Name Data Type Sub Type
ZdSend CodeUnit Zetadocs-Send
ZdRecRef RecordRef

e Add the following code to the OnPostDataltem trigger for the Zetadocs data item:
ZdRecRef.GETTABLE(<Main Data Item>);
ZdSend.AddRecord(ZdRecRef. RECORDID);

e Select an empty row on the report and press F9 to view the report code.

e Enter the following code after any existing code in the OnPreReport trigger:
ZdSend.Initialize(CurrReport. OBJECTID(FALSE), CurrReport. PREVIEW);

e Enter the following code after any existing code in the OnPostReport trigger:
ZdSend.ProcessRecords;

9.7 Classic Client specific layout modifications
Below are the instructions for modifying the classic report layout to include the Zetadocs reference, which is
required to add addressing information to the report once it has been printed.

e Click View = Sections to show the classic client report designer.

e Open the toolbox and add a text box that it will appear at the top of the report.
e Change the SourceExpr property to ZdSend.GetZdReference(<COPYNUMBER>).
(<COPYNUMBER> is CopyLoop.Number if you have a copy loop or 1 if not.)
e Change the FontSize property to 4.
e Change the DataSetFieldName property to Zetadocs_Reference, Note: This field is only available
in NAV 6.0 and later and should be ignored on earlier versions of NAV.
e Close the sections window.
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9.8 Role Tailored Client specific layout modifications

Following are the instructions for modifying the layout of the report for use with the role tailored client. If
your version of NAV does not have the role tailored client, skip this step.

There are two different methods that can be followed to add the Zetadocs reference to the role tailored
client report depending on how it has been designed.

(i) Body Section Only
The remittance advice journal report is an example of a report that does not have a page header section.
When this is the case, follow the instructions below to add the Zetadocs reference.

e C(lick View ->Layout to open the report designer for Role Tailored Client reports.

e Open the tool box and drag a new text box into the section of the report where the header data is

displayed. Note: Ensure the textbox does not overlap any existing controls.
e Change the Value property to =Fields!Zetadocs_Reference.Value.
e C(Close and save the report.

(ii) Header and Body Section
The Order confirmation report is an example where the page header section is used to display header
information on each page for the record. When this is the case, follow the instructions below to add the
Zetadocs reference.

e C(lick View - Layout to open the report designer for the Role Tailored Client reports.

e Add a new text box to the body section of the report.

e Change the Name property to Zetadocs_Reference_th.

e Change the Value property to =Fields!Zetadocs_Reference.Value.

e Change the Visibility >Hidden property to TRUE.

e Change the Color property to Red.

e Add anew text box to the top left of the page header section of the report. Note: Ensure the

textbox does not overlap any existing controls.

e Change the Font size and Color properties to values that you are happy with.

e Change the Value property to =Reportltems!Zetadocs_Reference_tb.Value.

e C(Close and save the report.

(iii) Version Code

Once you have saved the report add EQ4.0 to the Version List column in the Object Designer. Adding this
value is essential to ensure easy identification of reports modified for Zetadocs for NAV, in particular, for
uninstalling Zetadocs for NAV at a later point.

9.9 Setting NAV to run the correct reports

Now that you have completed the report modifications we need to set NAV to run the correct reports. The
steps below will take you through adjusting the Report Selections in NAV and the Zetadocs Report Settings
Card to ensure the both reference the same reports.

(i) Setting NAV to run the new report

If you are intending to use a sample report you will need to set NAV to run that report instead of the existing
report. In this example we will set NAV to run the sample Order Confirmation report, this process should be
repeated for each new report being used.

Open the NAV client and connect to/open the NAV database.

Select the Administration option from the Navigation pane.

Expand the folder relevant to the report to be setup, in this case Sales & Marketing.
Select Report Selections, the Report Selection — Sales card will open.
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Seguence |F‘.eport 1D |F‘.eport Mame |
3 1 205 Order Confirmation -

Figure 20 - Report Selection - Sales Card

e Select the Order report from the drop down.
e Click into the Report ID field and select the arrow to open the Objects list.
e Select the new object from the list, in this case 9009962 ZD-Order Confirmation.
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Zetadocs provides a range of standard data sets which populate the Zetadocs settings

tables and provide a basic system setup. These are provided based upon the version of NAV, the system
language/database e.g. GB or W1 as well as by feature set. This means there are specific configuration files
according to which modules you are installing, one for Delivery another for Capture and a third for both.
Once this system base has been created using the standard configuration file you can then fine tune the
system to operate as per your requirements. To import the data you will need to access the Zetadocs setup
within NAV, if you have just imported the Zetadocs for NAV menusuite you will need to restart NAV to add
these options to the Navigation Pane.

Zetadocs for NAV Installation Guide

10.1 Importing the Zetadocs Standard Configuration Data

e C(lose and then open NAV to update the menusuite with the changes imported earlier and select
the Administration option from the Navigation Pane.

e Select the Application Setup sub folder within it and then Zetadocs Setup, you may need to right
click on the Navigation Pane and select Refresh to make the newly installed menusuite options
available.

e Runthe Zetadocs Configuration Import Form, the form shown in the figure below will appear.

e |Ifyou are using Zetadocs Delivery you need to identify where your templates are to be stored,
choose either the checkbox for the default location or add the Template Path.

e Next select the XML file path field to browse to the file relevant to your NAV system version, in the
Zetadocs NAV Server Components folder followed by the relevant country code and NAV version
e.g. for a NAV 6 sp1 system installing Zetadocs Delivery only it would be <CD Drive>:\Zetadocs NAV
Server Components\W1\6.01\Zetadocs for NAV v4.0 Standard Data (Delivery) - NAVW1 6.01.xml

e Once selected click the Import button.

ol

Templates Shared Folder Location (Mot Required for Capture only systems)
[ Use default {\\SERVERMAME\Zetadocs Templates\):

Templatespath . . . . . . . | 1l

Import configuration XML file
XML filepath . . ... ... | ]

Import Help |

Figure 21 — Zetadocs Configuration Import Form

e Awarning message will appear informing you that the import will clear all Zetadocs setup data
from the tables, select Yes to continue.

e Afinal warning screen will appear asking you if you are sure you wish to import the data, select Yes
to install the data. If you have not imported our Sample Reports and attempt to import either the
Delivery or Both XML files you will see an error message. Either install the reports first of if not
using Delivery select the Capture only XML file.

You will now have a basic system setup and should be able to print any reports setup earlier and they will
be delivered as per the rules contained in the standard data.

10.2 Changes required for a basic Delivery working system

On importing the Zetadocs Standard Configuration data you will have populated the Zetadocs Report
Settings Card, this data assumes you are using the sample reports provided. As such if you have modified
some or all of the existing reports you now need to adjust the Zetadocs Report Settings accordingly.
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Open the NAV client and connect to/open the NAV database.

Select the Administration option from the Navigation pane.

Choose the Zetadocs Setup option and then Advanced Settings.

Open the Zetadocs Report Settings Card.

As you can see in the figure below we have associated a report in this case 9009969 (Sales —

Quote) with a document set and associated settings.

e This report will not however be run by NAV unless the above edits to the Report Selections table
have been done for this report so we need to adjust the Report ID to match the report NAV will run.
Select the report you wish to modify the settings for.

Select the Report ID field and choose the correct report from the Object list.

e Repeat the process for any remaining reports.

- o

Sales - Quote Sales - Quotes - Zetadocs Report Settings Card = |[ =[]
General |Tab|e Mapping I Options |
ReportID. . . . . ... 90099569 (%)
ReportMame . . . . . . i5ales - Quote [E)
Document SetMo,, . . . |ZDO000S (]
Document Set Mame, . . | Sales - Quotes

Archive Document Type .

Default Batch Mame . . .
Comments . . . . . ..
Setting v] [ Help ]
Figure 22 - Zetadocs Report Settings Card — General Tab
Properties:

e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with one Zetadocs Document Set.

10.3 Understanding Zetadocs for NAV Standard Configuration

Having imported the standard configuration data and reports into NAV and added the few system specific
pieces of information you should have a basic working system at this point. It should be capable of sending
reports from NAV to recipients using the standard reports and templates included and should you have
completed the SharePoint installation as well documents should also be archived to SharePoint.

Adjusting NAV Settings and Rules
The data imported into NAV reflects a standard installation and may not match your specific requirements;
the main settings are as follows:

e Zetadocs System Settings —with Fax disabled, archive enabled

e Zetadocs Document Sets — standard set of templates for all Sales and Purchase documents
e Zetadocs System Rules — set rules with delivery, defaulting to email only

e Zetadocs Reports Settings — setup for all standard Sales and Purchase reports

Default System Settings

Archive Enabled: Depends upon archiving selection on import of configuration data.
Fax Enabled: No

Logging Enabled: Yes

Log Level: Error
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Archive Folder Structure: Date (YYYY-MM-DD)

Report Name

Doc Set
No.

Doc Set Name

Template
ID.

Template Name

Delivery
Method
1

equisys

Delivery
Method
2

ZETAQOOCS®

Capture. Deliver. Share.

Delivery
Method

3

Default 0 Default ZT00000 Blank Email
Purchase Quote | ZDooo1 | Purchase - ZToo001 ZD-Purchase Email
Quotes Quote Template
Purchase Order | ZDooo2 | Purchase - ZT00002 ZD-Purchase Email
Orders Order Template
Purchase Return | ZDooo3 | Purchase - ZT00003 ZD-Purchase Email
Order Return Orders Return Order
Template
Blanket ZDooos | Blanket ZT00004 ZD-Blanket Email
Purchase Order Purchase Orders Purchase Order
Template
Sales Quote ZDooos | Sales Quotes ZTo0005 ZD-Sales Quote Email
Template
Order ZDooo6 | Order ZT00006 ZD-Order Email
Confirmation Confirmations Confirmation
Template
Sales Invoice ZDooo7 | Sales - Invoices | ZToooo7 ZD-Sales Invoice Email
Template
Sales Credit ZDooo8 | Sales Credit ZTo0008 ZD-Sales Credit Email
Memo Memos Memo Template
Sales Return ZDooog | Sales Return ZT00009 ZD- Sales Return | Email
Order Orders Order Template
Blanket Sales ZDoo1o | Blanket Sales ZTo0010 ZD- Blanket Sales | Email
Order Orders Order Template
Remittance ZDoo11 | Remittance ZTooo011 ZD-Remittance Email
Advice Journal Advice - Journals Advice Journal
Template
Statements ZDoo12 | Statements ZTo0012 ZD- Statements Email
Template
Purchase ZDoo13 | Purchase ZToo0013 ZD-Sales Invoice Email
Invoice Invoice Template
Work Order ZDoo14 | Work Orders ZT00014 Email
Purchase Credit | ZDoo1s | Purchase Credit | ZTooo1s Email

Memo

Memo

By examining this table you should be able to identify the areas where the standard document delivery
settings differ from your needs. The steps below will explain how to adjust these settings.

10.4 Setting the Zetadocs System Settings

To modify the default Zetadocs System Settings:

e Open NAV and select the Administration option from the Navigation Pane.
e Select the Application Setup sub folder within it and then Zetadocs Setup.
e Select the Zetadocs System Settings form.

Archiving Enabled
This option denotes whether Zetadocs will attempt to Archive documents on delivery or not. Enabling this
option allows access to the two archiving location options below.

Shared Network Folder
Shared network folder archiving can be enabled by adding a suitable network folder location to this
field. You must also ensure that all Zetadocs enabled users have permission to access this folder.
Note: This option does not support any of the Zetadocs for NAV search features which require
SharePoint integration.

SharePoint Site
This setting should be the address of your SharePoint document library, should you be utilizing

one.
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Fax Enabled

Requires the installation of a Zetafax system. For instructions on Zetafax installation please refer to the
Zetafax Setup guide located on the Zetafax product CD. NOTE: When faxing is disabled on the Zetadocs
System Settings form the system does not prevent the creation of rules including fax, however, attempts to
use fax addressing may prompt warnings during sending any documents that attempt to use fax addressing
will be displayed in the Zetadocs Batch Delivery Settings Dialog as an error.

Logging Enabled

To be used for troubleshooting installations and support issues. Enabling logging causes a text based log to
be written to each NAV user Windows %Temp% folder (ZetadocsNAV.log). The Log Level specifies the
amount of detail in the log.

Log Level

ERROR — Only writes error information to the log

WARNING - Writes any potentially problematic and error information to the log

DEBUG- Writes all levels of detail for troubleshooting difficult problems. Recommended only when
obtaining support or during installation and configuration.

Reference Prefix

The reference prefix is the first part of the reference code printed onto documents sent using Zetadocs, it
can be a maximum of 15 characters long.

=

Archiving

| E3|
Fax Enabled . . . . .. r
Logging Enabled. . . . . v
Loglevel . . . ... .. |ERROR =]
Reference Prefix . . . . [ZDRef

Help |

Figure 23 - Zetadocs System Settings

10.5 Template Settings

Zetadocs Templates combine stationery overlays and attachment documents as well as supplementary
addressing for any document sent using that template from the Zetadocs Client. The templates can be
created in the Zetadocs Client and saved to a shared network location. For more information on creating
Zetadocs Templates and setting up Zetadocs Shared Network folders please consult the Zetadocs Client
help. Zetadocs will already have created entries for each type of report supported, these can be modified in
the Zetadocs Client, the section on document templates explains this further. Should you wish to change
the template a report uses, for example if you wished to send out all correspondence for a period with
special attachments or a message as part of a special offer. Then you can create additional templates in the
Zetadocs client and assign them by doing the following.

e Open NAV and select the Administration option from the Navigation Pane.
e Select the Application Setup sub folder within it and then Zetadocs Setup.
e Select the Zetadocs Templates form.

e Select Template>List or press Fs.
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e Choose the Template you wish to modify and select OK.
e Select Path to choose another template.
e The name field will automatically populate, add a suitable Description and close the form.

ZD0000 OrderConfirmation - Zetadocs Templa... | = |[ & |[#3]
Template ID. . . . . . . ZD0000
Path . . v v v v 0 v v s {\WMC1\Zetadocs NAY Templates\Orderi[4]
Mame, . . ... OrderConfirmation
Description . . . . . . . Company Logo and Terms for Order Ca...
[ Template v] [ Help

Figure 24 - Zetadocs Template Card

10.6 Zetadocs System Rules

The Zetadocs System Rule card is where the Zetadocs Document Set rule is defined. It brings together the
format (templates), delivery method (contact addressing) and archiving options (SharePoint document
library, Archive Document Type and document library subfolder structuring).

o Define the default Zetadocs Document Set.

e Select the default document set (o)using the “Document Set No.” property lookup on the
“General” tab.

e  Specify the desired delivery method failover order (remember to only specify Fax if you have
Zetafax Server installed).

e Choose a “Template” from your imported template references.

e Enter an email address that reports using this rule will be sent from.

e  Onthe Archiving tab enable archiving (remember only if you have SharePoint).

e Complete the remaining archive options if applicable.

¢ On the Additional Recipients section, enter the contact information of any additional contacts that
will receive a copy of the reports using this rule.

Properties:
Once you have selected the document set to define, it cannot be changed for that record.
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= 0 Default - Zetadocs System Rule Card E@
General | Archiving
Document SetMo.. . . . o+
Document SetMame. . . | Default
Template ID. . . . . . . ZTO0006
Template Mame . . . . . ZD-Order Confirmation Template
Delivery Method Priority . |E-Mail [=] |Fax (=] |Hard Copy (=]
E-Mail From . . . . . . . sale @equisys,com
Comments . . . . ...
Delivery Type ContactMo.  Name Company Address Additional Recipient Information

) | E-Mail To [+ - Mame:

L Company:

1 Address:

4 m 2
Rule vJ I Help

Figure 25 - Zetadocs System Rule Card — General Tab

General Tab

o Delivery Method Priority: Implies that if the contact information being used during the sending of
a document that uses this rule is missing addressing information, the next highest priority method
will be used. For example, if the Delivery Method Priority was “E-Mail, Fax, Hard-copy” and the
contact information being used had no email information but did have fax information, then fax
addressing would be used. Similarly, if there was neither email or fax information, then the
document would be printed from Zetadocs to the local system default printer.

e Template: Optional.

o Email From: Optional. The user must have access to send emails using the address entered. If left
blank the user’s default email account will be used.

e Comments: Field for any additional information you may wish to add.

¢ Additional Recipients: Optional. This field is available on both the general and archiving tabs.
Enter additional recipients either by selecting a contact or by entering the information manually.
The delivery methods available are E-Mail (To, CC or BCC) and Fax. You can enter a maximum of 5
additional recipients for a system rule. E-Mail distribution lists are supported but they must be
entered as their full E-Mail address and not an alias (E.g. support@equisys.com)
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0 Default - Zetadocs Systern Rule Card [ = |
Archiving
Archive Sent Documents, |V
Archive Library . . . . . Archive
Archive URL, . . . . . . http://2008serverstd/fArchive
Folder Name Structure:
@ 5ub Folders DATE =l =] =]
Custom (A VIV I
Date Folder Maming . . . |Y¥YY-MM-DD  [=]
Delivery Type ContactMNo. MName Company Address Additional Redpient Information
#p | E-Mail To - Name:
L Company:
[ Address:

] i s

Rule v| | Help

Figure 26 - Zetadocs System Rule Card - Archiving Tab

Archiving Tab
e Archive Sent Documents: Determines whether Zetadocs for NAV will attempt to archive sent
documents.

e Archive Library: Only specify the SharePoint document library name, not the full URL.
e Archive URL: Displays the full target archive library by concatenating the SharePoint Site from the
Zetadocs System Settings and the Archive Library property.
o Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint
document library based on information from the sent record. The Custom radio button allows you
to specify new folder structuring values. Currently, no others have been implemented.
o COMPANY - The recipient NAV Customer name
o DATE - The Date with a format specified by the “Date Folder Naming” property
o DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document
Set, or its override in the Zetadocs Report Settings
Date Folder Naming- Allows you to specify the format of the date folder structure in the

SharePoint archive. E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

10.7 Zetadocs Report Settings

The Zetadocs Report Settings is where Zetadocs enabled reports can be associated with a particular
Zetadocs Document Set and therefore a rule definition for sending (template, delivery method, archiving
settings, additional recipients). It is also where recipient information settings are specified. The
configuration data will populate these fields with our standard data setup, it may be necessary to adjust
these values to meet your requirements.
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- o

=4 Sales - Quote Sales - Quotes - Zetadocs Report Settings Card = | B[]
General |Tab|e Mapping I Options |
ReportID. . . . . ... 9009963 (%]
ReportMame . . . . . . iSales - Quote
Document SetMo., . . . |ZD0O000S (%]
Document Set Mame, . . | Sales - Quotes

Archive Document Type .
Default Batch Mame . . .

Comments . . . . . ..

Setting v] [ Help ]

Figure 27 - Zetadocs Report Settings Card — General Tab

Properties:
e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with one Zetadocs Document Set.

General Tab

e Report ID: The Report ID is unique value given to identify each report.

e Report Name: This field is populated when the Report ID is selected.

o Document Set No.: The Document Set No. corresponds to the key field of the Zetadocs System Rule
Table linking the report to rules for its distribution.

o Document Set Name: Contains the name of the rule that is being applied to the report, it is
determined via the Document Set No. selection.

e Archive Document Type: The Archive Document Type determines the document type the report will
be stored under in SharePoint, please ensure you have created the appropriate content types in
your SharePoint archive to match these settings.

o Default Batch Name: When a report prints a number of records to Zetadocs they are held in a batch
in the Zetadocs Client. This field allows you to specify a name for the batch that will be visible in
the Zetadocs Client document explorer.

e Comments: Field for any additional information you may wish to add.
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Sales - Quote Sales - Quotes - Zetadocs Report Settings Card

Table Mapping | Options

-

=4 Eo[E5

Company Type Code . . |CUST (%]
Company Mo, Field Mo, . 2
Contact Mo. Field Ma. . . 5052
Record Mo, Field Mo, . . |E

Setting

v] [ Help ]

Figure 28 - Zetadocs Report Settings Card - Table Mapping Tab

Table Mapping Tab

e Company Type Code: This specifies a table relation between the report record and the recipient.
For example, the standard Sales Quote report is to be sent to a Customer. Therefore, we select

‘CUST’ for the Company Type Code from the Company Type Code List.

e Company No. Field No.: Specifies the field no. of the field in the table the report is based on where
the Company No. should be taken from. For example, the standard Sales Quote report is based on
the Sales Header table. The Customer No. in the Sales Header table is the field “Sell-to Customer

No.” field no. 2.

e Contact No. Field No.: Specifies the field no. of the field in the table the report is based on where
the Contact No. should be taken from. For example, the standard Sales Quote report is based on
the Sales Header table. The Contact No. in the Sales Header table is field “Sell-to Contact No.” field

no. 5052.

o Record No. Field No.: Specifies the field no. of the field in the table the report is based on where
the records No. should be taken from. This can be used as a dynamic field for writing the record no.
into a template message as a reference to the recipient and also as a searchable field in the

Zetadocs SharePoint archive.
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Sales - Quote Sales - Quotes - Zetadocs Report Settings Card = [ = | [eES]
| General | Table Mapping | Cptions |
Show Delivery Dialog!
Show Batch Delivery Dialog
Preview in Zetadocs Client
Test Mode [
Setting v] I Help
Figure 29 - Zetadocs Report Settings Card — Options Tab
Options Tab

e Show Delivery Dialog: Controls the display of the delivery dialogs which allow run-time user
overriding of send results.

o Show Batch Delivery Dialog: Controls the display of the delivery dialog which allows the user to
view and fix any send result errors.

o Preview in Zetadocs Client: Controls the default value of previewing the Zetadocs documents in
the Zetadocs Client before sending. If the delivery dialog is shown the default can be overridden by
the user.

o Test Mode: This field allows the administrator to prevent the report from printing the report results
to Zetadocs. It is useful when troubleshooting problems on a live system. When the report is run it
will run as normal up to the point of printing the report documents to Zetadocs.

10.8 Zetadocs System and Company Rules

The Zetadocs System Rules were explained earlier as the ability to define how a message being sent is
delivered (Email, Fax or Hard-Copy), how it is formatted (Zetadocs Templates), from which address the
message is sent and where it is archived. By now you should realize each Zetadocs Document Set can have
a separate definition of these sending settings.

Zetadocs for NAV also has Company Rules, these are the Zetadocs Customer Rules and the Zetadocs Vendor
Rules which add another level of control. The sending rules are best explained as a set of override rule
definitions. It can be viewed as a 4 level system which overrides particular rule settings dependent upon the
document set, the company or a combination of both.

LEVELS:
1. The Default Rule
o Allows you to specify a basic rule that can be used by any Zetadocs enabled report.
2. Per Document Set
o Allows you to specify more specific settings for Zetadocs enabled documents by type.
3. Per Company
o All Zetadocs enabled documents being sent to a particular company can have the
following rule settings overridden (This includes documents which are being sent using
either the Level 1 or a Level 2 rule settings):
i. The contact information to which the document will be sent
ii. The method of delivery by which the document will be sent (Email, Fax, Hard-

Copy)
4. Per Company, per Document Set
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o All Zetadocs enabled documents being sent to a particular company and that are part of a
particular document set can have the following rule settings overridden (this includes
documents which are being sent using either the Level 1 or a Level 2 rule settings and has

had some settings already overridden by a Level 3 rule settings)
i. The Zetadocs Template that will be applied to the document
ii. The contact information to which the document will be sent

iii. The method of delivery by which the document will be sent (Email, Fax, Hard-

Copy)

To visualize this, let’s look at an example, in this case the default configuration has been imported using the
steps earlier in this section. We will demonstrate scenarios which require the creation of level 2, 3 and 4

rules.

(i) The Level 1 Rule — Default Rule

The Zetadocs System Rule card shows the level 1 rule that will apply to all documents by default unless
overridden by a higher level rule. In this case documents are sent using email with the default template. We
can also set the archiving options on the Archiving Tab, in this example we will set the system not to

archive.

0 Default - Zetadocs System Rule Card

General | Archiving

Document Set Na.. . . . o)
Document Set Name. . . |Default

Template 1D, . . . . .. ZFT00000 (#]
Template Mame . . . . . ZD-Default Template
Delivery Method Priority . |E-Mail (=]
E-Mail From . . . . . . . sales @equisys.com

Comments . . . . ...

[

[

Delivery Type ContactMo. Name
» E-Mail To

Company

Address

Additional Redpient Information

Rule v] l

(===

Figure 30 - Level 1 Zetadocs System Rule Card

(ii) The Level 2 Rule — per document set

Requirement

The sales team has stated a requirement whereby all order confirmations are sent with a copy of the terms

and conditions and use a standard email template.

Solution

Zetadocs templates can be setup to provide all this functionality as described in section 11. Assuming we
have created a suitable template or modified one of the Zetadocs templates provided as required. A level 2
rule needs to be setup to ensure this template is applied but only to order confirmations.

e Select the Document Set No. drop down field and choose Order Confirmations.
e The card will populate as shown in the figure below, notice how the ZD-Order Confirmation
Template has been assigned as this is configured as part of the standard configuration data

imported earlier.
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The level 2 rule details shown below will apply to all documents with the document set Order Confirmation,
meaning that any Order Confirmation document will be sent using the ZD- Order Confirmation Template
whilst the others will use the level 1 rule and thus the default template.

ZD00006 Order Confirmations - Zetadocs System Rule Card E=xERE==|
General | Archiving
Document SetMo.. . . . |ZD0O000& (4]
Document SetMame. . . | Order Confirmations
Template IDL . . . . . . ZTO0005 (4]
Template Mame . . . . . ZD-Order Confirmation Template
Delivery Method Priarity . |E-Mail =] =\l =]
E-Mail From. . . . . . .
Comments . . . . ...
Delivery Type Contact Mo,  Mame Company Address Additional Redpient Information

#b |E-Mail To » | Name:

L Company:

1 Address:

€ 1 3
Rule vJ l Help

Figure 31 - Level 2 Zetadocs System Rule Card

(iii) The Level 3 Rule - per Customer

Requirement

Following discussions with one of our customers Cronus Corp, the sales team has requested that all
correspondence be sent to Mindy Martin, with the exception of Order Confirmations which should instead
go to John Emory by fax.

Solution
We need to make a change which affects all items sent to a particular customer, this is done by creating a
level 3 customer rule. We then need to speciy a level 4 rule to cover Order Confirmations.

e Select the Administration option in the Navigation pane and then Application Setup.

e Open the Zetadocs Setup > Advanced Settings section and select the Zetadocs Customer Rule
Card.

e Select the delivery tab, shown below, and select Use Contact: if the new contact is already in your
NAV database or Use Alternate: if it is not.

e Select or add the details of the recipient, in this case Mindy Martin, as required.

e All documents sent to Cronus corp will use these details.
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The Cannon Group PLC Default - Zetadocs Customer Rule Card EI@
- Delivery | Template
_ Contact Information
(©use Default Mame Mindy Martin
@) Use Contact: CT200136 E-Mail mindy.martin @cronuscorp....
(1 Use Alternate: Fax No.
Fax Mo
Delivery Method . . . . . . Use Customer Default (=] Template Information
Mame ZD-Default Template

Additional Recipient Information

Delivery Type Contact MNo. Name Company Address
¥ | E-Mail To - Name
| Company
: Address
] i 3
Rule v] [ Help ]

Figure 32 - Level 3 rule shown on Customer Rule Card

(iv) The Level 4 Rule - per Customer per Document Set

Requirement
The previous level 3 rule will now send all documents to Mindy Martin, but the requirement was for Order
Confirmations to go John Emory by fax.

Solution
We need to make a change which affects all items sent using the Document set Order Confirmation and to a
particular customer, this is done by creating a level 4.

Select the Administration option in the Navigation pane and then Application Setup.

Open the Zetadocs Setup section and select the Zetadocs System Rule Card.

Select the Document Set No. field and select Order Confirmation.

Select the delivery tab, shown below, select Use Contact: if the new contact is already in your NAV
database or Use Alternate: if it is not.

Select or add the details of the recipient, in this case John Emory, as required.

e Select the Delivery Method field and select fax.

e You have now created the level 4 rule.

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved Page 59



equisys

Zetadocs for NAV Installation Guide ZETAOOCS®

Capture. Deliver. Share.

The Cannen Group PLC Order Confirmations - Zetadocs Customer Rule Card El@
- Delivery | Template
Contact Information
Use Default Name John Emory
Use Contact: E200156 E-Mail
@ Use Alternate: FaxNo. 02072034005
Mame. . . ... .... John Emory
EMail, . . ... ... |
FaxMo.. . ... ..., 02072034005
Delivery Method . . . . . . Fax = Template Information
MName ZD-Crder Confirmation Tem...

Delivery Type Contact Mo,  Mame Company Address Additional Recipient Information
##  E-Mail To - MName
Company
- Address
4 (1] 3
Rule vl | Help

Figure 33 - Level 4 rule shown in the Customer Rule List

Starting from the top then, the internal processing determines the send settings by building the results from
the lower level rules up. Assume we are sending an order confirmation and it uses the document set
ZDo0006 — Orders Confirmations.
This will determine the delivery information from the Level 1 & 2 rules specified above:

e Delivery Method: Email

e Template: ZToooo06 - Order

e Archiving Settings: Do not archive

e Contact: Use Default contact
When we consult the Level 3 Rules we see that any document being sent to “The Canon Group PLC” (from
the Level 3 figure above) will be sent to “Mindy Martin” instead of the contact specified by default for the
company we are sending to.
This would mean:

e Delivery Method: Email

e Template: ZDoooo - Default

e Archiving Settings: Do not archive

e Contact: Mindy Martin

However, the Order Confirmation document has been made part of ZDooooé, therefore the Level 4 settings
will be applied and it will be sent to John Emory and by fax.
So the final settings will be:

e Delivery Method: Fax

e Template: ZDooo6 — Order Confirmation

e Archiving Settings: Do not archive

e Contact: John Emory

Additional Recipients

The additional recipients define in the system and company rules do not override those from the lower level
rule as the other settings do. They are additive. If additional recipients are added for a document set
(ZDoooo6 — Order Confirmations for example), any document sent using that document set will be
addressed to these additional recipients, along with the additional recipients set at a higher level.
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10.9 Zetadocs Capture Essentials Setup
The Zetadocs Capture Essentials components make use of several of the general system settings like
archive location but do have some specific settings that require configuration.

e Open NAV and select Administration from the Navigation pane.

e Next choose Zetadocs Setup = Advanced Setting = Zetadocs Sales Capture Setup.

e The form allows you to specify the fields below, these determine how items are archived when
dragged and dropped onto the document fast tab.

e Once you have added suitable values repeat the process for the Zetadocs Purch Capture Setup
form.

Fields:
Archive Library: Only specify the SharePoint document library name, not the full URL.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document
library based on information from the linked record.
COMPANY — The “ORGANIZATION” metadata value.
DATE - The Date with a format specified by the “Date Folder Naming” property.
DOCTYPE — Adds “Document Queue” to the folder structure.
Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint
archive. E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved Page 61



equisys
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

11. Using Preconfigured Document Templates e
Zetadocs for NAV has a number of preconfigured document templates included within it to make

setting up a system quicker and easier. These templates contain Zetadocs stationery and a message body
which have been deliberately constructed to provide a starting point from which to build and customize

your system. Should you wish to construct your own templates instructions on manually creating them are
available in the help installed with the Zetadocs Client. You should though find it easier to follow the
instructions here to modify the standard templates to your needs.

Note: If you are installing in a language other than English you should first check your templates folder as it
should contain a folder with templates specific to your language. Copy these files into the main templates
folder replacing the existing English language templates before proceeding with the steps below.

11.1 Preconfigured Document Template Features
The document templates contain Zetadocs stationery and a suitably generic message body reflective of
each templates purpose.

Attachments
The document templates come without an attachment included to allow you to include your own company
specific documents like terms and conditions that you may wish to distribute.

Stationery

A single stationery file has been provided which by default is applied to all ZD Templates included with your
installation. This means you would only be required to update this stationery once for it to apply to all
document templates.

Message Body Text

The message body text contains a default message which would form the email message body and subject
when the document is sent using Zetadocs for NAV. This allows for the use of dynamics fields to populate
information from NAV automatically into the email reducing the time required to process business
documents. In the message in section 11.4 you can clearly see several examples of these fields.

Viewing the Template details
To view the Zetadocs for NAV template details simply:

e Open the Zetadocs Client.

e Select the Shared network folder setup earlier containing your templates in the accessories pane
on the right hand side using the folder drop down box shown in figure 3. If the accessories pane is
not displayed select the Accessories button from the toolbar to display it.

e Ensure the Type drop down box is set to Templates.

e Double click on the Template you wish to adjust to open the Document Template Wizard.

e The pages of the wizard cover contain:

o AnlIntroduction to templates

Assignment of attachments

Assignment of Stationery

Email properties

Template Review and Save

O O O O
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Accessones ]
Folder: Fetadocs for NAY  w | X
Type: Templates w

_/vf| B asic

_/vfl Conditions of Purchase

_/ef_l Conditions of Sale

_/qf_l General ZDMAY Template

_/ef_l Purchase Invoice ZDNAY Template
_/vf.| Purchaze Order ZDMAY Template
_/vf_l Sales [rvoice ZDMAY Template

(]

Sales Order ZDMAY Template

Figure 34 - Opening the Document Template Wizard

11.2 Template Wizard - Adding an attachment to a template

The preconfigured templates supplied do not come with an attachment included as this would make them
unusable *out of the box’ as such if you require attachments to be sent along with your business documents
then please follow the steps below.

Any file that you use on a regular basis can be stored as an attachment file for ease of use. These files can
be attached to any spooled document prior to sending quickly and easily using the Accessories tool. By
specifying an attachment in a template you ensure it is always included when a document is sent using that
template with Zetadocs for NAV.

Note: That if your attached file is large this may reduce performance when sending large batches as the
attachment would have to be processed for each document delivered. As such we would recommend that
you check to ensure that attachments are as efficient in terms of memory required as possible.

To add an attachment simply:

e Copy your desired attachment (e.g. terms and conditions) in pdf format into the shared folder
location, likely to be in the form \\ServerName\Zetadocs Templates\

e Open the Zetadocs Client and select the template you wish to modify by double clicking on it in the
Accessories pane, see Figure 34.

e The template wizard will open, Select Next to reach the attachments step of the wizard.

e Select the Shared Network Folder by selecting the Folder drop down box.

e Your attachment should appear as one of the attachment options.

e Select the attachment and click the Add button.

e Select Next to be taken to the stationery template wizard page. If you are happy with the existing
settings in the remaining wizard steps skip past them using next and select Finish to save your
changes.

11.3 Replacing the stationery

The templates comes with stationery included, this single piece of stationery is applied to all of the
templates provided. As such by simply replacing this one file you can ensure your stationery is applied to all
of the provided templates.

Note: That if your stationery file requires a large amount of memory this may reduce the performance of
Zetadocs when sending large batches. This is because it would have to be processed for each page of each
document delivered. To reduce the size of this document we would recommend ensuring that any images
used are of a suitable format, quality and size. We would also recommend that users avoid scanning their
existing paper stationery as this creates large files, it is better instead to isolate and extract any images or
required elements before recreating the overall effect using word for example. It should be possible to
create stationery of a suitable quality which is around 30kb's in size or less.
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Adding company stationery to the Zetadocs client
To add your stationery to the Zetadocs Client simply open your existing company stationery and print it
selecting the Zetadocs PDF printer using the steps below.

Open your stationery in Word or another suitable application. The standard stationery has been
provided to you in Word format in the templates folders as well, so you can adjust and print that if
desired.

Select print and select Zetadocs PDF as your printer.

This will open the Zetadocs client with your stationery within it.

Select the File menu and then Save As Stationery.

You will then be prompted to provide the name and save location of the stationery, you should
select the shared network folder mentioned earlier this is likely to be in the form
\\ServerName\Zetadocs Templates\.

If you wish to apply this stationery to the existing preconfigured templates this file should be
named ZD - Stationery.zds this will over-right the existing standard stationery and will now be
used by all of the templates provided.

Should you wish to apply this stationery to a single template, name the file as you see fit then open
the Zetadocs client.

Next open the template wizard by double clicking on the template you wish to modify.

Go to the third page of the wizard using the next button the screen shown in Figure 35 will appear.
Select your stationery by selecting the Folder drop down box and selecting the Shared Network
folder.

Selecting the existing stationery from the selected stationery window as shown.

71 Document Template Wizard

Please choose your stalionery equisys
ZETAQOCS

If you wish to add stationery, please select one or more items from the list and press the Add button. Use the
Faolder option to browse for stationery in other folders.

Folder: [Zetadocs for NAV templates

[ ZDNAV-Equisys letterhead-TopLeft
[ ZDNAV-Equisys letterhead

Selected Stationery:
DOEE Stationeny

Figure 35 — The Document Template Wizard

Click the Remove button.

Select your new stationery file and press Add.

Select Next to be taken to the email message template wizard page. If you are happy with the
existing message select next again and then select Finish to save your changes. Note: the class
feature is not required for NAV users.
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11.4 Adjusting the Email message

The preconfigured templates contain an email message populated with dynamics field data from NAV and
static text generically phrased to allow them to be applicable in a number of situations. The messages, like
the one shown below, work with NAV to automatically create a personalised message that contains contact
details, names, order numbers and organization names.

Messages using Dynamics Fields

Subject: Order Confirmation for order number: %%/[ZetadocsRecordNo] for
%%][Organization]

Message Body:
FAO: %%][Name]

Dear Customer,
I'm pleased to attach your order confirmation, reference number %%|[ZetadocsRecordNo].

Kind regards,
Sales Team

When sent using the Zetadocs for NAV Client these fields are replaced with the corresponding fields from
NAV, and would appear thus:

Message with Dynamic Fields Populated
Subject: Order Confirmation for order number: 300381 for Equisys plc

Message Body:
FAO: John Smith

Dear Customer,
I'm pleased to attach your order confirmation, reference number 300381.

Kind regards,
Sales Team

By amending the document template you will be able change the content of every email message sent using
that template. It is possible to include a variety of other dynamically populated fields within your email; by
default you will have access to the following:

%%[Name]

e %%[FirstName]

e %%[Surname]

o %%[ZetadocsCompanyNo]
o  %%[ZetadocsRecordNo]

®  %%[Organization]

o %%[ZetadocsArchivelD]
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1! Document Template Wizard
Please enter your email properties

Subject:

equisys

Standard * 12pt -

* Tahoma =
g o | B 7 U|[[d so| # Z3 @[ HM

4

FAQ: %%[Name,Customer]

Dear Customer,

I'm pleased to attach your order confirmation, reference number %%
[ZetadocsRecordNo].

Kind regards,

Sales Team

=)

ZETACOCS

Crder Confimation for arder number: %% [Zetadocs RecardNo] for %% [Organization]

m

<Back | [ Nex>

] [ Cancel

Figure 36 - Document Template Wizard - Email Message Body

It is possible to include other dynamic fields however these require the use of the SDK Granule, this setup

will be explored in the Advanced Configuration Guide.

To adjust the email message you need to view the template in the Zetadocs Client using the document
template wizard. To open the document template wizard for a particular template follow the steps in section

11.1.

e The first three pages of the wizard contain:
e Anintroduction to templates

e The assignment of attachments

e The selection of stationery

e Click Next on each page to move past these wizard stages until you reach the email properties

page (see Figure 35 above).

e Adjust this content to match your needs remembering that the dynamic fields use the format
%%[Name] and will be replaced in the message by the corresponding NAV value.

e Click Next to review the templates contents and select Finish to save your changes.
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12.Testing Zetadocs Delivery and Capture Essentials

Now that you have successfully completed the install of the Zetadocs Delivery and Capture Essentials
features it is recommended that you test them to ensure that these features operate as expected. For those
customers also installing the Delivery Plus or Captures features we would recommend you perform some of
these tests to validate your install thus far. Further testing instructions are provided later to cover this extra
Advanced functionality following their install.

12.1 Testing Delivery Essentials

Your system should by this stage have the core delivery functionality successfully installed and configured,
as well as potentially having some optional archiving features. Instructions on testing both features are
below.

(i) Zetadocs for NAV Document Delivery
The test scenarios below will demonstrate how to test delivery of the Sales Order report under a number of
different rule configurations.

Zetadocs Rules
Zetadocs enables you to precisely control how your documents are configured using our system of delivery
Rules, these work on four levels:

1. The Default Rule — a basic rule that can be used by any Zetadocs enabled report.

2. Per Document Set — specific settings for Zetadocs enabled documents by type.

3. Per Company — specific settings for Zetadocs enabled documents by company.

4. Per Company, per Document Set — specific settings applied to specific document types when sent

to a specific company.

For more details on how rules and document delivery work with Zetadocs please see the section 2.4 How
Zetadocs Delivers Documents from NAV.

(i) Rule Testing

Rules are created by making modifications to the settings on the Zetadocs Customer/Vendor Rule Cards
and the Zetadocs System Rule Card. The standard configuration data will have created a level 1 and 2 rules
by default, so edits to these settings can simply be undone by setting the fields to their previous values.
However creating level 3 and 4 rules creates an additional level of rules, these need to be removed as usual
in NAV by pressing F4 to delete the entry.

Level 2 Rule Test - Single Send

e Select the Administration option in the Navigation pane and then Application Setup.
e Open the Zetadocs Setup section and select the Zetadocs System Rule Card.

e Select the document set relevant to the report you are testing, the figure below shows this card, it
is used to determine how a document set is to be delivered.
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ZD00007 Sales - Invoices - Zetadocs System Rule Card =n om="
General | Archiving
Document Set Mo, . . . |ZD000OF (4]
Document Set Name. . . (Sales - Invoices
Template ID, . . . . .. ZT00007
Template Mame . . . . . ZD-5ales Invoice Template
Delivery Method Priority . |E-Mail =] (=]
E-Mail From. . . . ...
Comments . . .. ...
Delivery Type ContactMo. Mame Company Address Additional Redpient Information
# |E-Mail To » | Name:
A Company:
: Address:
< T
Rule v] [ Help

Figure 37 - System Rule Invoice

Select the Sales and Marketing option in the Navigation pane.
Open the Order Processing section and select Orders.

Select a suitable order record and select Print = Order Confirmation.
The usual print dialog will appear, select Print.
The Zetadocs Delivery card may appear (shown below) depending on your system settings, this will

contain all of the delivery details according to your current rule setup.

Select OK to send the report, check to ensure it delivers as expected and archives if this has been

configured as well.

Note: If you have configured higher level rules for the customer in question these will supersede the

level 2 rule.
Sales Header: Order, 101016 - Zetadocs Delivery
Please confirm delivery settings before continuing
Contact Selection
ContactMo., . . . ... .. CT200138
ContactMame . . . . . . . Mindy Martin
EMal . ... 00 0. mindy.martin@cronuscorp.net
FaxMo. . . « « « ¢ o = « &
Delivery Method . . . . . . E-Mail
Template Selection
TemplateID . . . .. ... ZT00006
Template Mame. . . . . . . ZD-Order Confirmation Template
General
Preview Document in Zetadocs Client Before Sending
Ok ] [ Cancel ] [
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Level 2 Rule Test — Batch Send
e Open the Order Processing section and select Orders.
Select a suitable order record and select Print > Order Confirmation.
Select a suitable rage of records and select Print > Order Confirmation.
The usual print dialog will appear, select Print.
The Zetadocs Batch Delivery card may appear depending on your system settings, this will contain
all of the delivery details according to your current rule setup.
e Select OK to send the reports, check to ensure they deliver as expected and archive if this has been
configured as well.
Note: If you have configured higher level rules for the customers in question these will supersede the level
2 rule.

Modifying the Level 2 Rule
e Return to the Zetadocs System Rule Card for the report in question and change the delivery details
for that particular document set.
e Repeat the above send tests to ensure that they operate as expected.
e Return any settings to your previous values as determined by your requirements.

Level 3 Rule Test

e Go to the Customer Card and select a customer with an order (or one you are able to create one
for).

e Click the Customer Button and select Zetadocs Rules.

e The Zetadocs Customer Rule Card will open.

e Select the Delivery Tab and select a sending option other than Use Default and/or change the
delivery address (by changing any of those settings on that page you create a Level 3 Rule for that
customer).

The Cannon Group PLC Order Confirmations - Zetadocs Custormer Rule Card [ ===

| General | Delivery |Templahe |

Contact Information
Name Mr. Andy Teal

E-Mail the.cannon.group.plc@cro. ..

@) Use Default

Use Contact: Ei200156

Use Alternate:

Fax MNo.

= Template Information
MName ZD-Order Confirmation Tem...

Delivery Type Contact No. Name Company Address Additional Redpient Information
¥ |E-Mail To - Name
Company
Address

m

Rule v| | Help

Figure 39 - Customer Card - Zetadocs Tab page
e Send an Order to this customer and check that the NAV document has been delivered as expected.

Modifying the Level 3 Rule
e Return to the Zetadocs Customer Rule Card for the customer in question and change the delivery
details for them.
e Repeat the above send tests to ensure that they operate using the new rule details as expected.
e Return any settings to your previous values as determined by your requirements.

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved Page 69



equisys
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

Level 4 Rule Test
e Go to the Customer Card and select a customer with an order (or one you are able to create one
for).
Click the Customer Button and select Zetadocs Rules.
The Zetadocs Customer Rule Card will open.
Set the Document Set No. to the document set you wish to modify or create a rule for.
Modify the settings on the form as desired.
Print a NAV document and check in the Zetadocs Client that the appropriate settings from that
Customer Rule have been applied.

12.2 Testing Optional Delivery Features

You may remember that earlier you were shown a number of steps which would add functionality to a
Zetadocs system but which were not required on all setups. Should you have installed any of the features
discussed below please ensure you perform the relevant tests to ensure they operate as expected.

(i) NAV Role Tailored Client Compatibility

Those systems which have performed the Role Tailored Client compatibility modifications either manually
or by importing the Zetadocs for NAV V4.0 Interfaces - NAVW16.01 (Pages).fob file need to perform the
relevant test below to ensure setup has been successful.

e Loginto the Role Tailored Client as a user with a role with access to the modified sections within
NAV.

e Locate one of the modified forms setup to work with Zetadocs e.g. Sales Order

e Either select an existing document or create a new one and click Print.

e Ensure the document is handled as expected and in-line with the earlier delivery tests.

(ii) SharePoint Archiving Support

Those systems with SharePoint Archiving configured should already have populated there archive whilst
performing the earlier document delivery and rule tests earlier. As such viewing the document library
created earlier in section 5 should display those items archived earlier. For those without any existing
content in their archive you can modify your system settings using the steps in section 10.4 to enable
archiving before repeating any of the earlier document delivery tests.

(iii) Adding the Related Documents content to NAV forms
The Documents tab enables Zetadocs to display related documents from your SharePoint archive within the
NAV Role Tailored Client.

e loginto the Role Tailored Client as a user with a role with access to the modified sections within

NAV.

e locate one of the modified forms setup to work with Zetadocs e.g. Sales Order

e Open one of the modified forms in NAV and expand the Documents tab.

e This will display the Documents fast tab as shown in the figure below.
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1001 - The Cannon Group PLC

General

No.:

Sell-to Customer No.:

Sell-to Contact No.:

1001
10000
CT000001

Sell-to Customer Name: The Cannon Group PLC

Sell-to City:
Ordler Date:

Lines

Documents

% Li,"_g }

Date

09/07/2010 12:04
09/07/2010 11:29
29/06/201015:30

Birmingham

27/01/2011 -

MName E-Mail

juras.norkus@equisy:

Document Date: 27/01/2011 -
Requested Delivery Date: -
Salesperson Code: Ps -
Campaign No.

Opportunity No.

Status: Open

(%) Show more fields

E-Mail Cc E-Mail Bec

The Cannon Group PLC the.cannon.group.plc@cronuscor..

<

Invoicing

Shipping

Foreign Trade

(T

10000 | 1M(8D) | 27/02/2011

BLUE | 27/01/2011

#

v

~
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Figure 40 — Documents Fast Tab

(iv) Checking Zetadocs Form and Zetadocs Archive option additions to NAV
You will need to perform this test if you have imported the Zetadocs for NAV V4.0 Interfaces .fob file or
performed the equivalent manual steps. The fob file will have added the menu items to the following
locations, we would recommend you test a selection of them as a minimum using both the Role Tailored
and Classic clients if applicable.

The Zetadocs Archive search menu item can be added to the cards listed in the table below:

Form No. Form Name

21
26
41
42
43
44
507
6630
130
132
134
6660

49
50
51
52
509
6640
138
6650
140
136

Customer Card

Vendor Card

Sales Quote

Sales Order

Sales Invoice

Sales Credit Memo
Blanket Sales Order
Sales Return Order
Posted Sales Shipment
Posted Sales Invoice
Posted Sales Credit Memo
Posted Return Receipt

Purchase Quote
Purchase Order
Purchase Invoice
Purchase Credit Memo
Blanket Purchase Order
Purchase Return Order
Posted Purchase Invoice
Posted Return Shipment

Posted Purchase Credit Memo

Posted Purchase Receipt

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved

Page 71



equisys i
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

The Zetadocs Rules menu item can be added to the cards listed in the table below:

Form No. Form Name

21 Customer Card
26 Vendor Card

e Open NAV and choose one of the cards above e.g. the Customer Card.
e Click on the Customer button and it will expand revealing a number of options.
o Zetadocs Archive and Zetadocs Rules should appear at the bottom of this list as shown in the

figure below.
- Contact _
10000 The Cannen Group PLC - Customer Card . E@

Statistics F9

General |C0mmuniﬁﬁon I Inwvoicing I FPayments | Shipping | Fo Statistics by Currencies

[ T 10000 [ ﬂ Entry Statistics

Mame., . . ... .. .. The Cannon Group PLC Sales

Address . . .. .. .. 192 Market Square Trr=ae e

Address 2. . . . .. ..
Service Contract

Post CodefCity . . . . . B27 4T (#] [Birmingham Ervice Lontracts

Country/Region Code . . |GB &) Service ltems

PhomeMo. . . . .. .. A Johs

Primary Contact Mo.. . . [#] Online Map

Contact. . . .. .... Mr. Andy Teal
Zetadocs Rules

Zetadocs Archive

[gustcma vJ [ Sales v] [anctions - Help

Figure 41 — Customer Card with Zetadocs Rules menu item added

12.3 Testing Capture Essentials Features

If you have installed the Capture Essentials features throughout this guide you will have added a
Documents Fast Tab to several of your NAV systems forms in the Role Tailored Client. This will enable you to
drag and drop items into your SharePoint Archive linking them to the document currently displayed within
NAV. To test that these are operating as expected you need to do the following.

e loginto the Role Tailored Client as a user with a role with access to the modified sections within
NAV.

e Locate one of the modified forms setup to work with Zetadocs e.g. Sales Order

e Open one of the modified forms in NAV and expand the Documents tab.

e This will display the Documents fast tab as shown in the figure below.
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1001 - The Cannon Group PLC

General Z o~ |~
No.: 1001 Document Date: 27/01/2011 -

Sell-to Customer No.: 10000 - Requested Delivery Date: -

Sell-to Contact No.: CT000001 - Salesperson Code: Ps -

Sell-to Customer Name: The Cannon Group PLC Campaign No.: -
Sell-to City: Birmingham - Oppertunity Ne.: -
Order Date: 27/01/2011 - Status: Open -

Lines. v
Documents Z sl
S>>

Date Name E-Mail E-Mail Cc E-Mail Bcc

09/07/2010 12:04 juras.norkus@equisys.com; sam..

09/07/201011:29

20/06/201015:30 | The Cannon Group PLC the.cannon.group ple@cronuscor...
< i v
Invoicing 10000 | 1M(8D) | 27/02/2011 v
Shipping BLUE | 27/01/2011 v
Foreign Trade v

Figure 42 — Documents Fast Tab

e Select an appropriate record within NAV with which to associate a document

e Dragand drop the document to be added to the archive onto the portion of the Documents tab
shown below.

e Open the SharePoint archive for the system and search for the original NAV record.

e This should display the document you dragged and dropped into the Documents tab.

e Repeat this with a selection of file types and from location like the Outlook inbox to ensure they
function as expected.

Documents F ~

VYRS

Date Name E-Mail E-Mail Cc E-Mail Bec
09/07/2010 12:04
09/07/2010 11:29
20/06/2001015:30  The Cannen Group PLC the.cannon.group plc@cronuscor...

isys.com; sam.

Figure 43 — Documents Fast Tab Drag and Drop

12.4 Continuing the Installation

This completes the installation and testing of Zetadocs Delivery and Capture Essentials. If you are not
installing any Advanced features your setup is now complete, should you be performing the install on a test
setup please proceed to the section migrating to a live environment.
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Zetadocs Capture Plus Setup and <
Configuration

Note: The following sections of the installation guide cover the installation and setup of the features
provided as part of the Zetadocs for NAV Capture Plus module. These changes can only be made by those
with the Zetadocs SDK and implement features which require Capture Plus module licence from Equisys.

13. Zetadocs Capture Plus

The Zetadocs Capture Plus is an optional component of Zetadocs for Microsoft Dynamics and is required for
systems making use of the Document Queue and associated features. At its core is the Zetadocs Server
which runs on your server and converts documents placed into a Shared Network folder into PDF/A format.
It works with Microsoft Dynamics NAV and enables the document queues to work with a wide range of
documents by converting inbound documents into PDF/A. As standard the document queue supports a
variety of file types, allowing viewing, processing and eventual archive of these documents to SharePoint.

This provides a number of benefits:
e Documents are stored in a standard storage format (PDF/A)
e Document content is searchable within SharePoint including text which is part of graphics, if OCR
is enabled (optional requires additional licence)

By storing all documents within SharePoint you enable a wider range of your company’s staff to access
these documents despite perhaps not having a copy of the native software for the document. It also means
that you have a copy of the document that is an accurate representation of the document when it was
received.

The list below covers some of the options available to Capture Plus customers, typically these are used to
streamline document handling and management processes.

Capture Plus Features Include:
e Capture and Conversion of inbound documents to PDF/A format

e Custom Document Queues

e Optical Character Recognition

e Barcode Recognition

e On screen approval with workflows
e Document Association

It is easier to understand how these features all come together by looking at a brief example of how they
can be used to improve document handling. A company sends out Shipment notes printed from NAV with
their deliveries, these are signed by the customer and returned before being processed and filed.

By using Capture Plus you can automate and streamline this process significantly, firstly on printing the
Shipment note from NAV, Zetadocs can add a Barcode to the document it is then signed a usual by the
customer but on return it is simply scanned. Zetadocs can then recognise the barcode and automatically
adds a pdf copy of the document to your archive and associates it with the original order that the Shipment
note was based upon. It will then appear in the Shipment Document Queue, this gives the agent processing
these documents a single location from where they can view the signed Shipment Note and create and send
the corresponding invoice. This provides the organisation with an archive that is populated with related
records e.g. a Quote, Order, Shipment Note, Returned Signed Shipment Note, Invoice which enables them
to view the whole transaction workflow from SharePoint. We will demonstrate how to setup this Shipment
example in the coming pages.

The sample code to achieve this is shipped as part of the Zetadocs-Send Customize codeunit. Additionally

we provide a sample Sales Shipment report containing a barcode 9009999 - ZD Sales - Shipment(RTC-
Barcode).fob on the product CD in the folder \Zetadocs NAV Server Components\W1\6.01.
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13.1 Overview of the Zetadocs Capture Plus Install

Zetadocs Capture Plus is based around the integration of the Zetadocs Server which converts documents
with NAV and your other Zetadocs components to provide a range of enhanced functionality. The other
functionality is then gained by modifying NAV reports to contain information which Zetadocs can use to
automatically process and link documents.

This section will take you through the setup of each of the following:

e Zetadocs Server

e (Custom Document Queues

e Barcode support

e Adding Document Queues to a Role Center

To implement some of the features described in this chapter you will need to add a Granule to your license,
if you have already installed the Zetadocs Delivery module you may have the required Granule already. If so
skip to section 15.

13.2 NAV License
To successfully install Zetadocs for NAV you require a Zetadocs for NAV VAR NFR granule to be added to
your license.

Required Granules
To use Zetadocs for NAV you require the Zetadocs for NAV Granule to be added to your license.

VAR - Programming access
Granule 9009961 — Zetadocs Execute Granule

End User — Execute only access
Granule 9009970 — Zetadocs for NAV Granule

Optional Granules

To take advantage of Zetadocs for NAV integration with NAV Contacts you require the Contact Management
Granule.

Granule 5500 — Contact Management

Granule 5510 — Contact Management - Basic

Optionally you can also purchase the Zetadocs for NAV SDK Granule which allows the running of
customizations made in the Zetadocs Send Customize codeunit 9009962.
Zetadocs Capture Customize codeunit 9009964.

Granule 9009980 — Zetadocs for NAV SDK
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14. Zetadocs Server

The Zetadocs Server is simple to install but does require a number of the other steps of the Zetadocs for
Microsoft Dynamics installation to have been completed. We recommend that you complete all previous
elements of the install you require before attempting to install the Zetadocs Server.

14.1 Zetadocs Server Prerequisites
It is recommended that you perform any Zetadocs for NAV Delivery Essentials module installations first
before proceeding with the installation detailed below.

Technical Specifications

(i) Operating systems supported
e Windows Server 2008 R2 (64-bit)
e Windows Server 2008 R2 with Remote Desktop Services
e Windows Server 2008 Standard Edition (32-bit and 64-bit)
e Windows Server 2008 with Windows Terminal Services
e Windows Server 2008 with Citrix Presentation Server 4.5
e Windows Server 2003 Standard Edition (32-bit and 64-bit)
e Windows Server 2003 with Windows Terminal Services
e Windows Server 2003 with Citrix Presentation Server 4.5

(ii) Hardware requirements
e Itis recommended that systems have a minimum of a Pentium® class CPUs of 1 GHz or higher with 1
GB RAM or more. Should the server be running other applications we would recommend you
expand the hardware requirements appropriately for more information on suitable configurations
please consult Equisys at support@equisys.com.

(iii) Licensing Requirements
e The Zetadocs Server requires the purchase of an additional upgrade.

Note: It is recommended that you install Zetadocs Capture Essentials first if you are installing both
modules.

14.2 How the Zetadocs Server works

Conversion

Documents are added to the document queue by placing them in a shared network folder. These are then
displayed within the document queue allowing the user to process the document and create associated
Dynamics entries and documents. The Zetadocs Server application automatically converts documents
placed within the shared network folder into PDF/A whilst storing a copy of the original document in
another folder.

PDF Format

The Zetadocs Server converts documents in supported formats into PDF 1.4 (PDF/A-1a) format. This is an
international ISO standard ISO 19005-1:2005 for more details on this format please see
(http://www.pdfa.org/doku.php?id=pdfa:en:pdfa_whitepaper).

OCR

If you choose to include OCR as part of your solution all documents converted to PDF will support full text
search. This includes graphics documents or documents that contain graphics (e.g. a PDF with embedded
graphics), this requires special processing. To provide this we have the ZD OCR Processor, this is an
optional module which incorporates the Abbyy FineReader Engine. The full text that is recognised is added
to the created PDF file as a text layer, this enables full text search.

Supported Inbound File Formats

The following file formats are supported, how they are processed depends on whether the ZD OCR
Processor has been included:

If the OCR module is installed then the following file types will be processed with OCR:
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PDF (.pdf)

BMP and DIB (.bmp, .dib)

PCX and DCX (.pcx, .dcx)

JPEG, JIFF (.jpg, .jpeg, .jpe, .jfif)
GIF (.gif)

TIFF (.tif, .tiff, .g3n, .g3f)

DjVu (.djvu, .djv)

If the ZD OCR Processor is not included files will be passed for conversion without being OCR’d, we support
the following file types:
e Office files (v2003 and v2007) — Word and Excel (.doc, .docx, .xls, .xlsx)
Rich text files (.rtf)
Web pages (.html, .htm)
Text files (.txt)
Email messages (.msg format is recommended as htm format doesn’t include attachments)

Email message conversion of .msg files results in conversion of the email message body text and the
unpacking and conversion of any supported attachments. Should any of the attachments not be in a
supported format then the whole message will be flagged as having failed to convert so the user can review
it in its original format.

The following file types are not supported:
e Compression: Zip, Rar, ARJ, TAR, TGZ, CAB ...
¢ Media: MP3, WMV, AVI, MPG, MPEG, MP4, WAV...
e Executable types: EXE, DLL, BAT, VBS ...

Multipart Files
The Document Converter supports multipart files e.g. an email with an attached purchase order, this is then
converted into a pdf file with two or more pages with bookmarks to indicate where the various elements of
the message are contained. In the above example you would be presented with a first page containing the
email subject line, body text, addressing information and email message.
[ ]
The following Email metadata is also retained:
Sent — time/date
Received - time/date
From
To
cC
Priority

Next would follow the attachments, each with its own separate bookmark within the pdf.

Note: Hosting the document queue folders on a separate machine to the one the Zetadocs Server is
running on is not supported.

14.3 Installing the Zetadocs Server
To install the Zetadocs Server simply:
e Login with Administrator rights and deactivate the User Account Control (UAC), click here for
details on doing this.
e Runthe Zetadocs for Microsoft Dynamics software CD or software download.
Select the install option for your product version from the main menu.
Then select the Zetadocs Server option.
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SharePoint 2007 Extensions

SharePoint 2010 Extensions

Zetadocs NAV Client 32 bit
Zetadocs NAV Client 64 bit

Zetadocs for NAV Connector

Zetadocs Server

Figure 44 — Zetadocs Server Install

e Select Install Zetadocs Server to start the Installation Wizard.
e Once the Installation Wizard for Zetadocs Server starts click Next.

i Zetadocs Server - InstallShield Wizard x|

Welcome to the Installshield Wizard for
Ietadocs Server

The Installshield{R) Wizard will install Zetadocs Server on your
computer. To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

e_:quis;-,'.s
ZETACOCS®

Capture. Deliver. Share.

< Back I Mext = I Cancel |

Figure 45 - Zetadocs Server Install

e You will be asked to choose a destination folder for the installation, when satisfied click Next.

14.4 Installing OCR Support
e Next you will be asked to Choose whether you want to include OCR support, to include the ZD OCR
Processor you are required to have a valid licence.
e Choose the relevant option for your install:
e | have an Abbyy licence and would like OCR support.
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| do not have an Abbyy licence number.

Once you have reviewed and selected | Agree, click Next.

i Zetadocs Server - InstallShield Wizard x|

Ready to Install the Program equisys
ZETACOCS"

Capture. Deliver. Share.

The wizard is ready to beain installation.

Click Install to begin the inztallation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Inztallshield
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Click Next, if you have included Abbyy OCR you will be asked to review their licence agreement.

The Installation Wizard is now ready to install the Zetadocs Server, select Install to continue.

Figure 46 - Start Installation Program

e Once the Installation is complete select Finish.

14.5 Licensing Abbyy FineReader

o Ifyou earlier specified that you wished to include Abbyy OCR support then you now need to license

the Abbyy FineReader Engine.
e The Abbyy License Manager will open automatically.

+~ ABBYY FineReader Engine 9.0 Local License Manager

Build: 9.0.1.472

EoX

Serial number | License type Status Volume limit  Yolume remains  Units  Period = Protection
FEDC-2011-. .. 10000 10000 Month  File

Custom Developer  Activated Pages

[Prnperties...] [ Add new. .. ] Ackivate. . [ Deactivate ] [ Update... ]

[ Refresh

] [ Close

Figure 47 - Abbyy FineReader License Manager
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e Click the Add new... button and then add your Abbyy license number and click Add.
e The Abbyy FineReader Activation Wizard will appear for you to activate your product.

Activation methods:
o Viathe Internet Activation is carried out automatically and takes only a few seconds. An
Internet connection is required for this type of activation.

o By e-mail The user needs to send an e-mail message generated by the program and
containing information required for activation. To ensure a quick reply from the mail robot,
do not alter the information in the message body or Subject field.

Once activated Abbyy should be ready to work with the Zetadocs Server.

14.6 Restarting the Zetadocs Server
Once you have detailed the location of the Zetadocs Server you need to restart the conversion service.

e Go to Start->Run, then enter Services.msc

e  When the window opens scroll down to Zetadocs Document Converter and right click on it and
select Restart.

e This will restart the service and enable you to begin document conversion.

14.7 Configuring the Zetadocs Server
The Zetadocs server has a number of options which allow you to specify a series of options on how it
handles documents, these are:

Document Queue location
PDF Quality

Abbyy enabling

Stellent Bypass PDF

Log Level

Log location

(i) Specifying the Document Queue Locations

The Zetadocs document queues are where converted documents are stored, these queues have yet to be
configured in NAV. As such we recommend that you leave the document queue location setup until you
have successfully created your queues in the next chapter.

(ii) Adjusting the PDF Quality
The quality of the pdf’s the Zetadocs Server produces during conversion can be adjusted to meet your
requirements of file size, quality and conversion speed.
The options are:
o Better
e Smaller

To adjust the quality of the pdf files produced simply change the value shown here to one of the following
options:

<PDFQuality>Better</PDFQuality>

<PDFQuality>Smaller</PDFQuality>

Save the updated Config.xml file when finished modifying the file.
(iii) Enabling and Disabling Abbyy
In some circumstances it may be necessary to deactivate Abbyy for example if you were approaching the

end of your licensed document limit and wished to save the remaining capacity for a specific group of work.
To deactivate Abbyy simply change the entry to false, similarly to reactivate it change the value to true.

<EnableAbbyy>true</EnableAbbyy>
<EnableAbbyy>false</EnableAbbyy>

Save the updated Config.xml file when finished modifying the file.
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(iv) Adjusting the StellentBypassPDF option

If you are not using OCR in your system then there is obviously little point in converting PDF’s that you
receive as there will be no benefit. As such by having this value set to true you instruct the Zetadocs Server
not to convert pdf’s if you are not using OCR.

<StellentBypassPDF>true</StellentBypassPDF>

(v) Adjusting the Logging Level
The logging level options are as follows:

e Error
e Warning
e Debug

As such simply change the value in the config.xml file to either of these.
<LogLevel>Error</LogLevel>
<LogLevel>Warning</LogLevel>
<LogLevel>Debug</LogLevel>

Save the updated Config.xml file when finished modifying the file.

(vi) Specifying the Log Location

The Zetadocs Server log can be set to save to a file and/or the event log, change these values to true and
false as appropriate.

<LogToFile>true</LogToFile>
<LogToEventLog>false</LogToEventLog>

Save the updated Config.xml file when finished modifying the file.

(vii) Enabling Barcode Detection

Zetadocs can detect barcodes if the OCR module has been installed, this option determines whether the
Zetadocs Server searches for readable barcodes or not.

<EnableBarcodeDetection>true</EnableBarcodeDetection>
<EnableBarcodeDetection>false</EnableBarcodeDetection>

Save the updated Config.xml file when finished modifying the file.
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15. Zetadocs Document Queues 0
Zetadocs comes with two Document Queues setup a standard, a Sales and a Purchase Document

Queue. These come with a number of pre-programmed menu items which allow you to perform a variety of
actions from them. They are designed to cover a variety of standard Sales and Purchase scenarios. In this
section we will take you through how to setup the Sales and Purchase Document Queues and how to create
new document queues. It will include all the modifications required for the NAV tables and forms needed to
ensure they function correctly.

15.1 The Sales and Purchase Document Queues

Zetadocs comes with two existing document queues which have been created with the archiving and link
items pre-programmed, this offers you a quick and easy document queue solution. The queues come with
the following menu items setup:

Sales Document Queue \ Purchase Document Queue

Create new blanket order Create new blanket order

Create new credit memo Create new credit memo

Create new invoice Create new invoice

Create new order Create new order

Create new quote Create new quote

Create new return order Create new return order

Link to existing blanket order Link to existing blanket order

Link to existing credit memo Link to existing credit memo

Link to existing invoice Link to existing invoice

Link to existing order Link to existing order

Link to existing posted credit memo Link to existing posted credit memo
Link to existing posted invoice Link to existing posted invoice

Link to existing posted return receipt Link to existing posted receipt

Link to existing posted shipment Link to existing posted return shipment
Link to existing quote Link to existing quote

Link to existing return order Link to existing return order

These queues we imported as part of your install earlier, as such you only need to perform action 1, 2, 3
and 6, the two additional steps relate to Custom Queue Setup unless you are intending to modify the Sales
and Purchase Document Queues with additional functionality.

1. Create a shared network folder for the document queue

2. Configure the Zetadocs Server to process files in the document queue

3. Setting the Zetadocs Document Queue Settings

4. Add Zetadocs Archive ID field to record tables (Custom Queue Setup Only)
5. Modify record forms for archive search and retrieval (Custom Queue Setup Only)
6.

Adding the Document Queues to your Menusuite
The following sections provide more details on Queue setup using our Shipment note example from earlier.

15.2 Create a shared network folder

The document queue requires a network folder into which captured documents are placed and to which all
users of the queue have full access permissions.

¢ Find a suitable location within your network for the central storage of your document queue items.
This should be accessible by all intended users of the system.

Create the folders e.g. Shipment Document Queue

Right click on the folder and select Properties.

Choose the Sharing tab.

Check the Share this Folder radio button.

Select the Permissions button.

Assign the Permissions necessary to enable your system and users to be able to access these
locations.
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o USERS: A user of the queue must be added to the share permissions with a minimum of
Change and Read Permissions. Full Permissions are recommended.

o SERVICE: The Zetadocs DIRMonitor Service must have access to the queue folders. To do
this add FULL Permissions to the SYSTEM user or whatever network user the service is
running as.

15.3 Configure the Zetadocs Server
To enable the Zetadocs Server to convert documents placed into the Document Queue folders you need to
point the conversion service to them.
To do this you need to:
e Stop the Zetadocs Server
e Edit the configuration file
e Restart the Zetadocs Server

Stop the Zetadocs server:
e Go to Start->Run, then enter Services.msc
e When the window opens, scroll down to Zetadocs Document Converter and right click on it and
select Stop.

Edit the configuration file:
e Open the Config.xml file in Notepad or a suitable text editor. The file is located at C:\Program
Files\Zetadocs Server\Document Converter\Config.xml. The following file will be displayed:

<?xml version="1.0" encoding="utf-8"?>
<Config xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<docsQueue>
<DocsQ Description="Sales Document Queue" Location="\\ServerName\Sales Document Queue\" />
<DocsQ Description="Purchase Document Queue" Location="\\ServerName\Purchase Document Queue\" />
</docsQueue>
<PDFQuality>Better</PDFQuality>
<EnableAbbyy>true</EnableAbbyy>
<StellentTimeOut>10</StellentTimeOut>
<StellentBypassPDF>true</StellentBypassPDF>
<LogLevel>Error</LogLevel>
<LogToFile>true</LogToFile>
<LogToEventLog>false</LogToEventLog>
<EnableBarcodeDetection>true</EnableBarcodeDetection>
</Config>

e You need to add a line to the file in the section <docsQueue> that details the name and location of
each document queue you wish to setup.

e Adjust this to include the location you have selected for your Document Queues e.g. \\zdnav-
serv\Shipment Document Queue\.

<docsQueue>
<DocsQ Description="Sales Document Queue" Location="\\zdnav-serv\Sales Document Queue\">
<DocsQ Description="Purchase Document Queue" Location="\\zdnav-serv\Purchase Document Queue\"/>
<DocsQ Description="Shipment Document Queue" Location="\\zdnav-serv\Shipment Document Queue\"/>
</docsQueue>

e Save the updated Config.xml file when you have finished modifying the file.
Once you have edited the configuration file you need to restart the conversion service:
e (o to Start=>Run, then enter Services.msc
e When the window opens scroll down to Zetadocs Document Converter and right click on it and

select Start.
e This will restart the service and enable you to begin document conversion.
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15.4 Setting Document Queue Settings

The Zetadocs Document Queue card is where all Zetadocs Document Queue settings are defined. It already
contains the default settings imported earlier for the Sales and Purchase Document Queues, revise these as
required following the steps below. To add a new queue simply create another record on this card and fill it
out appropriately.

To open the card:

Open NAV and select the Administration option from the Navigation Pane.
Navigate to Application Setup—>Zetadocs Setup—>Advanced Settings>Zetadocs Document Queue
Setup.

ZDQ0003 - Zetadocs Document Queue Card EI@
L ZDQ0003
Mame. « v v v v v v Shipment
Path . .. ... .. .. Viiacksnipe \shipment document que... [#]
archive Library . . . . . Archive
archive URL, . . . . .. http:ffintranet/deve /archiveTest/Archive
Archive Document Type .
Folder Mame Structure. . ] [=] [=]
Date Folder Maming . . . |YYYY-MM-DD  [=
Archive Document . . . . . . . o
Delete After Archive . . . . . . o
Show Delete Confirmation. . . . |
Auto Link Documents . . . . . . W
Caption Menu Code ID
| Link to existing sales shipment ZDSHIP -
Settings v| | Help

Figure 48 - Zetadocs Document Queue Card

No.: The document Queue ID.
Name: The name of the Document Queue.
Path: The location of the document queue folder you created e.g. \\zdnav-serv\Shipment
Document Queue\
Archive Library: Only specify the SharePoint document library name, not the full URL.
Archive URL: Displays the full target archive library path.
Archive Document Type: The SharePoint content type to be used when archiving documents in this
queue.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint
document library based on information from the linked record.

o COMPANY — The “ORGANIZATION” metadata value. See here.

o DATE - The Date with a format specified by the “Date Folder Naming” property.

o DOCTYPE - Adds “Document Queue” to the folder structure.
Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint
archive. E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Archive Document: Indicates if the captured document is to be archived to SharePoint
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o Delete After Archive: Indicates if the document is to be deleted from the document queue after
successful archive.

e Show Delete Confirmation: Indicates if the user is to be asked to confirm deletion from the
document queue after successful archive.

e Auto Link Documents: Indicates whether the document queue will call the GetAutoLink function in
the Zetadocs-Send Customize codeunit.

The list at the bottom of the Document Queue card shows the menu items available to the user, when they
click the Archive button from the Zetadocs Document Queue form. Each menu item selects an action.
Through these actions the user can associate (link) the captured document with an existing or new NAV
record. You can add one or more actions to the document queue and for each you must give a caption:

e Caption: a caption that describes the action to a user e.g. Link to existing shipment

e Menu Code ID: the unique ID that identifies the action

To add new actions you need to open the Zetadocs Doc. Queue Actions table from the Object Designer and
enter the item. Once an Action has been added, it will be available via the lookup for Menu Code ID. We will
detail the steps required to enable the menu item action occur later in this section.

Add Zetadocs Archive ID field to record tables

When Zetadocs archives a captured document to SharePoint it stores the document with metadata. One of
the metadata fields used is the Zetadocs Archive ID. This is a unique key (GUID) that allows the captured
document to be quickly found and retrieved from SharePoint. In order to do the search and retrieve we need
to have a cross reference to the Zetadocs Archive ID and the associated record in NAV. One way to provide
this cross-reference is to add a Zetadocs Archive ID field to the table for the NAV records. If this is done,
then Zetadocs will fill in the key when it archives the captured document.

For the NAV record that you are associating captured documents with you need to add a new field to the
record table. Follow the actions below to do this.

Actions:

e Open the object designer (Shift + F12) and navigate to the record table. For example if you are
associating Shipment reports with Sales Shipment records then the Sales Shipment Header table
should be opened.

o Add afield called “Zetadocs Archive ID” of type GUID. You must enter the name exactly as stated.
Upper and lower casing must be correct as well as spacing.

e Add permissions to the Zetadocs-Capture Integration and Zetadocs-Capture Customize codeunits
to allow them to modify the record table data.

15.5 Modify record forms for archive search and retrieval (Custom Queues Only)
To allow a user to search, retrieve and view captured documents from a NAV record form it is necessary to
modify the form to provide a menu item that will do the search. For example the Posted Sales Shipment
record form would be modified to add a Zetadocs Archive item on the Shipment menu, as below.
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General | Invoicing |5}m|g |BizTak |

MO o v 2| Posting Date . . . . . .
Sell-to Customer No. . . 30000 DocumentDate . . . . .
selo ContactMo. . . .| | Requested Delivery Date | |

Sell-to Customer Name . |Selangarian Ltd. | Promised Delivery Date . l:l
Sell-to Address . . . . . | 153 Thomas Drive | QuoteNo. ....... |:|
Sel-to Address 2 . . . . | | OrderMo.. . ...... 101012
Sell-to City . . . . . .. |Coventry | External Document Mo, . I:l
Sell-to County Post Code | | |C'\.|'G 1GY | Salesperson Code . . . .
Sel-to Contact . . . . . [Mr. Mark McArthur | Responsbiity Center . .| |
Mo.Printed . . . . . . . [ &

T... No. Description Location ... Quantity  Unitof M... Quantity ... Planned ... F
p L. 19285 {AMSTERDAM Lamp | GREEM 5 PCS 5 170111 =~

Statistics
Comments
Dimensicns

Approvals

Zetadocs Archive

Figure 49 - Posted Sales Shipment form showing Zetadocs Archive menu item

Please follow the instructions below to add a Zetadocs Archive menu option to a record form:

Open the form in the object designer.
Add a new menu item to the bottom of the menu with the caption Zetadocs Archive.

e Inthe OnPush trigger define a local variable called ZetadocsUtilities of type codeunit and sub-type
Zetadocs-Utilities.

e Add the following code to the OnPush trigger:

ZetadocsUtilities.SharePointSearchl('ZDARCHID', "Zetadocs Archive ID", FALSE);

e Once you have saved the form add EQ4.0 to the Version List column in the Object Designer. Adding
this value is essential to ensure easy identification of forms modified for Zetadocs for NAV, in
particular, for uninstalling Zetadocs for NAV at a later point.

Compile the modified form
Check that the appropriate menu items have been created by running the form and check the
modified menu item is available.

If you are using the Role Tailored Client, then make the equivalent changes in the page editor for the RTC
record page.

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved Page 86



Zetadocs for NAV Installation Guide

equisys
ZETAOOCS®

Capture. Deliver. Share.

15.6 Additional code required for document linking and archiving (Custom

Queues Only)

Overview

In this section we write the code to enable document linking and archiving. There are a number of functions
that Zetadocs calls from the Zetadocs-Capture Customize codeunit that you need to implement. The steps

to follow are:

Write code in the GetLink function

e Write code in the GetAdditionalMetadata function
e Add permissions to codeunit

e Test document archiving

The following sections provide more detail on each step.

Write code in the GetLink function

For each action that is defined for the Archive button, you need to write some code in the function GetLink,

to carry out that action in NAV.

For example, if the action is to link the captured document to an existing record, then in this function you
would code the lookup that displays a form to allow the user to select the record and then return that
RecordID. Zetadocs will then use the record ID during the document archive and add the appropriate cross

reference (Zetadocs Archive ID) to the record table.

The GetLink function has the following parameters:

Name Type Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by
the user.
ZdLinkResult Record Zetadocs Link Read/Write A writable runtime table to allow
Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdControlFile Text Read Path to the DQF file for the
[250] document queue item (XML file).

Provided to allow you to fetch
other information about
converted files.

Sample Code:

This sample code shows an implementation of the GetLink function allowing the user to select the
associated Sales Shipment record. Note that this function will be called for every Action. You will need to
add a CASE statement using the Menu Code ID to identify the action the user has selected and write the

appropriate code against each case.

PROCEDURE GetLink@1000000007(ZdArchiveContext@ 1000000000 : Record 9009992;VAR
ZdLinkResult@1000000001 : Record 9009997;ZdControlFile@1000000002 : Text[250]);
VAR
SalesShipmentRec@1000000003 : Record 110;
RecRef@1000000004 : RecordRef;
BEGIN
ZdUtilities.Log(0, 'C9009964 - Link");
/I Menu Code ID find out what action to perform

II'if there are any errors during processing set the error flag in ZdLinkResult to TRUE
II'and set the error description field to a useful error message

This edition 26/10/2010 © Copyright Equisys plc 2010 All trademarks acknowledged All rights reserved

Page 87



equisys
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

CASE ZdArchiveContext."Menu Code ID" OF
'ZDSHIP": // link to existing sales shipment
BEGIN

I make sure the sales shipment record does not have any filters

SalesShipmentRec.RESET;

/I run the lookup form and check the result

IF FORM.RUNMODAL(0, SalesShipmentRec) = ACTION::LookupOK THEN

BEGIN
I'if the user selected a record use a RecordRef to get the RecordID for the record
/I'and modify the ZdLinkResult record to include it
RecRef. GETTABLE(SalesShipmentRec);
ZdLinkResult."Record ID" := RecRef. RECORDID;

END

ELSE

BEGIN
I/if the user cancelled, set the cancel flag in ZdLinkResult to true
ZdLinkResult.Cancel := TRUE;

END;

/I Call MODIFY to save the changes to the record

ZdLinkResult. MODIFY;

END;
END;
END;

Write code in the GetAdditionalMetadata function
Zetadocs calls the function GetAdditionalMetadata to get the values of metadata to be added to
SharePoint when the document is archived.

The GetAdditionalMetadata function has the following parameters:

Name .~ Type | Sub-type | Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the itemis in and the
menu item that was clicked by the
user.
ZdLinkResult Record Zetadocs Link | Read/Write A writable runtime table to allow
Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdArchiveMetadata Record Zetadocs Read/Write A writable runtime table to allow
Archive you to modify the field values
Metadata being archived to SharePoint and

to fill in custom metadata that has
multi-level table relations.

Sample Code:

This sample code shows an implementation of GetAdditionalMetadata that sets the values for the metadata
for Record Type, Record Number, Company Number, Name and Organization. Note that this function will be
called for every Action. You will need to add a CASE statement using the Record ID to identify the linked
record and then write the appropriate code against each case to pull the specific metadata required.

PROCEDURE GetAdditionalMetadata@1000000005(ZdArchiveContext@1000000000 : Record
9009992;ZdLinkResult@1000000001 : Record 9009997;VAR ZdArchiveMetadata@1000000002 : Record 9009993);
VAR
RecRef@1000000003 : RecordRef;
fRef@1000000004 : FieldRef;
BEGIN
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Il Use the record id to get the table number. From the table number we know which fields to get the metadata from.

Il We are using short codes for the standard Zetadocs SharePoint fields.

/I These codes will be translated into the correct field names.
Il For custom fields just put the full field name in and it will be used.

IF RecRef.GET(ZdLinkResult."Record ID") THEN
BEGIN
CASE RecRef.NUMBER OF

1

10: // Sales Shipment Header Table

BEGIN
Il First fill in the record type
ZdArchiveMetadata.INIT;
ZdArchiveMetadata.Name := 'RECORDTYPE';
ZdArchiveMetadata.Value := 'Posted Sales Shipment';
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

/I Field 3- "No."

fRef := RecRef.FIELD(3);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'RECORDNUMBER;
ZdArchiveMetadata.Value := fRef.VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::NUMBER;
ZdArchiveMetadata.INSERT;

/I Field 2 - "Sell-to Customer No."

fRef := RecRef.FIELD(2);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'COMPANYNUMBER';
ZdArchiveMetadata.Value := fRef. VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

// Field 84 - "Sell-to Contact"

fRef := RecRef.FIELD(84);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'NAME";
ZdArchiveMetadata.Value := fRef.VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

/I Field 79 - "Sell-to Customer Name"
fRef := RecRef.FIELD(79);
ZdArchiveMetadata.INIT;
ZdArchiveMetadata.Name := 'ORGANIZATION';
ZdArchiveMetadata.Value := fRef. VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

END;

END;
END;

END;

Add Permissions to codeunits
It is advisable to add at least modify permissions to the Zetadocs-Capture Customize and the Zetadocs-
Capture Integration codeunits for the table data of the records you wish to link to. This allows the codeunits
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to set the Zetadocs Archive ID and will enable you to perform other record modifications as part of your
custom link actions.

Test document archiving

At this stage you should test that the functionality you have added works by doing the following:
e Scanadocument to your new document queue.
e Check that the document is listed in the document queue within NAV and can be viewed correctly.
e  With the document selected click the Archive button and complete the actions.
e Browse to the SharePoint library and check that the document has been archived successfully in

the correct location.

View the document properties in SharePoint and check these are as expected.

e Check the Zetadocs Archive option from the record form finds the archived document in
SharePoint.

e (Finally, when you have completed your testing delete any test documents from the SharePoint
archive.)

15.7 Adding Document Queues to your NAV Menusuite
To enable users to quickly access your document queues you can add them to your menusuite, to do this
simply follow the simple steps below.

e Open the object designer within NAV and select the menusuite option.

o C(reate a new menusuite or edit an existing one as per your requirements.

e |fcreating a new one select the New button and then select the Design level appropriate to your
install, e.g. Company.

e locate the area in the Navigation pane where you wish to add the item to the menusuite.

e Right click on the area and select Create item.

e Select the object type of Form and pick the document queue in question from the object id field.

e Select OK when satisfied and the use ctrl+shift and the arrow keys to move your new item around
the menusuite until you are happy with its location.

e  Press ctrl+s to save your changes.

e Repeat for any remaining document queues.

Note: Document Queues will not be available via the menusuite until you have closed and restarted NAV.

15.8 Adding Document Queues to a Role Centre

Overview

The NAV role tailored client is designed around a user’s role and each role has its own Role Centre. This is
the ideal place to show information about the Zetadocs document queues, as each one is a queue of
documents that needs processing.

The following section gives a step by step guide explaining how to show document queue information in the
Activities area of the order processor Role Center in the role tailored client. The same steps can be used to
display document queue information on any Role Center for any role.

Add document queues to Role Center
The page that you need to modify for this example is number 9o60 — SO Processor Activities.

e Add the following global variables:

Name Data Type Sub Type

Queueltems Record Zetadocs Doc. Queue ltem
QueueSettings Record Zetadocs Document Queue
ZdDocQueue Page Zetadocs Document Queue

e Add the following line of code to the OnOpenPage trigger where ZDQooo1 is the ID of the document
queue that you want to display the information for:
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Queueltems.SETRANGE(Queueltems."Zetadocs Doc. Queue No.", 'ZDQ0001";

e Add a group to the page with a sub type of “CueGroup”. Set the caption to “Zetadocs Document
Queues”.

e Add a field to the group. Set the caption to “Document Queue” and set the source expression to
“Queueltems.COUNT” as shown in the screenshot below:

Page 9060 50 Processor Activities - Page Designer EI@
Mame Caption Type SubType SourceExpr
<Control 120000000 1= <Control1900000001> Container ContentArea -
<Controll> For Release Group CueGroup
<Sales Quotes - Open > <5ales Quotes - Open > Field "Sales Quotes - Open”
<Sales Orders - Openx <Sales Orders - Open> Field "Sales Orders - Open”
<Controlg> Sales Orders Released Not 5...  Group CueGroup
<Ready to Ship= <Ready to Ship= Field "Ready to Ship”
<Partially Shipped= <Partially Shipped > Field "Partially Shipped™
<Delayed> <Delayed= Field Delayed
<Control18> Returns Group CueGroup
<Sales Return Orders - All= «Sales Return Orders - All>  Field "Sales Return Orders - Al
<Sales Credit Memos - All= «Sales Credit Memos - All>  Field "Sales Credit Memos - All"
<Control 1000000000 = Zetadocs Document Queues Group CueGroup
4 <Control 100000000 1> Document Queue Field Queueltems. COUNT -

Figure 50 - SO Processor Activities - Page Designer

IF QueueSettings.GET(ZDQ0001) THEN

BEGIN

ZdDocQueue.SetQueueSettings(QueueSettings);

ZdDocQueue.RUN;
END;

Select the new field and press Fg to view code. Add the following code to the OnDrillDown trigger:

The previous steps can be repeated to add any other document queues to the display.

Below is a screenshot showing an example of what this looks like when it is complete:
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Figure 51 - Zetadocs Document Queues in the Role Centre
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16. Enabling Barcode Support 0

Zetadocs supports the addition of barcodes to reports printed from NAV using a barcode font to

print unique information about an NAV object. This places a barcode into the report output, which can be
used in a number of manners. For example, with documents like invoices or sign off sheets which are
distributed from NAV before being signed or filled in and returned. In these cases when the document is
added back into the system document queue via scanning or email etc, it is captured back into the system
and OCR’d. This process detects the barcode and decodes the information contained within it. It is then
used to link the returned document to the original document in the archive. This enables users to track
documents through a variety of business processes.

Zetadocs for NAV Installation Guide

Barcode Formats
Zetadocs for NAV support Code 128 format barcodes only.

(i) Numeric-only barcodes

e EAN-13 (European Article Numbering, an international retail product code)

e EAN-8 (compressed version of EAN code for use on small products)

e UPC-A (Universal Product Code seen on almost all retail products in the USA and Canada)
e UPC-E (compressed version of UPC code for use on small products)

e Code 11 (used primarily for labelling telecommunications equipment)

e Interleaved 2 of 5 (compact numeric code, widely used in industry, air cargo, other applications)
e Industrial 2 of 5 (older code not in common use)

e Standard 2 of 5 (older code not in common use)

e Codabar (older code often used in library systems, sometimes in blood banks)

e Plessey (older code commonly used for retail shelf marking)

e MSI (variation of the Plessey code commonly used in USA)

e PostNet (used by U.S. Postal Service for automated mail sorting)

(ii) Alphanumeric barcodes

e Code 39 (de facto standard for Government, Manufacturing, BarCode Industry, Education, and
Business applications, in use world-wide)

e Code 93 (compact code similar to Code 39)

e Code 128 (very capable code, excellent density, high reliability; in very wide use world-wide)

e | OGMARS (same as Code 39, this is the U.S. Government specification)

Barcode Options
e The Zetadocs server searches for barcode information when processing graphics and PDF image
files. Any barcodes which are included in the file are saved alongside the document, and can be
used by custom processing functions to identify the document and automate its processing.

e Atypical usage is to encode the NAV document number directly — eg adding the shipping note
number as a barcode. However for more complex requirements a separate ID could be stored
instead — eg storing a lookup key into a custom table within NAV which is used to store custom
information about the document. Barcode information is passed transparently to the custom code
when processing for maximum flexibility.

e Zetadocs for NAV is supplied with a standard barcode font. When used with this font, the barcode
recognition supports the following features:

o Encoding of variable length data strings, including letters A-Z (from ANSI standard Western
European character set), digits 0-9, plus a selection of punctuation characters.

o Barcode including text (user readable) version for manual checking or processing.

o Protection against misreading, using automatically generated checksum data.

o Support for documents scanned upside down.
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o Most other common barcode formats can also be supported. Please contact Equisys for further
details if there is a requirement to use a specific barcode format.

o Barcode processing requires the OCR add-on module.

o Use of the barcode to identify and process the document requires customization work by the
VAR using the Zetadocs for NAV Capture SDK, as described below.

Note: This method works for most reports; however, due to the customizable nature of reports it may not fit
all reports exactly. Therefore, the location of where to insert the code below may need to vary but the code
will remain the same.

Installation Overview

In this section we write the code to enable document auto linking and archiving. You will need to modify the
printed report to include a barcode and there are also a number of functions that Zetadocs calls from the
Zetadocs-Capture Customize codeunit that you need to implement. The steps to follow are:

e Installing the barcode font

e Modify a report to add a barcode

e Write code in the GetLinkDisplayString function
e  Write code in the GetAutoLink function

e Test document auto linking

The following sections provide more detail on each step.

16.2 Installing the barcode font

Barcodes can be added to reports by simply using a suitable font. The chosen barcode font must be
installed on each client PC that will be used to print the report. There are many different types of barcode
font available, but we have found that Code 39 barcodes work well with Zetadocs. You can download and
install a free Code 39 barcode font from http://www.barcodesinc.com/free-barcode-font/. Choose either
the standard or extended font and follow the included instructions to install the font on each client PC.
Barcode fonts often have limited character support e.g. A-Z and 0-9. So please ensure that the characters
you wish to use are supported by the font.

16.3 Modify an NAV report to add a barcode

Before you modify your report, you need to decide what unique piece of information you will use for the
barcode, so that the printed report can subsequently be identified in the capture stage. This will usually be
the record number of the NAV record. For example for the Shipment Note report you could use the
Shipment record number from the Posted Sales Shipment Record.

Follow these instructions to modify a report to add a barcode:

Open the NAV classic client and open the Object Designer (Shift+F12).
Locate the report you wish to modify in the Object Designer and select Design.
In the Report Designer select View—>Sections.
Open the toolbox View>Toolbox.
Select the text box tool and create one in a suitable location for the barcode - we suggest the main
header section.
Right-click on the text box and select properties.
e Set the text box FontName to the barcode font name
e.g. FontName = Free 3 of 9 Extended
e Edit the FontSize to a suitable value, we recommend a minimum size of 20.
e Set the text box SourceExpr property to the value to be used for the barcode
e.g. SourceExpr = STRSUBSTNO('*SHIP%1*',"Sales Shipment Header"."No.")
e Ensure that the barcode starts with and ends with “*”, otherwise the barcode will not be
recognized by the scanner.
e We also suggest that you add another text box below the barcode to display the value in a
standard font so that it is also human readable.
Save the changes to the report.
Test that the report prints OK and that the barcode is clearly legible.
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If you are using the Role Tailored Client, then make the equivalent changes in the report editor for the RTC
report.

16.4 Adding code to the GetLinkDisplayString function

Zetadocs calls the function GetLinkDisplayString to allow you to return a suitable text string to be
displayed in the document queue form. If no value is returned by this function, then the display will default
to the barcode text for the first barcode found in the captured document. If the document contains multiple
barcodes, these will be represented as multiple records in the table.

The GetLinkDisplayString function has the following parameters:

Parameter ~ Type | Sub-type Read/Write Description
ZdDocQueueBarcodes Record Zetadocs Read Aread only runtime table that
Doc. Queue allows you to access the values of
Barcodes all barcodes from the document
gqueue item.
Return Value Text[120] Write The text to display in the
document queue “Link” column.

e Open the NAV classic client and open the Object Designer (Shift+F12).

e locate the Codeunit ID:9009964 Zetadocs-Capture Customise in the Object Designer and select
Design.

e Scroll down to the GetLinkDisplayString section.

e You will notice the code matches that displayed below, this indicates that it is setup for the
Shipment Report, which we provide as a sample report.

e To add support for other reports we need to add additional if statements to ensure your systemis
configured to deal with barcodes which start with other details.

Sample Code:

This sample code shows an implementation of GetLinkDisplayString that returns a display string for a
Shipment record.

/I Call reset to clear any filters that may be on the barcodes temporary table
ZdDocQueueltemBarcodes.RESET;

IF NOT ZdDocQueueltemBarcodes.FIND(-") THEN
BEGIN
Il There are no barcodes so we leave the link string blank
EXIT(");
END;

info := ZdDocQueueltemBarcodes.Value;

II'if the barcode starts with SHIP
IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) = 'SHIP') THEN
BEGIN
info ;= STRSUBSTNO(strSalesShipment, COPYSTR(info, 5));
END;
END;

Customising the GetLinkDisplayString function

The document specific section of code below contains an IF statement which enables the codeunit to add
additional information to the document queue when it detects a barcode which begins with SHIP. The
makeup of this string is obviously determined by the unique value you wish to use for your barcode.

(i) String in the report which generates the barcode
SourceExpr = STRSUBSTNO("*SHIP%1*,"Sales Shipment Header"."No.")
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This would for example generate a value of *SHIP 102028*.

(ii) Corresponding code required in the codeunit
I'if the barcode starts with SHIP
IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) = 'SHIP") THEN
BEGIN
info := STRSUBSTNO(strSalesShipment, COPYSTR(info, 5));
END;

The code then detects that our barcode starts with SHIP and acts accordingly.

(iii) Adding additional IF statements for other reports

If then you wanted to add barcode support to another report then you would need to modify the report as
per the steps in section 16.3 adding the SourceExpr value shown below. Note you can use whatever
identifier seems appropriate in this case we have chosen to setup a Sales Invoice report so have chosen
SINV and have replaced Sales Shipment Header for Sales Invoice Header.

SourceExpr = STRSUBSTNO("*SINV%1*,"Sales Invoice Header"."No.")
We then need to add an additional if statement to match this:

I'if the barcode starts with SINV
IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) ="' SINV') THEN
BEGIN
info ;= STRSUBSTNO(strSalesInvoice, COPYSTR(info, 5));
END;

This can be repeated as desired for any remaining reports.

16.5 Write code in the GetAutoLink function

Zetadocs calls the function GetAutoLink for each item in the queue so that you can determine if it can be
automatically associated with a NAV record. Details of recognized barcodes are included so that you can
write any necessary functionality to lookup the NAV record. If you plan to have this function called
automatically from the NAS server or from other codeunits, it is recommended that you do not include user
input operations.

The GetAutoLink function has the following parameters:

Parameter ~ Type Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by the
user.
ZdDocQueueBarcodes Record Zetadocs Read A read only runtime table that
Doc. Queue allows you to access the values of
Barcodes all barcodes from the document
queue item.
ZdLinkResult Record Zetadocs Read/Write A writable runtime table to allow
Link Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdControlFile Text Read Path to the DQF file for the
[250] document queue item (XML file).

Provided to allow you to fetch
other information about converted
files.
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Sample Code:
This sample code shows an implementation of GetAutoLink that finds and returns the matching record ID.

PROCEDURE GetAutoLink@1000000006(ZdArchiveContext@ 1000000002 : Record 9009992;VAR
ZdLinkResult@1000000001 : Record 9009997;ZdControlFile@1000000000 : Text[250];VAR
ZdDocQueueBarcodes@1000000003 : Record 9009995);

VAR

msgNoBarcodes@1000000005 : TextConst 'DAN=Auto linking failed. No barcodes were detected on the
document.;DEU=Auto linking failed. No barcodes were detected on the document.;ENU=Auto linking failed. No barcodes
were detected on the document.;ESP=Auto linking failed. No barcodes were detected on the document.;FRA=Auto linking
failed. No barcodes were detected on the document.;ITA=Auto linking failed. No barcodes were detected on the
document.;NLD=Auto linking failed. No barcodes were detected on the document.;ENG=Auto linking failed. No barcodes
were detected on the document.’;

msgCouldNotFindRecord@1000000006 : TextConst 'DAN=Auto linking failed. Could not find record matching barcode:
%1;DEU=Auto linking failed. Could not find record matching barcode: %1;ENU=Auto linking failed. Could not find record
matching barcode: %1;ESP=Auto linking failed. Could not find record matching barcode: %1;FRA=Auto linking failed.
Could not find record matching barcode: %1;ITA=Auto linking failed. Could not find record matching barcode:
%1;NLD=Auto linking failed. Could not find record matching barcode: %1;ENG=Auto linking failed. Could not find record
matching barcode: %1';

barcodeVal@1000000004 : Text[80];

ShipmentRec@1000000007 : Record 110;

RecRef@1000000008 : RecordRef;

BEGIN
ZdUtilities.Log(0, 'C9009964 - AutoLink’);

This code should be the same for every report and doesn’t need repeating with each if statement.
Il Use the barcodes that are passed in to find the record to link to.

/I Call reset to clear any filters that may be on the barcodes temporary table
ZdDocQueueBarcodes.RESET;

IF NOT ZdDocQueueBarcodes.FIND(-") THEN

BEGIN
Il There are no barcodes so don't modify the record.
Il Processing will fall back to calling the Link function for the manual method.
EXIT;

END;

barcodeVal := ZdDocQueueBarcodes.Value;

IF Statement
II'/f the barcode starts with SHIP it means it is a shipment note.
/I The barcode will be in the format SHIP000000, where 000000 is the shipment number
IF (STRLEN(barcodeVal) > 4) AND (COPYSTR(barcodeVal, 1, 4) = 'SHIP') THEN
BEGIN
ShipmentRec.RESET;
ShipmentRec."No." := COPYSTR(barcodeVal, 5);
II'if we can find the record that the barcode refers to
IF ShipmentRec.FIND THEN
BEGIN
I'if the user selected a record use a RecordRef to get the RecordID for the record
/I and modify the ZdLinkResult record to include it
RecRef. GETTABLE(ShipmentRec);
ZdLinkResult."Record ID" := RecRef. RECORDID;
ZdLinkResult. MODIFY;
END;
END;
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EXIT;
END;

Modified IF Statement for the Sales Invoice

I1'If the barcode starts with SINV it means it is a Sales Invoice.
/I The barcode will be in the format SINV000000, where 000000 is the Sales Invoice number
IF (STRLEN(barcodeVal) > 4) AND (COPYSTR(barcodeVal, 1, 4) = 'SINV') THEN
BEGIN
ShipmentRec.RESET;
ShipmentRec."No." := COPYSTR(barcodeVal, 5);
I1'lf we can find the record that the barcode refers to
IF ShipmentRec.FIND THEN
BEGIN
I'if the user selected a record use a RecordRef to get the RecordID for the record
/I and modify the ZdLinkResult record to include it
RecRef.GETTABLE(ShipmentRec);
ZdLinkResult."Record ID" := RecRef.RECORDID;
ZdLinkResult.MODIFY;
END;
END;

EXIT;
END;

Test document auto linking
At this stage you should test that the functionality you have added works by doing the following:
e Print a modified report that includes a barcode.
Scan the printed report into your new document queue.
Check that the document is listed in the document queue within NAV and can be viewed correctly.
Check that the scanned document displays the appropriate text in the Link column.
Click the Archive button and complete the actions.
Browse to the SharePoint library and check that the document has been archived successfully in
the correct location.
View the document properties in SharePoint and check these are as expected.
e (Finally, when you have completed your testing delete any test documents from the SharePoint
archive.)

16.6 Further capture customizations

Overview
In this section a number of advanced functions are described that will help you to do further customisation
of the document queue capture process. The functions available are:

e  PreArchive

e  PostArchive

e GetZetadocsArchivelD

PreArchive

The PreArchive function is similar to the OverrideSendResult function in the delivery parts of the Zetadocs
SDK. This function gives a writable copy of the final information to be used in the archiving of the document
from the queue. It is at this point that you get the opportunity to override the archive location and content

type.

The PreArchive function has the following parameters:
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Parameter Type Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the itemis in and the
menu item that was clicked by the
user.
ZdArchiveSettings Record Zetadocs Read/Write A writable runtime table to allow
Archive you to modify properties of the
Settings archive action such as whether to
archive and the archive location.

PostArchive
Zetadocs calls the PostArchive function to inform you of the archiving result and to allow you to implement

workflow based on that information.

The PostArchive function has the following parameters:

Parameter - Type  Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provides context information like
Context the queue the item is in and the
menu item that was clicked by the
user.
ZdArchiveResult Record Zetadocs Read/Write A writable runtime table to allow
Archive you to find out if the archive was
Result successful and get the URL of the
archived file.

Sample code:

The sample code below demonstrates how to use the standard SMTP email functionality in NAV to send an
email with details about the archive operation that was just performed. The sample has been extended to

use the Zetadocs archive search functionality to find all related documents and append links to them to the
bottom of the email. To use this sample code, SMTP emailing must be set up in NAV.

PROCEDURE PostArchive@1000000002(ZdArchiveContext@1000000000 : Record 9009992;VAR
ZdArchiveResult@1000000001 : Record 9009996);
VAR
ZdArchive@1000000002 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{01C103A0-3852-4A8F-
83E6-E1B3A88B2273}:'Zetadocs Dynamics Utilities DLL'.ZdExtArchive";
ZdArchiveDocs@1000000003 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{DC2F0A50-A05A-
492E-97B5-C65F46EFB6C3}:'Zetadocs Dynamics Utilities DLL'.IZdArchiveDocs";
documentToMatch@1000000004 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{7TA71C89D-746E-
4CD6-9621-5040659D05E5}:"Zetadocs Dynamics Utilities DLL'.ZdArchiveDoc";
metadataFields@1000000005 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{C598AA2C-E67F-
48EB-96F 3-1A85F 13COEG5}:'Zetadocs Dynamics Utilities DLL'.ZdMetadata";
index@1000000006 : Integer;
ZdArchiveDoc@1000000007 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{04F44B47-DB79-4287-
BOFF-503D77179978}:"Zetadocs Dynamics Utilities DLL".IZdArchiveDoc";
metadataToMatch@1000000008 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{C598AA2C-E67F-
48EB-96F 3-1A85F 13COEG5}:'Zetadocs Dynamics Utilities DLL'.ZdMetadata";
ArchivelDToMatch@1000000009 : Automation "{B87DBB77-029B-40D7-93CE-912328221835} 1.2:{96512292-17CO0-
4D59-90A9-D2C547DAGEEBY};'Zetadocs Dynamics Utilities DLL'.ZdMetadataltem";
Mail@1000000010 : Codeunit 400;
EmailBody@ 1000000011 : Text[1024];
RecRef@1000000012 : RecordRef;
ShipmentNo@1000000013 : Code[10];
OrderNo@1000000014 : Code[10];
fRef@1000000015 : FieldRef;
ArchivelD@1000000016 : Text[100];
BEGIN
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T T

!

Il This sample code demonstrates how to use the Zetadocs search functionallity
Il to produce an email with information about the document that was archived
/l'and links to any related documents.

!

Il The sample code will only work correctly if the SMTP mail has been set up.

!

T T

/I Only do this if we attempted to archive and it succeeded
IF ZdArchiveResult."Archive Document” AND ZdArchiveResult."Archive Succeeded” THEN
BEGIN
Il First get some information about the record that we just linked to
//'and build up an email message to send
RecRef.GET(ZdArchiveResult."Record ID");
CASE RecRef.NUMBER OF
110: // Sales Shipment Header
BEGIN
fRef := RecRef.FIELD(3);
ShipmentNo := fRef.VALUE;
fRef := RecRef.FIELD(44);
OrderNo := fRef.VALUE;
fRef := RecRef.FIELD(9009959);
ArchivelD := fRef.VALUE;

EmailBody :='<p>Successfully archived new document in sharepoint</p>' +
STRSUBSTNO('<p>Sales Shipment: %1 for Sales Order: %2</p>'", ShipmentNo, OrderNo) +
STRSUBSTNO('<p>Click <a href="%1">here</a> to view the document</p>', ZdArchiveResult."Archive
Location");

Mail.CreateMessage('Test User’,
'testuser@equisys.com',
'testuser@equisys.com’,
'Sales Shipment Received',

EmailBody,
TRUE);

END;

ELSE
BEGIN
EXIT; // it's not a type of record that we recognise
END;
END;

Il Create the ZdArchive object
CREATE(ZdArchive,FALSE, TRUE);
ZdArchive.Initialize('sharepoint: ' + ZdUtilities.GetSharePointSite);

/I Create an archive document to use with matching
CREATE(documentToMatch,FALSE,TRUE);

Il Create an object to store the metadata fields to return
CREATE(metadataFields,FALSE, TRUE);

/I Create a metadata field to store the archive id
CREATE(ArchivelDToMatch, FALSE, TRUE);
ArchivelDToMatch.Name := 'ZetadocsArchivelD';
ArchivelDToMatch.Value ;= ZdUtilities. TrimGuidBrackets(ArchivelD);
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Il Create an object to store the metadata fields to match
CREATE(metadataToMatch, FALSE, TRUE);

/I Add the archive id metadata field to the fields to match
metadataToMatch.Add(ArchivelDToMatch);

/I Add archive id to the list of fields to return
metadataFields.Add(ArchivelDToMatch);

Il Set the metadata fields to match in the document object
documentToMatch.Metadata(metadataToMatch);

Il Set the current folder to the name of the document library to search
ZdArchive.CurrentFolder := 'Archive’;

/I Call GetDocuments to get the list of matching documents from sharepoint
ZdArchiveDocs := ZdArchive.GetDocuments(documentToMatch, metadataFields);

IF ZdArchiveDocs.Count > 0 THEN
BEGIN

Mail. AppendBody('<p>--------- Related Documents --------- <Ip>');
END;

FOR index := 0 TO ZdArchiveDocs.Count - 1 DO
BEGIN

ZdArchiveDoc := ZdArchiveDocs.Get(index);

Mail. AppendBody(STRSUBSTNO('<p><a href="%1">%2</a></p>', ZdArchiveDoc.FileUrl, ZdArchiveDoc.Name));
END;

Mail.Send;

Il Clear the objects we created
CLEAR(ZdArchiveDoc);
CLEAR(ZdArchiveDocs);
CLEAR(metadataFields);
CLEAR(metadataToMatch);
CLEAR(documentToMatch);
CLEAR(ZdArchive);

END;

)
END;

GetZetadocsRecordID

Zetadocs calls the GetZetadocsArechivelD function in the Zetadocs-Capture Integration codeunit to enable
you to provide an alternative implementation for storing Zetadocs Archive ID’s within NAV, perhapsin a
different table. In the majority of cases you will not need to change this function.

The GetZetadocsArchivelD function has the following parameters:

Parameter ~ Type  Sub-type Read/Write Description
Record Record Read The Record ID
ID
Return Value GUID Write The GUID used to uniquely identify
the record.

16.7 Capture Reference

Overview
This section gives details of the records used by the capture functions:
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Zetadocs Archive Context
Zetadocs Archive Metadata
Zetadocs Archive Result
Zetadocs Archive Settings
Zetadocs Doc. Q. Item Barcode
Zetadocs Link Result

Zetadocs Archive Context

Table 9009992 Zetadocs Archive Context - Table Designer = R ==
E.. Field Mo.  Field Name Data Type Length Description
v 1 Mo. Integer Always 1 as table only used to represent one capture activety =
v 10 Zetadocs Doc, Queue Mo, Code 10 Doc Queue that the dick is from
b v 11 Menu Code ID Code 10 Menu Item that was dicked
v 40 UIEnabled Boolean Whether or not UI should be allowed

Figure 52 - Zetadocs Archive Context Table

The Zetadocs Archive Context table has the following fields:
e No.: Table record entry - please ignore

o Zetadocs Doc. Queue No. : Foreign Key to Zetadocs Document Queue table to allow you to know
from which document queue the Link function has been called.

e Menu Code ID: Foreign Key to Zetadocs Document Queue Menu Item No. table to allow you to
know which menu item had been selected by the user. Blank if used with GetAutoLink function.

e UlEnabled: Indicates whether Ul (User Interface) dialogs should be shown or suppressed.

Zetadocs Archive Metadata

P

Table 9009993 Zetadocs Archive Metadata - Table Designer =[] ]
E.. Field Mo,  Field Name Data Type Length Description
v 1 Mame Text 100 -
v 2 Value Text 250
b 3 T\,rpe| Option

Figure 53 - Zetadocs Archive Metadata Table

The Zetadocs Archive Metadata table has the following fields:
e Name: Archive column name in SharePoint

e Value: The metadata value expressed as a string
e Type: The metadata type. Available types are NUMBER, DATE and STRING.
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Zetadocs Archive Result

Table 9009996 Zetadocs Archive Result - Table Designer EI@
E.. Field Mo.  Field Name Data Type Length Description
v 1 Mo, Integer Always 1 as table only used to represent one capture activety =
v 10 Record ID RecordID Record to assodiate with
v 70 Archive Document Boolean Flag indicating if we tried to archive the document
v 71 Archive Location Text 250 The URL of the archived document in SharePaint
v 72 Archive Succeeded Boolean Flag indicating if the archive operation succeeded
v 80 Delete After Boolean Flag indicating if the document should be deleted after archiving
v 81 Show Delete Confirmation Boolean Flag indicating if a confirmation message should be shown
v 110 Error Boolean Flag indicating if there has been an error
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
(AR 200 Additional Param Text 250 Used to store custom data|
Help

Figure 54 - Zetadocs Archive Result Table

The Zetadocs Archive Result table has the following fields:
e No.: Table record entry - please ignore

e Record ID: Un-typed record ID of the NAV record that the captured document is associated with.

e Archive Document: Indicates if the captured document is to be archived to SharePoint

e Archive Location: The URL of the archived document in SharePoint.

e Archive Succeeded: Indicates if the archive was successful.

o Delete After: Indicates if the document should be deleted

e Show Delete Confirmation: Indicates to Zetadocs whether prompt the user for confirmation of
delete.

e Error: Indicates to Zetadocs whether an error occurred during the function.

o  Error Description: A description of the error that occurred.

e Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.

e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.
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Zetadocs Archive Settings

Table 9009994 Zetadocs Archive Settings - Table Designer E\@
E.. Field Mo, Field Name Data Type Length Description
v 1 Ma. Integer Always 1 as table only used to represent one capture activety  #
v 10 Record ID RecordID Record to associate with
v 70 Archive Document Boolean Flag indicating if document should be archived
v 71 Archive Location Text 250 The location to archive the document to
v 73 Archive Document Type  Text 250 The sharepoint content type that will be used
b 110 Errar Boolean Flag indicating if there has been an errorl
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
v 200 Additional Param Text 250 Used to store custom data

Figure 55 - Zetadocs Archive Settings Table

The Zetadocs Archive Settings table has the following fields:
e No.: Table record entry - please ignore

e Record ID: Un-typed record ID of the NAV record that the captured document is associated with.

e Archive Document: Indicates if the captured document is to be archived to SharePoint

e Archive Location: The location to archive the document to in SharePoint.

¢ Archive Document Type: The SharePoint content type to be used when archiving.

e Error: Indicates to Zetadocs whether an error occurred during the function.

o  Error Description: A description of the error that occurred.

e Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.

e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.
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Zetadocs Doc. Q. Item Barcode

i

Table 9009996 Zetadocs Doc. Q. tem Barcode - Table Designer o[ B[R]
E.. Field Mo,  Field Name Data Type Length Description
v 1 Mao. Integer line id -
v 2 Value Text 250
b v 3 B Integer page barcode was on

Figure 56 - Zetadocs Doc. Q. ltem Barcode Table

The Zetadocs Doc. Q. Item Barcode table has the following fields:
e No.: Table record entry - please ignore

e Value: The barcode expressed as a string
e Page: The page number the barcode was on

Zetadocs Link Result

Table 9009997 Zetadocs Link Result - Table Designer =l
E.. Field No.  Field Name Data Type Length Description
v 1 Mo, Integer Always 1 as table only used to represent one capture activety =
v 10 Record ID RecordID Record to assodate with
v 110 Error Boolean Flag indicating if there has been an error
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
v 113 Cancel Boolean Flag indicating if the user cancelled a link operation
bV 200 Additional Param Text 250 Used to store custom data

Figure 57 - Zetadocs Link Result Table

The Zetadocs Link Result table has the following fields:
e No.: Table record entry - please ignore

e Record ID: Un-typed record ID of the NAV record that the captured document is associated with.

e Error: Indicates to Zetadocs whether an error occurred during linking.

o  Error Description: A description of the error that occurred.

e Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.

e Cancel: Indicates whether the Archive action should be cancelled.
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e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.
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17. Testing Zetadocs Capture Plus e

This section will detail the steps required to ensure that the Capture Plus elements of your

system are operating as expected. It will not cover those aspects already tested earlier but may overlap on
some areas already tested. You may wish to test on a mixture of the NAV classic and Role Tailored Clients as
required by the systems specifications to ensure all functionality operates as expected.

17.1 Document Queues

This section details how to test that the Document Queue is functioning correctly. The terminology
“Zetadocs Document Queue” in this section is used to describe all document queues.

Check Scanning (Optional)

If a scanning device is connected, perform the following checks to ensure correct operation.
e C(lick the Queue - Scan... button to initiate scanning which uses the Zetadocs client settings.
e Scanadocument; once scan is complete the user should be prompted to name the document.

Please enter unique name for scanned document (File will be saved as pdf)

SEW-X-CMMScan 20071024 103130

[ Cancel ][ Save ]

Figure 58 — Enter Scanned Document Name

e Upon Save, the scanned document name should appear in the Zetadocs Document Queue as the
latest entry. The file (typically “filename.pdf”) should also be in the Zetadocs Document Queue
shared folder location.

Check Shared Location Updating

e C(reate an email with an attachment and save it as a .msg file into the Zetadocs Document Queue’s
shared folder location.

e Select the Queue-> Refresh menu button and ensure that the saved email.msg file is now in the
Document Queue converted into pdf format.

e Select the entry in the Zetadocs Document Queue and click Item—>View, ensure that the item is
viewable in pdf format

e Select the entry in the Zetadocs Document Queue and click Item->View Original, ensure that the
item is viewable in its original format.

Check Printing
e Select the scanned .pdf file and click Item->Print, when prompted select a physical printer and
click print. Ensure that the document prints to the printer.
e Select the recently added email with attachment(s) now stored as a pdf file and click Item->Print,
when prompted select a physical printer and click Print. Ensure that the document prints to the
printer and that the attachments are printed out also.

Check Delete
e Select an entry in the Zetadocs Document Queue and click ltem—>Delete. Ensure that the
document is removed from the Queue and also that it successfully deletes the file from the
Zetadocs Document Queue network folder location.

17.2 Creating Documents using the Sales and Purchase Document Queues

The Sales and Purchase Document Queues have the capacity to generate a number of different documents
within NAV. These are predetermined and you should do a test for each that you intend to implement in the
system.
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Sales and Purchase Queue Create Options:
Quote
Order
Invoice
Blanket Order
Credit Memo
Return Order
Link to existing sales document (posted or unposted)

Creating a Document using the Sales and Purchase Document Queues

e Open NAV and open the Zetadocs Sales Document Queue.

e Ensure the queue is populated with a selection of sample or test documents.

e Select one of the items from the queue and select Create and then the type of document you wish
to test. In this case we’ll look at a Quote, normally a user would view a queue item using the
Zetadocs Viewer and use this as the basis for filling in the quote, order invoice etc details.

e This will display the Sales Quote window. Fill in the form as usual and when finished click the Print
button.

e This displays the Sales - Quote dialog box. To send your documents using Zetadocs, check that
Send using Zetadocs is selected on the Options tab.

e  Click Print again. This displays the Sales — Quote - Print dialog box. Click OK. This displays the
Zetadocs Delivery window, where you can change any settings if you want to, e.g., if you want to
address your quote to a different contact, or if you want to change the template.

e On the Zetadocs Delivery window, if you select Preview in Zetadocs Client before sending, this
allows you to preview your document in the Zetadocs Client before actually sending it. But if you do
not select this option, your document is sent directly to the recipient.

e After sending the order, the Send Result dialog box is displayed, showing you the result. If you
click the Show log button, you can see information about the Quote you sent, and it will also tell
you the location where the Quote has been archived as per your archiving options in Microsoft
SharePoint.

e You can now close the Sales Quote window. The Zetadocs Status Message is displayed advising
you that a copy of your document that you have just processed from the Zetadocs Document
Queue, has been saved in the archive and will also give you the archive location in Microsoft
SharePoint. You will be asked whether you want to delete the document from the document queue.
If you no longer require the document to be in the Document Queue, you can delete it. You can
always go back to the Microsoft SharePoint location where the document was saved to view it.

e Repeat this process for the other Sales items and the Purchase queue as required.

e Open your SharePoint Archive and ensure the documents have been archived as expected.

17.3 Creating Documents using the Custom Document Queues

The Custom Document Queues have the capacity to generate a number of different documents within NAV
based solely upon the requirements of the system. As these can take a number of forms you should do a
test for each that you intend to implement in the system in the manner it is likely to be used. The example
below will look at testing a Shipment Document Queue.

Creating a Document using Custom Document Queues
e Open NAV and open the Zetadocs Shipping Document Queue.

e Ensure the queue is populated with a selection of sample or test documents.

e Select one of the items from the queue and select Archive.

e The available Actions should be listed. Ensure your Actions are all displayed.

e Select eachin turn and create and send a document.

e Repeat this process for the other queues as required.

e Open the SharePoint Archive and ensure the documents have been archived and sent as expected.
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Zetadocs for NAV Delivery Plus Setup
and Configuration

Note: The following sections of the installation guide cover the installation and setup of the features
provided as part of the Zetadocs for NAV Delivery Plus module. Users who wish to install and utilise these
features will need to purchase the required licence from Equisys.

18.Zetadocs Delivery Plus - Architecture Overview

The Zetadocs for NAV Addin can be split into 2 main areas, data and processing. The installation guide dealt
primarily with setting up the data that would determine our report formatting and send information when
sent to the Zetadocs Client. We saw how reports could be grouped into Document Sets which share a
common rule for formatting and archiving and we saw how rules can be stored which alter formatting and
send information dependant on who we were sending to. It is assumed then that we have a good
understanding of the information involved in sending a report using Zetadocs for NAV. In this architectural
overview the process of collating the sending information, which we refer to as the “Send Results”, is

explained. This includes a breakdown of the main processing areas and their use in integrating with NAV as
well as an insight into the customization potential and extensibility of Zetadocs for NAV.

18.1 Typeless Public and Private Code

The Zetadocs for NAV processing code is split into two categories, public and private. Public being NAV
objects that we have installed which are editable by a VAR, and private, the objects that are not editable.
This is more commonly known in NAV as having “Modify” rights on the codeunit or not. The code is also
written so that it is typeless, meaning it is not compiled against specific tables in NAV, all data access is
done using table and field references and therefore the code is adaptable to work with any data set. This
concept will become clearer as we progress through the examples in this document. The core processing
codeunits of Zetadocs for NAV are private as this allows us to be able to provide upgradable object versions
of our core processing engine without additional work necessary from a VAR to copy and reconfigure
customization they have made. To ensure that we still remain a highly customizable solution we ensure that
all our processing data is typeless and all interactions with existing NAV data and objects remain public,
and are therefore editable by a VAR.

18.2 Data Processing Flow
Now let’s look at the flow of data that occurs when sending a report. The following diagram helps to
visualize the process and will aid us in discussing the relevant parts of the product.

As you can see from the diagram it starts with a NAV report that has been modified for Zetadocs for NAV. A
report is generally based on a set of records that are used to produce some report output, a document for
each record. The records contain information that relates to a contact and possibly a company, to whom the
report should be sent (i.e. the recipient). Sometimes that information can be a direct table reference to an
existing table that represents a contact or company for example, or it may contain some other form of
references which can be used to find the contact information from another source. This could be a look up
table of some sort based on some bespoke logic. The Zetadocs Send Results Gen codeunit is the central
processing controller and builds a runtime list of send results in a temporary table of type “Zetadocs Send
Result” for each record in the report.
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/—Zetadocs Send Results Gen—\
Zetadocs Settings

7 A Tables

Initialize
Add Record
ResolveSendIinfo
GetEmbComms

Zetadocs Send
Results

Zetadocs Zetadocs
NAV Report Integration Customization

Records Integration Override
Functions Functions

A

NAV Tables

Codeunit: R d
ecords
Temporary Table Table (Filtered Table)

Notation

Figure 59 - Zetadocs for NAV Architecture Diagram

Interfacing with the Zetadocs Send Results Gen codeunit (1.)

A report modified for Zetadocs for NAV will call the four trigger functions on the Zetadocs Send Results Gen
codeunit. Firstly, Initialize (1.) is called to set the report that is being printed. The initialization information
allows us to determine what report settings, if any, have been specified (2.). After initialization we start to
process individual record specifics. Each record reference is passed to the send results codeunit by calling
AddRecord (1.). Each record is then processed to extract the contact information (3.). Depending on who the
company is we may apply specific rules covering how the contact or the template is determined. When all
rules and settings have been applied the “Zetadocs Customize” codeunit is called to offer overriding of the
result (4.) (This requires the Zetadocs for NAV SDK Granule). Once all the records have been added
ResolveSendinfo (1.) is called which will offer run-time user override and error resolution dialogs. The final
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step is for the report to request the formatted embedded commands text to print for each report by calling
GetEmbComms (1.). Once again a call is made to offer the ability to add additional embedded commands in
the Zetadocs-Send Customize codeunit (4.) before returning the full text of embedded commands to the
report. These embedded commands are then extracted by the Zetadocs Client after printing to the Zetadocs
printer.

Querying the Zetadocs Settings (2.)

Based on the ID of the report that is being printed we can determine what template and archiving settings
to use for the report and potentially how to automatically find the company and contact references from the
report records. Internally the Zetadocs Send Results Gen codeunit will query the Zetadocs Report Settings
using the report ID. These settings control the flow of processing from this point on.

[=5 Zetadocs Report Settings == 3]
ReportID  Report Mame Zd Docum... Zd Docum... Archive D... Company ... Company ... Contact Mo... Record Mo. ... Default|
4 59987 Purchase - Invoice 0 Default VEMND 2 5043 3
4 m [
Help

Figure 60 - Zetadocs Report Settings

Resolving the Company and Contact Information (3.)

This can happen in a number of ways depending on the Zetadocs Report Settings for that report. The report
settings control whether the Zetadocs Send Results Gen codeunit can copy the company and contact
references from a field in the record or whether it should call out to the “Zetadocs-Send Integration”
codeunit for the information. It is in this public codeunit that a VAR will implement their custom integration
code for their system. This is explained in more detail in a later section of this guide; however, this should
highlight the main purpose of the Zetadocs-Send Integration codeunit and the Zetadocs Send Result table
being public. It means that when we need to access data from typed NAV tables this code is exposed to the
VAR developer to allow them to integrate or customize successfully. The private Zetadocs Send Results Gen
codeunit only correlates and manages the data, unaware of its meaning (typelessly).

Overriding in Customize Codeunit (4.)

There is the ability to alter the Zetadocs Send Results record directly in this codeunit before continuing with
sending of a report. Each send result is passed to this codeunit by calling OverrideSendResult internally in
the Zetadocs Send Results Gen codeunit. This gives the VAR a great opportunity to implement customized
business logic above that offered by Zetadocs for NAV. An example would be altering the recipient (contact)
depending on the value of an order. The second potential customization is to add additional embedded
commands for tailoring email messages using dynamic fields in Zetadocs Templates or adding extra
metadata to be archived with the document.

18.3 Summary
Now that we have been introduced to the architectural overview of Zetadocs for NAV it should be easier for

us to understand the sections which follow and begin to allow us to imagine the potential customizations
and workflow that could be created with the Zetadocs for NAV Addin.
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19.Send Any Report

In the installation guide we saw how to configure Zetadocs for NAV to send reports from the Sales Order
and Purchasing processes. We edited the NAV reports for Zetadocs for NAV and set the report settings to
point at the Customer or Vendor reference for that report and the respective Contact reference. With this
information Zetadocs for NAV was able to extract the references and query the names, email addresses and
fax addresses of the contact, as well as, cross reference the company (Customer or Vendor) reference with
the associated Zetadocs Customer or Vendor rules tables to apply per company formatting and addressing
logic. This however is not the limit of Zetadocs for NAV functionality. This principle of field reference and
related information resolution can be applied to almost any report. In this section we will see how small
changes in the report settings can control and alter the information used to address, format, send and
archive a report using Zetadocs for NAV.

19.1 Permissions

Before we enable more reports for sending there are some permission considerations to consider. The
Zetadocs-Send Integration codeunit has a function that is called by the Zetadocs Send Results Gen codeunit
to set the Zetadocs Archive ID for any record being archived. This is here to allow a VAR to add to the
permissions of this public codeunit any tables they wish to send and archive using Zetadocs for NAV. For
this reason please follow these instructions for each report you wish to enable for archiving.

e Determine the table type (<TableName>) of the record you are sending in the AddRecord command
in your report. (This is the record which will have the Zetadocs Archive ID set in it.)

e Modify the table is the table designer. Add the “Zetadocs Archive ID” field (case sensitive, type
GUID)

e Ensure that the field no. you choose for this field is the same as other tables in the posting line to
ensure correct copying of the archive id across the tables during posting.

e Modify the permissions on the Zetadocs-Send Integration codeunit (9009963) to include
“TableData <TableName> =rm”

19.2 Simply Send

Perhaps you have no requirement for the power of the rules support provided by Zetadocs for NAV for a
particular report or number of reports. You simply want to give your users the ability to manually address a
report at runtime using contact information in NAV and send using Zetadocs. For example you need to send
the Warehouse Shipping Status report to someone who does not have access to that report in NAV. This is
simply done by not associating the Zetadocs edited version of the report with any Zetadocs Document Set
in the Zetadocs Report Settings. The following instructions explain how to set this up.

e Edit the desired report for Zetadocs for NAV (See the “Single Recipient” report style in section 0.)

e Do not enter any report settings in the Zetadocs Report Settings for your modified report.

e Set the printer selection for your modified report to Zetadocs (Administration\General\Printer
Selections in NAV).

Now when the report is run you should see the Zetadocs Delivery Dialog where you can select your
addressing and template information.
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Sales Header: Order, 101016 - Zetadocs Delivery @
Please confirm delivery settings before continuing
Contact Selection
ContactMo. . . ... ... CT200136 [+]
ContactMame . . . . ... Mindy Martin
= = mindy.martin@cronuscorp.net
FaxMo. . . . . « « o« ..
Delivery Methed . . . . . . E-Mail =]
Template Selection
TemplateID . . . . . . . . ZT00006 (#]
Template Mame. . . . . . . ZD-Order Confirmation Template
General
Preview Document in Zetadocs Client Before Sending I
oK ] [ Cancel ] [ Help ]

Figure 61 - Zetadocs Delivery Dialog

19.3 Configured Send

It should be clear by now from the installation guide that by setting the “Company Type Code”, “Company
No. Field No.” and “Contact No. Field No.” fields in the Zetadocs Report Settings that you can configure
Zetadocs for NAV to automatically resolve your contact information and apply company specific rules if they
exist. In this way it is possible to reference any fields which contain the right type of reference (i.e.
customer/vendor or contact etc). There is some logic to the application of these settings that is important to
know to help decide what settings to enter but it also gives the opportunity for some variations in
configuration.

Zetadocs Report Settings Field No.’s Reference Logic (Pseudo Code)

IF Company Type Code <> NULL THEN
IF Company No. Field No. <> NULL THEN
Get the Company No. from Record using Field No.
ELSE
CALL Integration codeunit GetCompanyForReport for VAR to get Company No.
END
END

Send Result.VALIDATE(Company No., Company No. Value)

IF Contact No. Field No. <> NULL THEN
Get the Contact No. from Record using Field No.
ELSE
CALL Integration codeunit GetContactForReport for VAR to get Contact No.
END

Send Result.VALIDATE(Contact No., Contact No. Value)
From this it is important to notice the order that validation happens in as this coordinates with the Zetadocs
Send Result table OnValidate trigger code for “Company No.” and “Contact No.”. Since the company

information is validated first no contact reference will be set yet. We can check for this and default to using
the company’s communication information, later when the contact reference is validated we can override
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the addressing information (email, fax). This provides the fallback addressing logic of Zetadocs for NAV so
that if a record has a blank reference for a contact we will still end up with the company correspondence
information. This means that we can deliberately control what information is used by altering the settings. It
also means that this behavior can be customized by the VAR by implementing the get trigger functions in
the Zetadocs-Send Integration codeunit and/or changing the OnValidate triggers in the Zetadocs Send
Result table.

Company Type Code Company No. Field No. Contact No. Field No. Resulting Addressing
Info Used

SET SET SET Contact Info unless the
reference in record is
blank THEN Company
Info

SET NULL SET Contact Info unless the
reference in record is
blank THEN Company
Info using Company
Reference implemented
by VAR

SET NULL NULL Contact Info using
Contact Reference
Implemented by VAR
unless that reference is
blank THEN Company
Info using Company
Reference implemented

by VAR

NULL NULL SET Contact Info

NULL SET SET/NULL Invalid — You must
specify a company type

to enable use of
company field.

Table - Zetadocs Report Settings Addressing Information Control Options

To get a strong understanding of this it is recommended that you review the OnValidate triggers for
“Company No.” and “Contact No.” in the Zetadocs Send Result table and familiarize yourself with the
trigger functions in the Zetadocs-Send Integration codeunit. These are explained in detail in the next
section.

19.4 Custom Send

We saw in the last section how selecting certain report settings can control the flow of the operation of the
Zetadocs processing codeunits. By exploiting these settings and implementing the trigger functions in the
Zetadocs-Send Integration codeunit we can highly customize our report sending. In this section we will
focus on the trigger functions in the Zetadocs-Send Integration codeunit and explain how they can be used.

GetZetadocsArchivelD

WARNING: This function should be left unchanged. It is only exposed in this codeunit to allow a VAR to add
additional permissions to the codeunit for reading and writing the Zetadocs Archive ID value to and from
additional tables!

OverrideSendSettings

Apart from setting up the company and contact field number references in the Zetadocs Report Settings
there are a number of other options that control the display options and the report batch information
settings. During the Initialize function (See Architecture Overview) these settings are copied in to a
temporary table called the Zetadocs Send Settings. This gives us the ability to adjust these settings at
runtime. Once the report settings have been copied into the temporary send settings table described, the
Zetadocs Send Results Gen codeunit calls the OverrideSendSettings trigger function in the Zetadocs-Send
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Integration codeunit. Here you can modify the settings based on some logic for that send instance. Let’s
have a look at the Zetadocs Send Settings table.

b e

Table 9009975 Zetadocs Send Settings - Table Designer E@
E.. Field No.  Field Mame Data Type Length Description
v 1 Report ID Integer *
b v 2 Batch Name Text 120 |
v 3 Show Delivery Dialog Boolean
v 4 Show Error Dialog Boolean
v 10 Company Type Code Code 20
v 20 Client Prewview Boolean
v 30 TestMode Boolean
4 T 3
Help

Figure 62 - Zetadocs Send Settings

e Report ID: WARNING: This is not for editing. It is here to allow the developer to determine which
report is being printed in the trigger and to branch CASE or IF statements depending on its value.

e Batch Name: In the Zetadocs Report Settings you have the ability to specify a “Default Batch
Name”. This is the name that will be displayed in the Zetadocs Client for the report records printed
to Zetadocs. This default value can be overridden in this function.

e Show Delivery Dialog, Show batch Delivery Dialogs, Preview in Zetadocs Client and Test Mode: All
these can be dynamically overridden in this trigger at runtime.

e Company Type Code: Similar to the Report ID, this value is not for editing but is present to allow
the developer to determine the target company type configured for this report without having to
query the Zetadocs Report Settings Table.

A good example of when you might use this function is if you wish to have a report run uninterrupted by Ul

dialogs and previewing in the Zetadocs Client if it is being sent during the night. All previews could be
turned off.

GetContactForReport

As explained in the previous section, not specifying a “Contact No. Field No.” means that this function will
be called for you to return the value. This means that you are not restricted to extracting the reference
directly from the record being reported. The report id, record id and send settings are passed as parameters
into this function and therefore you can implement your own custom logic for each report and record type to
determine a contact. Note that the return value Code is not typed and is extra long. This means that the
code is not tied to a specific NAV type. This will be covered more in the next chapter.

GetCompanyForReport

Similar to GetContactForReport this function allows you to implement custom logic for determining the
“Company No.” value. The report id, record id and send settings are passed as parameters to this function
and therefore you can implement your own custom logic for each report and record type to determine a
company. Note that the return value Code is not typed and is extra long. This means that the code is not
tied to a specific NAV type. This will be covered more in the next chapter.

GetHardCopyPrinter

This function is always called to get the printer to use for the current user when the delivery method is set
to “Hard Copy”. It defaults to using the NAV Printer Selections setting for that user for that report otherwise
it uses the user’s system default printer. It is provided here to allow you to change this logic.
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GetOutputFileName

When a report is printed to Zetadocs, converted to a pdf and sent to a recipient it is desirable to be able to
name that pdf file something relevant. This function is called from the AddRecord function in the Zetadocs
Send Results Gen codeunit (i.e. once per report record) to allow you to specify independent file names.

GetRecordNoForReport

Similar to the Company No. Field No. and Contact No. Field No. settings in the Zetadocs Report Settings
there is an option to specify the Record No. Field No. This field’s purpose is primarily for customizing
Zetadocs message content. For example it is often desirable to include a Ref. number in the subject of email
correspondence. This can be set by adding %%][ZetadocsRecordNo] into the subject of a Zetadocs Template.

11’ Document Template Wizard @
Please enter your email properiies equisys

ZETAQOCS

Subject: Order Confirmation for order number: %% [ZetadocsRecordNo] for %[Organization] m

Standard =~ Tahoma - 12pt ~
9 B I U= % G3@|HM

(i
[
[l
e

4

FAQ: %%[Name,Customer]

Dear Customer,

I'm pleased to attach your order confirmation, reference number %%
[ZetadocsRecordNo].

m

Kind regards,

Sales Team

Help <Back || MNet> || Cancel

Figure 63 - Zetadocs Template Wizard

Once again this field no. reference setting operates similar to Contact No. Field No. such that if the field is
left blank in the Zetadocs Report Settings then this function will be called from the AddRecord function in
the Zetadocs Send Results Gen codeunit. This may be necessary if your reference number is composed of
more than one field value. If so these field values could be concatenated and returned from this function.

GetCompanyRule

This function is exposed here for a number of reasons. Firstly it allows the customization of rules
dynamically at runtime but primarily it can used in conjunction with the Company Type Code to provide
company rules for bespoke company types (i.e. types other than Customer and Vendor). This is explained in
more detail in the next chapter. The important thing to note about this function is the parameter that is
passed. The “Zetadocs Company Rule” is another temporary table maintained in the Zetadocs Send Results
Gen codeunit. This is used to get the rule override information irrespective of the company type. This will
become clearer in the next chapter. It is recommended that you review the implementation of this trigger
function in the Zetadocs-Send Integration codeunit to further your understanding.
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20. Bespoke Contacts and Company Types

Due to the nature of NAV system installations and the hugely customizable potential it is acceptable that
some systems may or may not use the company tables “18 Customer” and “23 Vendor”. Similarly some
systems may not use the Contact Management Module or the native NAV “5050 Contact” table. These
entities may have bespoke tables, this section details how Zetadocs for NAV can be integrated into such
systems. This section focuses on the abstract relationship between the “Zetadocs Company Types” table
and the tables that represent these types. We will also see how Zetadocs for NAV can be extended to
integrate with other existing native company types.

20.1 Company Types

Zetadocs for NAV integrates with two native company types in its initial configuration, Customer and
Vendor. However, the code which directly accesses these tables is kept in 2 locations that are public to a
NAV VAR. As an example of how one could implement a new bespoke company type or in fact edit one of
the existing company types CUST and VEND the following example is presented.

NOTE: the Zetadocs Sales Document Queue form (9009962) operates for the Sales process only and uses
direct references to the Customer and Contact names field in the “Sales Header” table. If you have modified
the Sales Header table (36) to work with your bespoke Customer and/or Contact implementations then you
may need to alter the references to “Sell-to Customer ..” and “Sell-to Contact ...” field references.

BANK Example
Consider the business relation BANK. To integrate Zetadocs for NAV with reports that are sent to BANK
contacts you would follow these instructions.

e C(Create a Zetadocs Company Type “BANK”

& Zetadocs Company Type List E'@
Code Description
oy Ak lBanks . |B
CusT Customers
VEND Vendars

Figure 64 - Zetadocs Company Types

e Implement the BANK “IF” case to get the bank name and addressing information from your bank
table in the Zetadocs Send Result table (9009968) similar to the CUST case.
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Table 3009368 Zetadocs Send Result - C/AL Editor [E=nE=m ==
Companuy Mo. - OnValidate(}
IF “Company Ho."™ <> "' THEHN
BEGIN
Ff"Company Name" := ZdIntegration.GetNameFromCompany(“Company Type", “Company No."};
IF "Company Type Code" = "CUST' THE 3
BEGIN
IF Cust._GET{"Company Mo."') THEN
BEGIN
“Company Hame* := Cust.Hame;
IF "Contact Ho.” = °° THEHN
BEGIN
IF Cont.GET(Cust."Primary Contact Ho.") THEHN
BEGIN
"E-HMail" := Cont."E-HMail“;
“Fax Ho." := Cont."Fax Ho.";
IF Cont.Type = Cont.Type::Company THEH
"Contact Hame" := Cust.Contact
ELSE
“Contact Hame" := Cont.Hame;
END
ELSE
BEGIN
"E-HMail" := Cust."E-HMail“;
“Fax No." = Cust."Fax No.";
"Contact Hame" := Cust.Contact;
END ;
END;
END
ELSE
BEGIN
HESSAGE{msgCompanyMotFound);
zdUtilities.Log(2, STRSUBSTHO( T9089972 - Company Ho. - OnValidate: Customer %
zdUtilities.Log{2, Please check that "Company No. Field Ho." is correct
EMND;
END
ELSE IF "Company Type Code"™ = "UEND' THEH >
4 [m b

Figure 65 - Zetadocs Send Result Table Code

e Also update the Company No. - OnLookup trigger and Contact No. - OnLookup trigger to include

the IF case for your BANK type.

e Update the thContName - OnLookup trigger in the Zetadocs Delivery Form (9009966) to use the

correct ContactBusinessRelation information if necessary.
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e

Forr 9009956 Zetadocs Delivery - Form Designer = [ =[]
&
'| Please confifm delivery settings before continuing” =~ © © © © (Tl
k:nnml:tNo. P e e | =<"Contact Mo." =
tnmﬁ-:t Mame .-. ... . | =<"Contact MName ">
EMal . ... || =<E-Mail">
FaxMNo. .. ........ ||=<Faxho.>
Delivery Method . . . . . .| =<Delivery Method™>
'| ' Template Selection I
Template ID . . . . . ... | =<"Zd Template ID">
h’emplate Mame. .. . . . . | =<"7d Template Mame™=
|l General '
_ Preview Document in Zetadocs Client Before Sending &
[ o [ cncel [ bep |

Figure 66 - Zetadocs Delivery Form “tbContName” textbox

e Theninthe Zetadocs Report Settings set the BANK Company Type for the report that has BANK
recipients and set the respective “Company No. Field No.” and “Contact No. Field No.” references
for the report source table.

e Ifyou have implemented a bespoke “Customer” table for use with Sales and Marketing then you
may need to update the Zetadocs Sales Document Queue Form (9009962) to use your bespoke
Customer record type references where necessary.

20.2 Contacts

Similar to Company it is possible that there may be a bespoke implementation of Contact information or
there may be a requirement to change the default contact address resolution logic of Zetadocs for NAV.

Validating

As has been explained the Zetadocs Report Settings the “Contact No. Field No.” determines whether the
contact reference can be extracted from a field in the record that is passed to the Zetadocs Send Results
Gen codeunit or whether this is implemented by the VAR and called from the codeunit. Once the reference
has been set in the “Contact No.” field in the Zetadocs Send Result table the OnValidate trigger is called.
Therefore to modify the contact addressing resolution or to change the code to use a bespoke contact table
you must follow these instructions:

e Modify the Contact No. — OnValidate trigger in the Zetadocs Send Result table (9009968) to get the
name and addressing information from your bespoke contact.
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Enabled Field No.  Field Name Data Type
v 1 Record ID RecordlD =
2 Record No. Code
10 Company Type Code Code
11 Company No. Code
12 Company Mame Text
20 Delivery Method Option

v | 30| Contactlo.

LUR SN SR Y

<

Table 9009968 Zetadocs Send Result - C/AL Editor
Contact Ho. - OnValidate()

[ =

IF "Contact Ho.™ <> '' THEN
BEGIH
IF Cont.GET{"Contact Ho.") THEH
BEGIN
“Contact Hame™ :=Cont._Name;
"E-Mail" := Cont."E-Mail"™;
“Fax Ho." := Cont."Fax Ho.";
END
ELSE
BEGIH
HESSAGE(msgContactNotFound) ;

A T O O T T S O T O O 4

zdUtilities.Log{2, '
END;
END
ELSE
BEGIN
//Should we blank values? HO!
| EMD;

4

zdUtilities.Log{2, STRSUBSTHO( T9809972 - Contact Ho. - OnUalidate:
Please check that “Contact Ho.

Field Ho."

Gontact %
is correct

[am

Figure 67 - Zetadocs Send Result table - Contact No. code
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e Modify the Contact No. — OnLookup trigger in the Zetadocs Send Result table (9009968) to use the
correct ContactBusinessRelation information dependant on the “Company Type Code”.

e Update the Zetadocs Delivery Form (9009966) references to contact information to use your
bespoke contact record type and correct ContactBusinessRelation information if necessary.

e Ifyou have implemented a bespoke “Customer” table for use with Sales and Marketing then you
may need to update the Zetadocs Sales Document Queue Form (9009962) to use your bespoke

contact record type references where necessary.
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21.Zetadocs-Send Customize codeunit

By now you should have a good idea of what this codeunit is for. Up until now we have been exploring the
internal processing and control flow of the Zetadocs for NAV Addin. By using specific settings and writing
some code in the Zetadocs-Send Integration codeunit and the Zetadocs Send Result table triggers it is
possible to completely integrate and customize Zetadocs for NAV into an NAV system. We have also seen
the potential to implement business specific logic into the sending mechanism and expand on the Zetadocs
for NAV product functionality. There is still however room to take it further.

This section details the two basic functions in the Zetadocs-Send Customize codeunit (9009962) that allow
the implementation of more business specific send logic as well as document formatting and archiving
customizations.

21.1 OverrideSendResult

As the name suggests this function gives you the whole send result. At this point the result has been
completely resolved by Zetadocs and any custom code that has been implemented by you in the various
areas explained earlier in this document. This then allows you to modify the completed record as a whole.
The only place the results can be edited after this are in the Zetadocs Delivery Dialogs or the Zetadocs
Errors Dialogs depending on your display settings for these dialogs, as specified in the Zetadocs Report
Settings (potentially overridden by the OverrideSendSettings in the Zetadocs-Send Integration codeunit).
Let’s examine the Zetadocs Send Result table a little more closely now for the first time.

Table 9009969 Zetadacs Send Result - Table Designer [ || & |[55)
Enabled Figld Mo, Field Name Data Type
v 1 Record ID RecordID
v 2 Record Mo, Code
v 10 Company Type Code Code
v 11 Company Mo, Code
v 12 Company Mame Text
v 20 Delivery Method Option
v 30 Contact Mo, Code
v 31 Contact Name Text
v 40 E-Mail Text
v 41 E-MailCc Text
v 42 E-MailBice Text
v 50 Fax Mo, Text
v 60 Prinker Text
v 70 ArchivingEnabled Boolean
v 71 Archive Location Text
v 72 Archive Document Type Text
v 80 Zetadocs Archive ID GUID
v 90 Zd Template ID Code
v 91 Zd Template Mame Text
v 110 Error Boolean
v 111 Erraor Description Text
v 112 skip Boolean
v 130 Qutput File Mame Text
4 1 F
Help

Figure 68 - Zetadocs Send Result

Some of these fields will be familiar from having worked with the Zetadocs Company Rule used in the
GetCompanyRule trigger function in the Zetadocs-Send Integration codeunit. Let’s break them up into their
respective parts and get familiar with their use and how we can exploit this to implement our specific
business logic and workflow.
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Record Fields (1 -2)

The Record ID and Record No. represent the typeless and typed references to the record we are sending.
Record ID is used by the core processing of Zetadocs for NAV to tie the send results and records together.
Record No. is what will ultimately be passed to Zetadocs for use as an external reference by either the
recipient or in archiving to SharePoint. For more information on Record No. click here.

Example Usage:
Having the Record ID of what you are sending means you can get that record and query or use values from
that record to implement logic for changing other fields in the Zetadocs Send Result.

Company Fields (10 - 12)

These fields and their use should be extremely clear by now. The Company Type Code allows us to integrate
with native and bespoke company tables such as Customer, Vendor and one of your own design. Company
No. and Company Name are then obvious references to the id and display name of the company.

Delivery Method (20)

This controls the addressing that is selected for sending, E-Mail, Fax or Hard Copy. Some obvious
customization possibilities include implementing a company policy such as “Any company sensitive
information should not be emailed under any circumstance and should be faxed or printed only.”
Depending on particular reports or recipients the delivery method could be checked or changed to uphold
company policy.

Contact Fields (30 -31)

In collaboration with the Company fields these fields can integrate with native and bespoke systems for
contact addressing information resolution. By setting and validating this field is it possible to pull the
information from the contact based on the logic that is implemented in the Zetadocs Send Result table
triggers as discussed previously.

Addressing Fields (40 - 60)

Provides the ability to set additional email recipients in the Cc and Bcc fields, these fields are without
relationships to the contact and company references that may or may not be present in the send result
record. This means that addressing information can be taken from anywhere for the respective email, cc,
bcc, fax and print addressing fields. Care should be taken to clear the company and contact no. fields before
setting these values manually.

Archiving Fields (70 - 72)

Set in the Zetadocs System Rule that you have associated with a report via the Zetadocs Report Settings,
the archiving settings are available for per record modification. This can be used for example in deciding
whether or not the document is archived depending on its content or changing the archiving location to a
limited permissions document library in SharePoint, or sub categorizing documents using the Zetadocs
Archive Document Type.

Properties:
e Archiving Enabled — per document archiving
e Archive Location — the archive connection string takes the following format
e “sharepoint: <site>, <archive library>[/subfolder[/subfolder...]]”
e Archive Document Type —for an in-depth explanation of this please refer to the ‘Zetadocs for
Microsoft Dynamics NAV SharePoint Components Installation Guide.pdf’ on your CD.

Zetadocs Archive ID (80)
WARNING: This field will contain data which contains a reference for an NAV record to archived documents.
It should not be edited or you risk breaking the archive search functionality of Zetadocs for NAV.

Zetadocs Template Fields (90-91)

The “Zd Template Name” field is set automatically as the “Zd Template ID” field has a table relation with the
Zetadocs Template table. The uses of this field are fairly obvious, change the Zetadocs template being used
depending on some custom business logic.
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Error Fields (110-111)

The Zetadocs Send Result table (9009968) has a trigger function CheckErrors. This function is called for
each results record in the Zetadocs Send Results Gen codeunit during the ResolveSendInfo function. This
happens after all possible modifications of the send result values have taken place in the Zetadocs-Send
Integration trigger functions and Zetadocs-Send Customize codeunit override function OverrideSendResult.
This function checks the addressing information (email, fax, and printer) against the specified “Delivery
Method” (Email, Fax, Hard Copy) to pre-empt potential send failures in the Zetadocs Client. If an error is
found in a Zetadocs Send Result record the “Error” field is set to TRUE and a description of the error written
in “Error description”. It is possible to implement your own error checks by editing the code in the
CheckErrors function in the Zetadocs Send Result table. Note that the presence of an just 1 error record in
the Zetadocs Send Result record for a particular send will cause the “Zetadocs Batch Delivery Dialog” to
display IF the “Zetadocs Send Settings” for that send has “Show Batch Delivery Dialog” set to TRUE
otherwise all errors will be marked as Skip = TRUE.

Skip (112)

When Skip = TRUE this will cause the report to use CurrReport.Skip for the associated record. For example if
your report contains 3 reports and one is marked to skip then only 2 will be printed to Zetadocs. If the
Zetadocs Batch Delivery Dialog is displayed either by there being errors in the send results or by the user
choosing to preview the send results, they can manually set a report to skip particular report records.

ZLetadocs Batch Delivery Settings E@
Please correct any errors listed or select to skip the records before continuing
Skip All Errors Preview Documents in Zetadocs Client Before Sending
Record ID  Company M... Contact Mo, ContactM... Delivery ... Template  Error Error Des... Skip E-Mail Fax Mo.
b SalesHe... Autohaus... CT0000&82 Autohau... E-Mail ZD-Order... autohaus. .. -
Sales He... Designstud... CTO00045 Designst... E-Mail ZD-Order. .. designst. ..
ok | [ et ][ Edtal || Gancel | [ Help

Figure 69 - Zetadocs Batch Delivery Dialog

Output File Name (130)

When a report is printed to Zetadocs and split into the addressable documents each document is given a
name. It is desirable to be able to control the name of these documents as it will be the name of the PDF file
produced and attached to emails as well as archived to SharePoint. This field allows you to set that
document name. A good example of its use would be to generate the name based on the type of report and
the record no. For example: “Order Confirmation: 10045”. Using the RecordID you can retrieve any
information about the record for generating the output file name.

21.2 GetAdditionalEmbComms

In the final stage of the reporting process for Zetadocs for NAV the GetRecordCustComms function is called
from the report on the Zetadocs Send Results Gen codeunit to retrieve the formatted embedded commands
which represent the send result for each report record. Internally in the Zetadocs Send Results Gen codeunit
we create the Zetadocs embedded commands but before we return it we call this trigger function
GetAdditionalEmbComms in the Zetadocs-Send Customize codeunit. This allows you to return additional
embedded commands which can be used to customize your document message subject and body text as
well as additional archive metadata to associate with the document when it is archive.
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Dynamic Fields
Dynamic Fields are name/value pairs that can be used to pass any information to Zetadocs. The format of
the command is:

% %l[field: <name>, <value>]

For Example:
%%]field: salutation, Mr.]

By using this in conjunction with a Zetadocs Templates you can personalize the message as follows.
%%]field: salutation, Mr.]

%%[field:name, McCarthy]

%%l[field: company, Widgets Inc.]

%%l field: quote_number, 1234]

%%l[field: myname, Sam]

Document Template

When merged to a document template containing the following text:

Dear %%[salutation] %%[name]

I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure.
Our quotation number for your reference is %%[quote_number], please include this on your sales order.
Regards,

%%[myname]

Expected Output
Zetadocs creates the following email message body:

Dear Mr. McCarthy

I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure.
Our quotation number for your reference is 1234, please include this on your sales order.

Regards,

Sam

Archiving Metadata
It is also possible to archive any of the dynamic fields as metadata. To do this the embedded command
should include the ARCHIVE flag at the end. Here is the format:

%%[field: <name>, <value>, ARCHIVE]
For Example:
%%l[field: Postcode, N7 oJE , ARCHIVE]

Whether the dynamic field is used in personalizing the message or not its value name pair will be passed to
the SharePoint archive as a content type column.

There are a couple of things to note about this. If the column name does not exist already in SharePoint it
will need to be created as a column of the content type specified, this needs to be done in SharePoint in
advance.

Zetadocs documents default to using a “Zetadocs” content type. If you have specified an “Archive
Document Type” in either the Zetadocs Document Sets table or the Zetadocs Report Settings table then the
content type will be a child type of the Zetadocs content type. NOTE: It is recommended that the SharePoint
columns are created before archiving a document and that it is well tested before roll out.

These fields can then be used to search on SharePoint. The Zetadocs-Utilities codeunit exposes a search
function which can perform a column search in SharePoint.
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SharePointSearch
This command in the Zetadocs utilities will launch your web browser and search the specified field for the
specified value.

SharePointSearch(Text <fieldname>, Text <fieldvalue>, Boolean <ShowSearchPage>)
For Example:

SharePointSearch(‘Postcode’, ‘N7 o/E’,FALSE)
When <ShowSearchPage> is false you will be directed to the search results. When it is true you will be taken
to the Zetadocs Search page with the ‘Postcode’ pre-populated in the search form. This does however
require modifying the search page as per the instructions in the Zetadocs for Microsoft Dynamics NAV
SharePoint Extensions Installation Guide.
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22, Migrating to the live database

At this stage the system configuration and testing of Zetadocs Delivery Essentials should be complete, if
these are the only elements to be installed in your system and you have been performing these steps on a
test version of your system you can now migrate it to the live database. Otherwise please continue
installing any remaining components, there will be details on migrating these systems provided following
their install and configuration. The process is very similar to the steps taken in sections 7 and 8 save that
the configuration file that you will be importing is now configured to your requirements.

This requires a number of steps:

e Exporting the Configuration

e Exporting any Modified Forms, Tables or Reports
e Importing the Zetadocs for NAV Objects

e Importing any Modified Forms, Tables or Reports
e Importing the xml file with your configuration

22.1 Exporting the Configuration
The Zetadocs Configuration Export form will export all of the configuration data specific to Zetadocs, if you
have modified data in other tables this will not be exported.

e From the Navigation pane select the Administration option.

e From the options that appear, select Application Setup and then Zetadocs Setup.

e Select the Zetadocs Configuration Export option.

e Inthe window that appears select a suitable name and location for your configuration export and
click Export.

22.2 Exporting Modified Forms, Tables or Reports
e Open the Navision client and connect to/open the Navision database.
e Open the Object Designer (Tools->Object Designer).
e Click on All button in the designer menu.
e Select All objects (CTRL + A) or alternatively select those objects you wish to export.
e Select Export Objects in file menu (File>Export).
e Export objects to a suitable file e.g. Zetadocs for NAV4.0 Export.fob file.
o Keep the Zetadocs for NAV4.0 Export.fob in a safe place.

22.3 Importing Zetadocs to the Live NAV System

The steps to import the Zetadocs for NAV system to your live system are the same as those utilised earlier,
save that different files are imported. Instead of importing the config.xml file and tables/forms.fob files
straight from the Zetadocs for NAV product CD/download you simply select the configuration xml file you
created during the export and any modified versions of your tables and forms. The steps below outline this
process, for more in depth instructions please review chapters 7 and 8 for more details.

e Import the Zetadocs for NAV Objects fob file created from you test system.

e Ifyou are using Document Archiving import the Zetadocs for NAV v4.0 Interfaces (Tables) fob file
relevant to your language and NAV version from your product CD or import the modified tables
from your test system.

e Ifyou are using SharePoint Archiving import the Zetadocs for NAV v4.0 Interfaces (Forms) fob file
relevant to your language and NAV version from your product CD or import the modified forms from
your test system.

e Import the xml file with your configuration from the test system.

e Copy across your Zetadocs Templates.

Once you have imported the configuration you should perform a series of tests like those in chapter 12 to
ensure the system have be successfully migrated.
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This section contains details on performing routine tasks and other procedures which may be required to

maintain an operable system.

23.1 Operational Checklist

Use these checklists periodically to record operations.

Checklist: System Operation
Follow the checklist to verify system operation.

Completed Task

Check the operation of each Zetadocs enabled NAV report.

Check and verify that messages print to the Zetadocs Client successfully.

Check and verify that messages deliver successfully.

Check and verify that messages archive successfully.

Check the number of documents printed, delivered and archived match.

Check the operation of each Zetadocs enabled NAV report.

Checklist: Event Logs
Check event logs using the following checklist.

Completed Task

repetitive warning and error logs.

Filter application and system logs on each NAV Client to see all Zetadocs errors Note

search and crawl errors. Note repetitive warning and error logs

Filter application and system logs on the SharePoint server to see all Office SharePoint

this guide.

Respond to discovered failures and problems with the aid of the Troubleshooting section of

Checklist: Check NAV and SharePoint Backups
Complete this checklist to check supporting systems backups.

Completed Task

completed.

Ensure that the recommended minimum backup strategy - a daily online backup - is

Verify that the previous backup operation completed.

Analyze and respond to errors and warnings during the backup operation.

Follow the established procedure for tape rotation, labeling, and storage.

logs).

Verify that the transaction logs were successfully purged (if your backup type is purging

Make sure that backups complete under service level agreements (SLA).

23.2 Security Hardening

Zetadocs for NAV provides the ability to print and send NAV information and in that respect consideration
should be made as to ensuring the safety of both the information and the method of delivery. As Zetadocs
integrates with Microsoft Dynamics NAV and Microsoft Office Outlook as standard for the source and

destination of the information attention should be paid to the access permissions with NAV to
data. Overall best practices should be followed for the deployment of NAV and Office Outlook.

particular

Similarly the setup and configuration forms within Zetadocs for NAV are recommended for access only by an
NAV Administrator and therefore access permission roles should be set up to this effect as with the other
areas of NAV. For general advice on Security Hardening for NAV and other general recommendations please

refer to the “Navision Security Hardening Guide” which is downloadable from
http://www.mibuso.com/dlinfo.asp?FilelD=474 .

Zetadocs Setup

Some features of Zetadocs for NAV involve the use of shared network folders. It is strongly recommended
that only the necessary users are granted access to these folders. Examples of these are: Zetadocs

Template folders, Zetadocs Document Queue folders.
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The Zetadocs Configuration, which contains details of enabled users, license and location of shared
network folders, is stored in the domain partition of Active Directory. Optionally this configuration can be
stored on a network share; it is also strongly recommended that only the necessary users are granted
access to this folder.

SharePoint Security

If integrating with Microsoft SharePoint as a document archive, consideration should be made as to the
access permissions of users to view potentially sensitive archived information. For general security
recommendations for Microsoft SharePoint Server please refer to Microsoft documentation. Some
information on security hardening can be found here http://technet.microsoft.com/en-
us/library/cc262849.aspx .

From Zetadocs for NAV, rules can be setup to change the archive location of documents dependant on type
and with the use of the Zetadocs SDK granule and writing some code in the Zetadocs-Customization
codeunit per record archive locations can be set dependant on content. For this reason it is recommended
to consider access permissions when creating the Zetadocs System Rules.

23.3 Performing a Zetadocs for NAV Backup

This section describes how to perform backups of a Zetadocs for Microsoft Dynamics NAV system. This
enables you to safeguard your organizations information resources by holding extra copies in secure
locations and enables you to restore your systems following problems with the original data.

How Zetadocs for NAV Backup integrates with NAV Backup

Zetadocs for NAV has additional tables contained within NAV which when NAV is fully backed up will also be
included within the backup meaning that there is no additional overhead in performing the standard
operation. There are however elements to Zetadocs for NAV which exist separately from NAV which will
require additional steps to include in a complete backup.

Document Queues — The Zetadocs Document Queues are centralized folders for processing documents
from, in essence a virtual in tray. The Zetadocs Document Queues operates by accessing a shared network
folders which contains documents received by NAV via email, fax or scanned from hard copy sources. As the
folder is not part of NAV it will not be backed up during an NAV backup as such it is desirable to backup the
network folders separately.

SharePoint Archive — If the archiving options in Zetadocs have been configured to archive documents into a
SharePoint archive then this to would need to be backed up separately as well to ensure that the record of
processed documents is not lost. The backup of this data falls under the standard backup of a SharePoint
system and therefore may be part of your existing backup procedure.

Preparations before Backing up

It is important to have a clear strategy for dealing with system backups as it is both business critical and
also a legal requirement that backups of essential business data be kept. There are obviously a number of
decisions to be made when backing up:

e Identify the data to be backed up

e Frequency and Timing of the Backup
e Storage Format

e Storage Location

Performing an NAV System Backup
To perform a backup follow the standard NAV backup instructions, a full system backup will include both
NAV and the Zetadocs elements integrated into NAV.

Backing up the Zetadocs Document Queues
To backup the document queues you need to simply locate the network folders and copy those folders to
the assigned storage location for your backup.

e Locate the network folders which contain the contents of your document queues. This will be
specified in the Zetadocs Sales Document Queue Form shown below and the Zetadocs Purchase
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Document Queue Form.
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Figure 70 - Zetadocs Purchase Document Queue Setup

e Copy the folders (or the specific elements you desire) to your backup storage location.

Backing up your SharePoint System
Backup of all SharePoint site and document libraries for Zetadocs for NAV are covered in a standard
Microsoft SharePoint backup. For more information please refer to:

SharePoint MOSS: Administering backup and recovery for Office SharePoint Server 2007
SharePoint WSS: Administering backup and recovery for Windows SharePoint Services 3.0

Restoring a Zetadocs for NAV system

To restore your Zetadocs for NAV system following problems with the original data you need to restore 3
separate elements. The NAV system backup itself which contains the additional Zetadocs elements, the
document queue backup and the SharePoint archive.

Preparations for Restoring your System
It is important to have a clear strategy for dealing with system restorations as it is critical to the business
that the system can be restored. There are obviously a number of decisions to be made when restoring the
system:

o Identify the storage location for the backup

o Identify which backup data set is to be restored

Restoring your Zetadocs for NAV System

At some point you may need to restore your system using a backup, this will restore the Zetadocs for NAV
system excluding the document queue and the SharePoint archive which will be covered later in this guide.
To restore your system follow the standard restore instructions as laid down in NAV.

Backups that were exported with the Microsoft Dynamics NAV backup facility can be imported by using
Tools, Restore. You should always restore the database backup into a new (empty) database.

Restoring the Document Queues
e Locate the copy of the network folders which contained the contents of your document queues in
your backup location.
e Copy the folders (or the specific elements you desire) to the network folders being used for your
respective document queues. The location of these folders will be specified within the Zetadocs
Sales Document Queue Setup Form and Zetadocs Purchase Document Queue Setup Form.

Restoring your SharePoint System
All SharePoint sites and document libraries for Zetadocs for NAV can be restored using the standard
Microsoft SharePoint Restore instructions. For more information please refer to:
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SharePoint MOSS: Administering backup and recovery for Office SharePoint Server 2007
SharePoint WSS: Administering backup and recovery for Windows SharePoint Services 3.0

Reinstalling the Zetadocs for NAV SharePoint Extensions

If you have had to completely rebuild your SharePoint system then you will need to reinstall the Zetadocs
for NAV SharePoint Extensions after you have restored your SharePoint system.
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24. Upgrading your Zetadocs for NAV system

Upgrading your Zetadocs for NAV system has four main stages shown below which will update your system
to the Zetadocs for NAV v4.0 specification. The following process should enable you to upgrade from a
Zetadocs for NAV v3.0 system, for details on installing from earlier versions please contact Equisys
technical support at support@equisys.com.

e Zetadocs SharePoint Extensions

e Zetadocs for NAV Client

e Zetadocs for NAV Objects

e Zetadocs for NAV Reports (Optional)

24.1 Preparing to upgrade your Zetadocs for NAV system
You may wish to create a copy of your live system on which to perform the upgrade before migrating it
across to your live system,

Creating a copy of your NAV database (optional)
e Open the NAV client and open the database in question.
e From the main menu select Tools—>Backup.
e Save a copy of your NAV database in a safe location.
e Select File>Database->New and create a new duplicate system.
o Next select Tools>Restore and select the backup database you just created.

24.2 Upgrading the Zetadocs SharePoint Extensions

The Zetadocs SharePoint Extensions installer will have provided a set of components that sit on a Windows
SharePoint Services (WSS) v3.0 or Microsoft Office SharePoint Server (MOSS) 2007 machine. Briefly, these
components comprise of web services, web parts and ASPX pages. To upgrade your SharePoint extensions
install you need to uninstall the existing extensions fully and then install the new Zetadocs SharePoint
Extension in their place.

SharePoint Extensions

To uninstall the SharePoint extensions you must be logged onto the machine using an account that has
SharePoint Site Collection Administrator privileges for the front-end web application and the Central
Administration program.

To check which accounts are listed as Site Collection Administrators, you should do the following:

e On the SharePoint machine, run the application SharePoint 3.0 Central Administration from the
Start menu.
e Click on the Application Management option in the left-hand navigation panel.
o Select the Site Collection Administrators option from the SharePoint Site Management section of
the page. The resulting page will show you which accounts are listed as the Primary and Secondary
Site Collection Administration accounts.
Site Collection Administrators

Use this page to view and change the primary and secondary site collection administrators for a site collection. As site collection administrators, these users receive any quota or auto-deletion notices and have full control over all content in the site collection,

Site Collection: | http://moss-2003svr:15046/ssp/admin ~

Primary Site Collection Administrator

The primary site collection administrator is displayed. Type a user name, and then cick OK to save
the change.

Secondary Site Collection Administrator

The n optional entry for a Web site collection, The 8w
sec ed. Type a user name, and then click OK to save

Figure 71 - SharePoint Site Collection Administrators

e Using the Site Collection drop-down at the top of this dialog, add your chosen Administrator
account to both the Central Administration and front-end Web Applications.
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Deactivating the Zetadocs Web Services feature and NAV content types

To deactivate the Zetadocs Web Services feature and NAV content types on the SharePoint sites, you
should do the following:

e Open your top-level site in Internet Explorer.

e Choose Site Settings > Modify All Site Settings from the Site Actions menu if running MOSS
2007, or Site Settings from the Site Actions menu if running WSS v3.0. Please note that if the
Modify All Site Settings option is not available on a MOSS 2007 machine, you may be logged on as
a user with insufficient permissions to activate SharePoint features.

e Select the Site Collection Features option from the Site Collection Administration section.

e Find the Zetadocs SharePoint Web Services feature in the list and Zetadocs Content Types (NAV)
then click the Deactivate button for each.

Deactivating the Zetadocs Extensions feature on each site
To deactivate the Zetadocs Extensions feature on each site (including the top-level and Search sites), you
should do the following:

e Open the site in Internet Explorer.

e Choose Site Settings > Modify All Site Settings from the Site Actions menu if running MOSS
2007, or Site Settings from the Site Actions menu if running WSS v3.0.

e Select the Site Features option from the Site Administration section.

e Find the Zetadocs SharePoint Extensions feature in the list, and click the Deactivate button.

Uninstalling Zetadocs SharePoint Extensions
To uninstall the Zetadocs SharePoint Extensions, you should do the following:

e Browse to Add/Remove programs.

e Highlight the Zetadocs SharePoint Extensions option.

e Click the Remove button.

e The uninstaller will ask ‘Are you sure you want to remove Zetadocs SharePoint Extensions from
your computer?’

e Select Yes.

e Next you need to verify whether the zetadocs wsp files have been successfully removed as in some
systems they can remain.
Open the SharePoint Central Administration and select Operations then Solution Management.
Should you see any of the Zetadocs wsp files select them and choose Retract Solution and once
retracted select the Remove Solution option to complete the uninstall.

Upgrading the Zetadocs SharePoint Extensions
To upgrade to the latest version of the Zetadocs SharePoint Extension simply follow the standard
installation steps from chapter 5.

24.3 Zetadocs for NAV Client

The Zetadocs for NAV Client is installed in 3 separate parts:

e Zetadocs NAV Client
e Zetadocs APl Runtime
e Zetadocs PDF

The Zetadocs for NAV Client components are installed through Windows Installer and the upgrade can be
performed by running the installer again for Zetadocs NAV version 4.0.

e From your Zetadocs for NAV CD, launch the installer.
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SharePoint 2007 Extensions
SharePoint 2010 Extensions
Zetadocs NAV Client 32 bit
Zetadocs NAV Client 64 bit
Zetadocs for NAV Connector

Zetadocs Server

Figure 72 - Zetadocs for NAV Installer

e Select the Zetadocs NAV Client (32 or 64 bit) option relevant to your operating environment.

¢ You may be asked if you want to perform an upgrade of Zetadocs NAV Client. Select Yes.

e Follow the instructions of the installer and select Yes if asked to install the Zetadocs NAV Client
prerequisites of Zetadocs PDF and Zetadocs API Runtime. During the Zetadocs for NAV Client install
you will see the following dialog:

15 Zetadocs NAV Client - Installation Wizard

Setup Type equisys
Choose the setup type that best suits your needs. ZETAOOCS

Capture. Deliver. Share.

Please select a setup type.

Installs Zetadocs NAV Client for additional network users.

(") Administrator
All program files will be installed and shared network folders will be

created for templates, the sales document gueue and the purchase
document queue

All program files will be installed. Choose if and where shared
folders are created for templates, the sales document queue and
the purchase document queue,

Installshield

[ < Back ][ Next = ] [ Cancel

Figure 73 - Select Install Type

e Select Typical if you are upgrading a network user.

e Select Custom if you are upgrading the server installation.

e The Administrator option is only used on fresh installs and should not be used when performing an
upgrade.
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If you are doing a Custom install, should you want to use your existing templates shared folders
you need to disable the Zetadocs Template creation options as shown below
Select Next to continue.

119 Zetadocs NAV Chent - Installation Wizard = x|

Create Network Folders )
ZE n@oc S

Croose ch Shaved Foiders You Woukd Lice t Create

¥ Create Shaved Folder for Templates

) C\Users Public\Documents Eausys \etadocs NAV Terplates Browee.
- ]

Warming: Please ensure you hive 8ccess rights 1o areate ths folder

Figure 74 - Network Folder Locations

Once the installation is finished, ensure that your license information is still valid for the version of
Zetadocs that you are using. You can validate your license by using the Zetadocs PDF Configuration
program.

24.4 Zetadocs for NAV Objects

Most of the configuration for Zetadocs version 3.0 will work for Zetadocs version 4.0 once the new objects
are imported, but we strongly recommend that the current configuration is backed up for security reasons.
The following steps will tell you how to back up the Zetadocs for NAV objects before you upgrade.

Open the NAV Classic Client and log on to the database.

Navigate to the (Administration tab = Application Setup ->Zetadocs Setup).
Run the Zetadocs Configuration Export form.

Run the export to save the configuration data to an XML file.

Note that all the reports that were created for Zetadocs version 3.0 will work with Zetadocs version 4.0
without any modifications. Therefore, there is no need to export them during the upgrade process.

Deleting existing Zetadocs for NAV codeunits
Before you import the new objects you must delete some deprecated codeunits to avoid a name collision
during import.

Open the Navision client and connect to/open the Navision database.

Open the Object Designer (Tool->Object Designer).

Click on the Codeunits button in the Object Designer menu.

Select codeunits 9009966-Zetadocs Print and 9009967-Zetadocs Import and Export
Click on Delete in the Toolbar (F4).

Click Yes to delete selected lines.

You are now ready to import the Zetadocs for NAV 4.0 objects in your database. The instructions given here
are for NAV 6.0. You must pick the file that’s appropriate for the version of NAV you are using.

From NAV, import the Zetadocs for NAV 4.0 Objects — NAV6.0o.fob file. You will be prompted to
open the Import Worksheet — say No to open the Import Worksheet.
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Microsoft Dynamics NAV Classic (]

i 1 All ohjects have been examined, and no conflicts were found.

Choose Yes to import all objects, No to open the Import Worksheet, or
Cancel to stop the import.

Figure 75 - Objects Import

Once all the Zetadocs for NAV objects have been imported, ensure that the existing configuration has been

kept intact by going through the forms of the Zetadocs application setup. Recover configuration from the
backup xml file if needed.

24.5 NAV Reports

If upgrading from Zetadocs for NAV v3.0 all reports that have been modified for Zetadocs for NAV will work
consistently with version 4.0 and require no modifications.

Note: That you should not select any of your existing modified reports from the Zetadocs Reports Selection

Form as this could potentially result in duplication of the Zetadocs Embedded Commands and
delivery/archiving problems.

24.6 Zetadocs Server

Clearing the Zetadocs Document Queues
The Zetadocs Document Queue folders contain captured documents and display them in the relevant
document queue. The files in the converted folders need to be deleted before the upgrade process.

e Locate the existing Zetadocs for NAV Document Queue Folders. These will be specified in your

Zetadocs Sales/Purchase Queue Setup Forms in the Zetadocs Setup = Advanced Settings section
of NAV Administration.

e Make sure that the Zetadocs Document Converter service is not running.

5. servces BEE
Flle  action Yew Help

] B2
| services tocal *: Services (Local)

Zetadocs Document Converter Name Description Status | Startup Type | LogOn As
A | SaWindows Time Maintains date and time synchronization on al...  Started  Automatic Local System
-~ SWireless Zero Configuration Frovides autor . Stated  Automatic Local System
Manual Local System

I3

Start the service:

Description: Started  Automatic
This service manages the docume 5 B s i . " =
qusues For Zetadacs For Moresolt @ ~
" Extended  Standard

Figure 76 - Services

e Open the document queues and delete all files from the content of the hidden subfolder
“_Converted”. (To view hidden folders you will need to modify the folder options of Windows)
e Continue with the upgrade.
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The Zetadocs Server can be upgraded by running the installation program from the CD, simply:
e Login with Administrator rights and deactivate the User Account Control (UAC), click here for
details on doing this.
Uninstall your existing copy of the Zetadocs Server via Add/Remove Programs.
Run the Zetadocs for Microsoft Dynamics software CD or software download.
Select the install option for your product version from the main menu.
Then select the Zetadocs Server option.
The installation program will run, proceed through the wizard and on completion you will be asked
to restart your system before the changes can take effect.

24.7 Configuring the upgraded system
As there are new features in Zetadocs for NAV v4.0 you need to perform some additional configuration to
ensure the system works as expected.

Steps required for all systems
e Open NAV and select Administration from the Navigation pane.
e Next choose Zetadocs Setup > Advanced Setting
e Reference Prefix (Delivery Only)
o Choose Zetadocs System Settings.Select the reference prefix field and enter a suitable
value, by default this should be ZDRef.
e Document Queue No. Series (Capture Only)
o Next choose the Zetadocs No. Series menu item.
o Create a number series for the Zetadocs Document Queues. We recommend you copy the
format for the existing Zetadocs No. Series (E.g. ZDDOCQ).
e Capture Setup (Capture Only)
o Ifyouintend to use the drag and drop functionality of Capture then you must configure the
archive settings.
o Choose the Zetadocs Sales Capture Setup.
o Configure your archive library and subfoldering preferences
o Repeat for Zetadocs Purchase Capture Setup.

Updating the help files
Zetadocs for NAV comes with its own help files, these have been revised to cover the new functionality and
as such should be updated. Please follow the steps in section 6.2 to update your help files.

Enabling the Sales and Purchase Document Queues
Document Queue setup is handled via a pair of Document Queue Setup forms in Zetadocs for NAV v4.0
these need to be checked to ensure they contain the correct settings.

Open NAV and select Administration from the Navigation pane.

Next choose Zetadocs Setup = Advanced Setting = Zetadocs Sales Doc. Queue Setup.
Ensure the fields on the form match the required settings for your document queue.
Repeat for the Zetadocs Purch Doc. Queue Setup form.

Next we need to add them to the NAV menusuite as they are not included by default in our
mensuite fob any longer, see sections 15.7 and 15.8 for details.

Check the Reports are working

It is a good idea at this point to try printing some of your reports to Zetadocs to verify that they are still
working. If not you should re-check that the correct report IDs are set in the Zetadocs Report Settings and
that they match the report IDs that are set in the Report Selections for Sales and Purchases.

24.8 Adding new features to the system

To gain access to the new features in Zetadocs for NAVv4.0 you need to perform the additional setup and
configuration tasks required for each. Below is a list of those features and the sections of this guide you will
need to complete to enable them.
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Capture Essentials

The Capture Essentials components will have been added to the system earlier with the NAV object import,
to configure how Capture Essentials will operate simply follow the steps in section 10.9. Following that you
will need to update your Forms and Pages by following the steps in section 8.2.

Custom Document Queues
To setup a custom document queue simply follow the instructions in chapter 15.

Barcode Recognition

Barcode recognition requires the OCR module be installed, view the section 14.4 on the Zetadocs Server for
details on configuring OCR, once done you can perform the actions in chapter 16 to enable barcode
recognition.

24.9 Verifying the upgraded system

Having completed the above steps you simply need to populate those fields which were not present in the
previous version of Zetadocs for NAV to ensure the system operates as expected.
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25. Uninstalling Zetadocs for NAV

25.1 Uninstallation Overview
This section gives an overview of the uninstallation process. Each step is covered in more detail in the
following sections of this manual. It is recommended that you follow these steps in order.

e Rollback of NAV Reports
e Uninstalling the Zetadocs for NAV Objects

o Remove the Zetadocs for NAV objects and existing object modifications from within
Microsoft Dynamics NAV.

e Uninstalling the Zetadocs for NAV Client
e Uninstalling the Zetadocs SharePoint Extensions (Optional- may not have been installed)

o Removal of the Zetadocs Archive Document library and uninstallation of the Zetadocs for
NAV search web parts.

e Verify all components have been removed successfully

e Uninstalling the Zetadocs Server

25.2 Rollback of NAV Reports

To restore you original report versions you should have either backed up the original versions of your
reports or you produced new versions of your existing reports with different report ID’s.

Different Report ID’s
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tools—>Object Designer).
Click the Report button on the Object Designer.
Set a filter *EQ* on the Version List column.
Select all Zetadocs reports (CTRL+ A).
Click on Delete in the Toolbar (Fz).
Click Yes to delete selected lines.

Restoring Backed Up Reports
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tools—>Object Designer).
Select Import Objects in file menu (File=> Import).
Find and select the Backup of Reports before Zetadocs for NAV4.o.fob file.
Choose Yes to import all objects.
Click No to open Import Worksheet.
Click Replace All.
Click Ok.

25.3 Removing Zetadocs for NAV Objects
This section details the removal of Zetadocs for NAV objects and editing restored NAV objects back to their
original configuration.

Removing changes to existing NAV objects

Before you can import the old object versions you must clear all values in the Zetadocs archive id field in all
tables modified by Zetadocs for NAV. A function has been created to help do this in the Zetadocs
Integration code unit (9009959). The function is called RemoveArchivelDFromTables and takes one boolean
parameter. If this parameter is set to true, the function will expect all archive id fields to have the number
9009959. If the parameter is false the function will cycle through all tables and all fields looking for the
Zetadocs Archive ID field and clearing it out.

Warning, once this function has been run there will be no way to recover the Zetadocs Archive IDs that have
been lost and therefore there will be no link between NAV records and reports archived to SharePoint.
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To call this function it is suggested that you do the following:

e C(Create a new form.

e Add a button to the form.

e In C/AL Globals, add a variable called ZDInt of type codeunit with a subtype of Zetadocs-Send
Integration.

¢ Inthe on push event for the button add the following code:
ZDInt.RemoveArchivelDFromTables(TRUE);

e Save and compile the form.

e Runthe form and press the button. You will be prompted if you want to continue. Press Yes if you
want to proceed. The Zetadocs Archive ID fields will now have been cleared.

e Delete the form that you just created.

Importing the Backed up objects
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tool->Object Designer).
Select Import Objects in file menu (File=> Import).
Find and select the Backup of Objects before Zetadocs for NAV4.o0.fob file.
Choose Yes to import all objects.
Click No to open Import Worksheet.
Put an *EQ* filter on column Existing Object Version List.
Click Replace All.
Click Ok.

Uninstalling the Zetadocs for NAV Objects
e Click on the All button in the Object Designer menu.
e Put an *EQ*filter on column Version List.
o Compare the remaining object list with the object list table in the Appendix to ensure you will
not delete tables unnecessarily.
e Select table Zetadocs Settings (9009959)

Perform the next steps for all Zetadocs for NAV tables in the following order:
o 9009963 t0 9009982

o 9009960 t0 9009962

Click Run.

Select all lines (CTRL + A).

Click on Delete in the Toolbar (F4).

Click Yes to delete selected lines.

Close Table Run (Esc).

Once this has been complete for all tables in the specified ranges.
e Select all Zetadocs for NAV objects (CTRL+ A).
e Click on Delete in the Toolbar (F4).
e Click Yes to delete selected lines.

Note: You may not have permissions to delete all the objects, such as some codeunits. In this case it is ok
to leave the codeunits on the system as they will not be used.

25.4 Uninstalling the Zetadocs Client

This section describes how to uninstall the client applications which include the Zetadocs Client, the
runtime APl and the NAV Extensions. The Zetadocs for NAV Client installation is performed using a
combination of installers. You will need to uninstall each of these to remove the Zetadocs for NAV Client.
You will need to uninstall the Zetadocs for NAV and the two pre-requisites, the Zetadocs Client and
Zetadocs API runtime.
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Figure 77 - Add Remove Programs

Open Add/Remove programs (Windows XP) or Programs and Features (Windows Vista) or other
uninstallation utility relevant to the environment you are operating in.

e Select Zetadocs NAV Client from the program list and select uninstall.
e Select Zetadocs PDF from the program list and select uninstall.
e Select Zetadocs API Runtime from the program list and select uninstall.

25.5 Uninstalling the Zetadocs SharePoint Extensions

The Zetadocs SharePoint Extensions installer will have provided a set of components that sit on a Windows
SharePoint Services (WSS) v3.0 or Microsoft Office SharePoint Server (MOSS) 2007 machine. Briefly, these
components comprise of web services, web parts and ASPX pages. The purpose of these components was

to provide a means of integrating Zetadocs for NAV with a SharePoint installation.

SharePoint Extensions

To uninstall the SharePoint extensions you must be logged onto the machine using an account that has
SharePoint Site Collection Administrator privileges for the front-end web application and the Central
Administration program.

To check which accounts are listed as Site Collection Administrators, you should do the following:

e  On the SharePoint machine, run the application SharePoint 3.0 Central Administration from the
Start menu.

e Click on the Application Management option in the left-hand navigation panel.

e Select the Site Collection Administrators option from the SharePoint Site Management section of

the page. The resulting page will show you which accounts are listed as the Primary and Secondary
Site Collection Administration accounts.

Central Administration > Application Management > Site Collection Owners

Site Collection Administrators

Use this page to view and change the primary and secondary site collection for a site collection. As site collection these users receive any quota or auto-deletion natices and have full control over all content in the site collection.

Site Collection Site Collection: | http://moss-2003svr:15046/ssp/admin ~
Select a St Colection.

Primary Site Collection Administrator Primary site collection ad

MOSS-20035VR\ad)

The primary site collection administrator is displayed. Type a user name, and then ciick OK to save
the ch

Secondary site colection administrator:

save

Figure 78 - SharePoint Site Collection Administrators

e Using the Site Collection drop-down at the top of this dialog, add your chosen Administrator
account to both the Central Administration and front-end Web Applications.

Uninstalling Zetadocs SharePoint Extensions
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To uninstall the Zetadocs SharePoint Extensions, you should do the following:

Browse to Add/Remove programs.

Highlight the Zetadocs SharePoint Extensions option.

Click the Remove button.

The uninstaller will ask ‘Are you sure you want to remove Zetadocs SharePoint Extensions from

your computer?’

Select Yes.

o Next you need to verify whether the zetadocs wsp files have been successfully removed as in some
systems they can remain.

e Open the SharePoint Central Administration and select Operations then Solution Management.

e Should you see any of the Zetadocs wsp files select them and choose Retract Solution and once

retracted select the Remove Solution option to complete the uninstall.

25.6 Uninstall Zetadocs for NAV Client Help Files
The Zetadocs for NAV help files should have been copied to the Microsoft Dynamics NAV help folder and
given names that will not clash with other help files.
These files were originally:

e addin_a.chm

e addin_a.hh
This folder may have contained other help files which may have used the ‘a’ post-fix name. As such you
should select and open the addin_a.chm file and identify whether it is the Zetadocs for NAV help file. If it is
not then try the next unused post-fix letter between a and j until you locate the Zetadocs for NAV help files.
Note that the post-fix on both file names must match. (e.g. addin_f.chm and addin_f.hh) Once identified
these files should be deleted from:

Program Files\Microsoft Dynamics NAV\CSIDE Client\ENG
Or removed from the equivalent installation folder of Microsoft Dynamics NAV on the machine.

25.7 Uninstalling the Zetadocs Server
The Zetadocs Server converts items placed into the document queues into pdf format, to remove it follow
the steps below.

e Open Programs and Features (Windows Server 2007) or other uninstallation utility relevant to the
environment you are operating in.

e Select Zetadocs Server from the program list and select uninstall.

o Some files are created after installation of the Zetadocs Server, to ensure all related files are
removed, delete the Zetadocs Server folder. This is by default located in the Program Files
directory.
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26. APPENDIX

26.1 Troubleshooting

This section provides help with resolving common problems with the system. To assist in trouble shooting
problem with the Zetadocs system there are a number of log files which can help diagnose a problem or
assist in getting the configuration of the system correct.

NAV Logging
Ensure that Logging Enabled is ticked ON in the Zetadocs System Settings Form. The Logging Level
determines the amount of information written to the log file. For general configuration and trouble shooting,
WARNING or ERROR should suffice. The NAV log is saved to the users temp folder location. This can be
found by either pressing Start->Run, then type %Temp% and press OK; or manually browse to
C:\Users\<username>\AppData\Local\Temp(Vista) or C:\Documents and
Settings\<username>\Local\Temp(XP) directory.
There are two logs produced by the Zetadocs for NAV Addin.

e ZdExternalUtilitiesDll.log — logging of document queue actions and external calls to Zetadocs API.

Only valid for troubleshooting issues with Equisys.

e ZetadocsNAV.log - standard logging of activity that occurs in the Zetadocs for NAV objects.
The content of the Zetadocs for NAV tables can also be exported to help when troubleshooting issues. A
single text file is created and includes the version of all the Zetadocs for NAV objects that are currently
installed on the system, as well as the content of the tables (report settings, system settings, etc.). The
following steps explain how to create the version report file.

Actions:
e From the Administration pane, select Application Setup\Zetadocs Setup\About Zetadocs for NAV.

e Select the “Save Version Report” button.
e Save the text file locally.

=
Zetadocs for NAV

Version EQ4.0.110
Licence Number 55500000
Licence Type Zetadocs for NAV

Copyright {c) 2007-2010 Equisys plc and its licensors, All
rights reserved, Zetadocs is a registered trademark of
Equisys plc.

Sawve Version Report ] 0K

Figure 79 — Zetadocs About Box

The version report created can be printed directly to Zetadocs PDF. It will already be addressed to Equisys
technical support. If using NAV 6.01 this action must be performed from the classic client.

Zetadocs Client
Please refer to the Zetadocs Client help for information on client logging.

Zetadocs API
The Zetadocs API runtime, which is used as part of the Zetadocs for NAV addin logs information to the users
Zetadocs folder. Its contents are usually of value when troubleshooting issues with Equisys.
It can be found at:
e (C:\Users\<username>\AppData\Local\Equisys/Zetadocs PDF/ZdApi.log(Vista)
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e C:\Documents and Settings\<username>\Local\ApplicationData\Equisys\Zetadocs PDF\ZdApi.log
(XP).

Object ID collisions when importing the Zetadocs objects .fob file

Unless you are re-importing the objects or performing an upgrade it is unlikely that you will come across an
ID collision. If you do, please continue and view the recommendations of the import collision wizard in NAV.
It is not recommended to undertake collision resolution unless you are an experienced NAV consultant.

Some objects fail to compile during import of the Zetadocs objects .fob file
Most likely this is due to not having installed the Zetadocs for NAV Client on the machine you are using to
import the Zetadocs objects from. Many of the codeunits in Zetadocs for NAV use automation components
which must be installed prior to importing to ensure that all objects compile successfully.
Things to check for (in order):
¢ You have installed the Zetadocs for NAV Client on the machine you are using to import the
Zetadocs objects
You are logged in as the user who installed the Zetadocs for NAV Client
If the above are true but you are still having problems try uninstalling and re-installing the
Zetadocs for NAV Client

When you run the Customer/Vendor Card no information is displayed in the Zetadocs tab
Copy and pasting the Zetadocs subform control on to the Zetadocs tab should copy all required subform
links. If you are experiencing problems check the following property values on the subform control on the
Zetadocs tab:

e  SubFormlID: Zetadocs Customer Rule Subform

e  SubFormLink: Customer No.=FIELD(No.),Zd Rule ID No.=CONST(0)
OR For Vendors

e SubFormiD: Zetadocs Vendor Rule Subform

e SubFormLink: Vendor No.=FIELD(No.),Zd Rule ID No.=CONST(0)

SharePoint Logging
The logs for Zetadocs activity on your SharePoint site can be found in the following locations:

SharePoint 2007 Systems
C:\Program Files\Common Files\Microsoft Shared\web server extensions\12\LOGS\Zetadocs

SharePoint 2010 Systems

C:\inetpub\wwwroot\wss\VirtualDirectories\8o\%CommonProgramFiles%\Microsoft Shared\Web Server
Extensions\14\LOGS\Zetadocs

26.2 Zetadocs for NAV Object List

Type ID NAME Status
Table 9009959 Zetadocs System Settings New
Table 9009960 Zetadocs Template New
Table 9009961 Zetadocs Document Queue ltem New
Table 0009962 Zetadocs Sales Document Queue New
Table 9009963 Zetadocs System Rule New
Table 9009964 Zetadocs Customer Rule New
Table 9009965 Zetadocs Report Settings New
Table 9009966 Zetadocs Document Set New
Table 9009968 Zetadocs Send Result New
Table 9009970 Zetadocs No. Series New
Table 9009971 Zetadocs Vendor Rule New
Table 9009973 Zetadocs Company Type New
Table 9009974 Zetadocs Company Rule New
Table 9009975 Zetadocs Send Settings New
Table 9009976 Zetadocs Sys. Rule Recip. Line New
Table 9009977 Zetadocs Cus. Rule Recip. Line New
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Type ID NAME Status
Table 9009978 Zetadocs Ven. Rule Recip. Line New
Table 9009979 Zetadocs Company Rul Rcp. Line New
Table 9009982 Zetadocs Purch. Doc. Queue New
Table 9009983 Zetadocs Report Mappings New
Table 9009989 Zetadocs Document Queue New
Table 9009990 Zetadocs Doc. Queue Menu Item New
Table 9009991 Zetadocs Doc. Queue Actions New
Table 9009992 Zetadocs Archive Context New
Table 9009993 Zetadocs Archive Metadata New
Table 9009994 Zetadocs Archive Settings New
Table 9009995 Zetadocs Doc. Q. Iltem Barcode New
Table 9009996 Zetadocs Archive Result New
Table 9009997 Zetadocs Link Result New
Table 9009998 Zetadocs Doc. Queue ltem New
Table 9009999 Zetadocs Related Documents New
Table 9010000 Zetadocs Printed Records New
Table 9010001 Zetadocs Sales Drag & Drop New
Table 9010002 Zetadocs Purchase Drag & Drop New
Form 9009959 Zetadocs System Settings New
Form 9009960 Zetadocs Template Card New
Form 9009961 Zetadocs Template List New
Form 9009962 Zetadocs Sales Document Queue New
Form 9009963 Zetadocs System Rule card New
Form 9009964 Zetadocs Customer Rule Subform New
Form 9009965 Zetadocs Report Settings List New
Form 9009966 Zetadocs Delivery New
Form 9009967 Zetadocs Batch Delivery New
Form 9009968 Zetadocs Batch Errors New
Form 9009969 Zetadocs Document Sets New
Form 9009970 Zetadocs System Rule List New
Form 9009971 Zetadocs Customer Rule Card New
Form 9009972 Zetadocs Customer Rule List New
Form 9009973 Zetadocs No. Series New
Form 9009974 Zetadocs Sales Doc Queue Setup New
Form 9009975 Zetadocs Printer Reminder New
Form 9009976 Zetadocs Vendor Rule Subform New
Form 9009977 Zetadocs Vendor Rule Card New
Form 9009978 Zetadocs Vendor Rule List New
Form 9009979 Zetadocs Report Settings Card New
Form 9009980 Zetadocs Company Type List New
Form 9009981 Zetadocs Configuration Import New
Form 9009982 Zetadocs Purch. Document Queue New
Form 9009983 Zetadocs Purch Doc Queue Setup New
Form 9009984 Zetadocs Document Set Card New
Form 9009985 Zetadocs About Box New
Form 9009986 Zetadocs Sys. Rul Rep. Subform New
Form 9009987 Zetadocs Cus. Rul Rep. Subform New
Form 9009988 Zetadocs Ven. Rul Rcp. Subform New
Form 9009989 Zetadocs Cust. Rule Cont. Info New
Form 9009990 Zetadocs Cust. Rule Temp. Info New
Form 9009991 Zetadocs Vend. Rule Cont. Info New
Form 9009992 Zetadocs Vend. Rule Temp. Info New
Form 9009993 Zetadocs Cus. Add Rep. Info. New
Form 9009994 Zetadocs Ven. Add Rcp. Info. New
Form 9009995 Zetadocs Delivery Edit New
Form 0009996 Zetadocs Report Mappings List New
Form 9009997 Zetadocs Report Mappings Card New
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Type ID NAME Status
Form 9009998 Zetadocs Report Selections New
Form 9009999 Zetadocs Configuration Export New
Form 9010000 Zetadocs Document Queue New
Form 9010001 Zetadocs Doc. Queue Select New
Form 9010002 Zetadocs Doc. Queue Action Sel New
Form 9010003 Zetadocs Document Queue Card New
Form 9010004 Zetadocs Document Queue List New
Form 9010005 Zetadocs Doc Q Menu Items Sub New
Form 9010006 Zetadocs Doc. Queue Actions New
Form 9010007 Zetadocs Related Documents New
Form 9010008 Zetadocs Sales Capture Setup New
Form 9010009 Zetadocs Purch Capture Setup New
XMLPort 9009959 Zetadocs Xml Port New
Codeunit 9009959 Zetadocs-Utilities New
Codeunit 9009960 Zetadocs-Send Results Gen New
Codeunit 9009962 Zetadocs-Send Customize New
Codeunit 9009963 Zetadocs-Send Integration New
Codeunit 9009964 Zetadocs-Capture Customize New
Codeunit 9009965 Zetadocs-Capture Integration New
Codeunit 9009970 Zetadocs-Capture New
Codeunit 9009971 Zetadocs-Report Printing New
Codeunit 9009972 Zetadocs-Import and Export New
Codeunit 9009973 Zetadocs-Automation New
Codeunit 9009974 Zetadocs-Send New
Menusuite 55 Zetadocs for NAV New
NAV 6.01 Objects:

Type 1D NAME Status

Page 9009961 Zetadocs Template List New

Page 9009962 Zetadocs Sales Document Queue New

Page 9009966 Zetadocs Delivery New

Page 9009967 Zetadocs Batch Delivery New

Page 9009968 Zetadocs Batch Errors New

Page 9009969 Zetadocs Document Sets New

Page 9009971 Zetadocs Customer Rule Card New

Page 9009972 Zetadocs Customer Rule List New

Page 9009975 Zetadocs Printer Reminder New

Page 9009977 Zetadocs Vendor Rule Card New

Page 9009978 Zetadocs Vendor Rule List New

Page 0009982 Zetadocs Purch. Document Queue | New

Page 9009985 Zetadocs About Box New

Page 9009987 Zetadocs Cus. Rul Rcp. Subform New

Page 9009988 Zetadocs Ven. Rul Rcp. Subform New

Page 9009989 Zetadocs Cust. Rule Cont. Info New

Page 9009990 Zetadocs Cust. Rule Temp. Info New

Page 9009991 Zetadocs Vend. Rule Cont. Info New

Page 0009992 Zetadocs Vend. Rule Temp. Info New

Page 9009993 Zetadocs Cus. Add Rep. Info. New

Page 9009994 Zetadocs Ven. Add Rcp. Info. New

Page 9009995 Zetadocs Delivery Edit New

Page 9010000 Zetadocs Document Queue New

Page 9010001 Zetadocs Doc. Queue Select New

Page 9010002 Zetadocs Doc. Queue Action Sel New

Page 0010003 Zetadocs Related Documents List New

Page 9010007 Zetadocs Related Documents New

Existing Objects:
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Type ID ' NAME Status

Table 18 Customer Modified
Table 36 Sales Header Modified
Table 112 Sales Invoice Header Modified
Table 114 Sales Cr.Memo Header Modified
Table 110 Sales Shipment Header Modified
Table 6660 Return Receipt Header Modified
Table 23 Vendor Modified
Table 38 Purchase Header Modified
Table 122 Purch. Inv. Header Modified
Table 124 Purch. Cr. Memo Hdr. Modified
Table 120 Purch. Rcpt. Header Modified
Table 6650 Return Shipment Header Modified
Form 21 Customer Card Modified
Form 41 Sales Quote Modified
Form 42 Sales Order Modified
Form 43 Sales Invoice Modified
Form 44 Sales Credit Memo Modified
Form 507 Blanket Sales Order Modified
Form 6630 Sales Return Order Modified
Form 130 Posted Sales Shipment Modified
Form 132 Posted Sales Invoice Modified
Form 134 Posted Sales Credit Memo Modified
Form 6660 Posted Return Receipt Modified
Form 26 Vendor Card Modified
Form 49 Purchase Quote Modified
Form 50 Purchase Order Modified
Form 51 Purchase Invoice Modified
Form 52 Purchase Credit Memo Modified
Form 509 Blanket Purchase Order Modified
Form 6640 Purchase Return Order Modified
Form 138 Posted Purchase Invoice Modified
Form 6650 Posted Return Shipment Modified
Form 140 Posted Purchase Credit Memo Modified
Form 136 Posted Purchase Receipt Modified
Page 21 Customer Card Modified
Page 26 Vendor Card Modified
Page 41 Sales Quote Modified
Page 42 Sales Order Modified
Page 43 Sales Invoice Modified
Page 44 Sales Credit Memo Modified
Page 49 Purchase Quote Modified
Page 50 Purchase Order Modified
Page 51 Purchase Invoice Modified
Page 52 Purchase Credit Memo Modified
Page 130 Posted Sales Shipment Modified
Page 132 Posted Sales Invoice Modified
Page 134 Posted Sales Credit Memo Modified
Page 136 Posted Purchase Receipt Modified
Page 138 Posted Purchase Invoice Modified
Page 140 Posted Purchase Credit Memo Modified
Page 507 Blanket Sales Order Modified
Page 509 Blanket Purchase Order Modified
Page 6630 Sales Return Order Modified
Page 6640 Purchase Return Order Modified
Page 6650 Posted Return Shipment Modified
Page 6660 Posted Return Receipt Modified
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26.3 Zetadocs for NAV Menusuite
The menusuite changes listed here are a general guideline for giving regular or administrator NAV user’s
access to the Zetadocs features and configuration forms. It is up to the installer what level of access
permissions are given to configuration forms after they finish the installation. It is assumed, that in
situations where a system administrator in the client company has an understanding of the Zetadocs for
NAV system and is capable of editing the rules and settings, that access to these forms would remain for
the system administrator after installation.
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The following table shows the list of menu items and groups to be created using the Navigation Pane
Designer (Alt + F12) for configuration. As mentioned before, it may be preferable to remove some of the
items on completion of installation and configuration. This is should be decided by the installer.

Type Caption Location Object Type and ID

Group Zetadocs Setup Administration\Application Setup
(Group)

Item Zetadocs No. Series Administration\Application Form 9009973 — Zetadocs No. Series
Setup\Zetadocs Setup (Group)

Item Zetadocs System Settings Administration\Application Form 9009959 — Zetadocs System Settings
Setup\Zetadocs Setup (Group)

Item Zetadocs Templates Administration\Application Form 9009960 — Zetadocs Template Card
Setup\Zetadocs Setup (Group)

Item Zetadocs Document Sets Administration\Application Form 9009984 — Zetadocs Document Set Card
Setup\Zetadocs Setup (Group)

Item Zetadocs System Rules Administration\Application Form 9009963 —Zetadocs System Rule Card
Setup\Zetadocs Setup (Group)

Item Zetadocs Customer Rules Administration\Application Form 9009971 — Zetadocs Customer Rule Card
Setup\Zetadocs Setup (Group)

Item Zetadocs Vendor Rules Administration\Application Form 9009977 —Zetadocs Vendor Rule Card
Setup\Zetadocs Setup (Group)

Item Zetadocs Report Settings Administration\Application Form 9009965 — Zetadocs Report Settings
Setup\Zetadocs Setup (Group)

Item Zetadocs Sales Doc. Queue Administration\Application Form 9009974 —Zetadocs Sales Doc Queue

Setup Setup\Zetadocs Setup (Group) Setup
Item Zetadocs Purch. Doc. Queue Administration\Application Form 9009983 — Zetadocs Purch Doc Queue
Setup Setup\Zetadocs Setup (Group) Setup

Item Zetadocs Company Types Administration\Application Form 9009980 — Zetadocs Company Type List
Setup\Zetadocs Setup (Group)

Item Zetadocs Configuration Import Administration\Application Form 9009981 — Zetadocs Configuration Import
Setup\Zetadocs Setup (Group)

Item About Zetadocs for NAV Administrator\Application Form 9009985 — Zetadocs About Box
Setup\Zetadocs Setup (Group)

Zetadocs for NAV Role Tailored Client Menusuite Changes

Type Caption ‘ Location Object Type and ID

Group Zetadocs Setup Administration\Application Setup
(Group)

Item Zetadocs Customer Rules Administration\Application Page 9009971 — Zetadocs Customer Rule Card
Setup\Zetadocs Setup (Group)

Item Zetadocs Vendor Rules Administration\Application Page 9009977 —Zetadocs Vendor Rule Card
Setup\Zetadocs Setup (Group)
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Type ‘ Caption ‘ Location Object Type and ID

Item About Zetadocs for NAV Administrator\Application Page 9009985 — Zetadocs About Box
Setup\Zetadocs Setup (Group)

26.4 Installing in a Terminal Services Environment
Follow the steps below to ensure successful installation in a Terminal Services Environment.

Overview of Installation:

e Checking that your scenario is supported.

e Ensureyou are logged in as an Administrator.

e Ensure the Terminal Server is set to Application Server/Terminal Server mode.

e Ensure the permissions are granted to install kernel-mode printer drivers on Windows 2003
systems.

e Install the Zetadocs Client through Add/Remove programs (directly on the terminal server and not
from within an RDP session). NOTE: this pre-requisite of the Zetadocs NAV client needs to be
installed separately to ensure the printer driver install correctly.

e Install the Zetadocs NAV client through Add/Remove programs (directly on the terminal server and
not from within an RDP session).

e Testing the Zetadocs NAV client.

On some systems due to default Windows security settings, Zetadocs PDF printer drivers are not
automatically installed. The following information will allow you to manually configure these drivers.

Check that your scenario is supported
Firstly you need to verify that your intended scenario is supported.

Supported Scenarios

Remote Session mode

An application (e.g. NAV) and Zetadocs are installed onto the terminal server. A single remote session is
opened onto the server. The user opens an application (e.g. NAV) in the remote session, and prints to the
Zetadocs PDF printer. Zetadocs client will launch automatically within the remote session. Zetadocs is able
to start Microsoft Outlook in the remote session.

Published Application mode

An application (e.g. NAV) and Zetadocs client are installed onto the terminal server. An application (e.g.
NAV) runs as a published application and prints to the Zetadocs PDF printer. In this scenario Zetadocs client
starts up in the same window as the published application. When both applications terminate, the
published application window closes down automatically.

Unsupported Scenarios

Remote mode

An application (e.g. NAV) is installed on a client machine and Zetadocs is installed on the terminal server.
An application (e.g. NAV) is opened on the client but not within a remote session. The client application is
still able to see the shared Zetadocs PDF printer on the remote server. However, the application cannot
print to the printer in this case.

Mixed mode

An application (e.g. NAV) is installed on the terminal server and the Zetadocs client is installed on a client
machine. In this mode, NAV runs as a published application (in a remote session) and prints to the Zetadocs
PDF printer. The user starts up Zetadocs client on the client machine (not in a remote session). In this
scenario the client is unable to pick up the printed files from the server and so this scenario is not
supported.

Ensure you are logged in as an Administrator
Log on to the terminal server system as a user with administrative rights.

Ensure that the Terminal Server is set to Application Server/Terminal Server mode
Before installation, the terminal server must be switched into Terminal Server mode (Windows 2003).
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See http://support.microsoft.com/default.aspx?scid=kb;en-us;306626& sd=tech for more details.

Ensure permissions are granted to install kernel-mode printer drivers (Windows 2003 only)
e From the Start menu select run.

e Inthe run dialog type gpedit.msc and press OK.

Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you.

Open: |

¥

[ o

][ Cancel ][ Browse. .. ]

Figure 80 — Run window

e Browse to the disallow installation of printers using kernel-mode drivers option in Computer
configurationlAdminstrative TemplatesIPrinters:

Fle  Adion  View Heb

- OB FEB R

5 Local Computer Polcy
= 3 Compuser Corlipur stion
+ ] Softwars Sattings

ke |
+ () Windows Settings Disallow installation of printers Satting
= ) Admnstrative Templotes | U3in0 kernel-mode drivers £5 Adow privters to be ublihed Not cenfapred
% 20 Windows Componeets | ooy orccnne “@WMdMunm Not configured
) Microscit Outlook 2000 @mmmwmun«mmmnay Not configured
+ 2 System Qaguemants: ﬁ!ow.awgae Not configured
+ ) Network AL least Mcrosoft Windows P Comguter location Not configured
=3 Printers mm" Sows Server 2003 Q(mwtmnhhﬁo;fdﬂ«'.«utm Not conbigured
= agwc«fw&m Qm«lwmnmd ot cerbrpred
+ ) Software Sattiers g::auxm: 13 Drectory prurwg priceRy Nt condapred
+ ) Windows Settings erenes whether prinbers using 3
2 st s | bevnetmods & % may b istalled @Dnaayv«ry , ccrh@a
Administy '"W on the local computer. Kernebmode Dxsaliow installation of prirters usng kerned-mode drivers Yot conf\oured
dricers hyve m 10 $y2errwnde 511 Log drectory pruning retry events Not configured
memory, and ore poorky- X
orressd ‘ poerty & Pre-popudate peinter search location text Mot configured
Caise 0P eerees. Printer trowsing Not configured
Prune prickers that are not sutomatically repubished Mot conbgured
fmﬁ%uﬁzﬂ Alow Priek: Spocler to SC0ept chent Crnmctions ot confagured
vt o Givers may be italed 1N Web based prntng Mot corfigured
on the locsl compater rurning
Windows 3P Mome Edtion and
Windows 1P Professonsl
If you do not corfigure thes satting on
Windows Server 2003 famdy
products, the nstalstion of kernel-
mode prinker drivers will be blocked. v
< > \ Extended A Standard /

Figure 81 - Group Policy

e Use the right click menu to open the Properties dialog.
e Set this option to Disabled and select OK.
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Disallow installation of printers using kernel-mode dr...

Setting | Explain|

@ Disallow installation of printers using kemel-mode drivers

(O Not Configured
(O Enabled

Supported on: At least Microsoft Windows XP Professional or Windo...

[ Previous Setting ][ Next Setting ]

[ oK ][ Cancel ][ Apply

Figure 82 - Properties

Install Zetadocs Client through Add/Remove programs
Note: Installing the Zetadocs Client application and printers should be done by logging onto the terminal
server system and not via a terminal session.

e Start the Add or Remove Programs control panel applet.

e Click on Add New Programs then click on the CD or Floppy. (as below)
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% Add or Remove Programs

Add a program From CO-ROM or floppy disk
L. To add 3 program from & CD-ROM or floppry disk, chick CD or Floppy

B

Add programs froem Microsoft
4 To add new Windows festures, device drivers, and system updates aver the Internet, cick Windows Update I

Windows Update

Figure 83 — Add Remove Programs

e When prompted to insert a program disk, click Next then Browse.

Install Program From Floppy Disk or CD-ROM 5[

Insert the product's first installation floppy disk or CD-ROM,
and then click Next.

Figure 84 — Start Installation Program
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Run Installation Program i X|

YWindows was unable to find the installation program. Click
Back to try again. Click Browse to find the installation
program manually.

Dpen:

Browse... I

| < Back I Finish Cancel

Figure 85 — Run Installation Program Dialog

e Locate the file setup.exe of the Zetadocs Client installer. This will be found in the ISSPrerequisite
folder of the Zetadocs for NAV Client folder. Be sure to select the x86 or x64 version as appropriate.
Select it and click the Open button.

Path x86:
D:\Zetadocs NAV Client\ISSetupPrerequisites\{FE8A4B83-A2F6-43AB-BCo1-0301F92AF5E8}\Setup.exe

Path x64:
D:\Zetadocs NAV Client x64\ISSetupPrerequisites\{65D64B11-D27D-4F67-8C36-92BC6759EEFs5}\Setup.exe

e On the Run Installation Program dialog box, click Next.
e |f prompted with an Open File — Security Warning click Run.

Open File - Security Warning x|

The publisher could not be verified. Are you sure you want to
run this software?

Fﬁ Name: setup.exe
Publisher: Unknown Publisher
Type: Application
From: \\Ruby_server\BuildiQARelease}Zetadocs PDF\200, ..

publisher. You should only run software from publishers you trust.

@ This file does not have a valid digital signature that verifies its
How can | decide what software to run?
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Figure 86 — Security Warning

e Zetadocs client should install successfully. Please see chapter 6 for further details on the Zetadocs
client install process.
e  Click Finish to complete the installation.
e Click Next on the Windows After Installation dialog box. Then Finish.
e To verify the Zetadocs printer has installed correctly, browse to the Printers and Faxes folder, there
should be a Zetadocs printer installed.
Note: If the installation of Zetadocs client has failed for some reason, please refer to the following Microsoft
TechNet article:

http://www.microsoft.com/technet/prodtechnol/windowsserver2o03/library/ServerHelp/447dad75-28fs5-
4699-80f8-17ad2359ba66.mspx

e  Publish Microsoft NAV for use with Zetadocs Client.

e  On the Citrix server, run Citrix Access Management Console from Start | All Programs | Citrix |
Management Consoles.

e Expand Citrix Resources | Presentation Server | < Citrix farm>

l:! Citrix Access Management Console

File Action View Help
&= | BAMEBe R @
EE Citrix Access Management Console
Zﬂ Alerts
1 (__j Search Results
LT My Views
fuief J Report Center
| Licensing
Dlagnostlc Facility
E@ Citrix Resources
{#> Configuration Tools
: @ Presentation Server
= ﬁj,‘ EquisysFarm
&Z} Administrators
- _; Applications
[+ Servers
&7 Zones
2 gg, Monitoring Configuration

Figure 87 - Citrix Access Management Console

e Right click on Applications and select New | Publish Application.

e Give the published application a name and description. Click Next.

e Choose Application and Access from server. Click Next.

¢ You will now need to browse to your Microsoft NAV executable. The default path is C:\Program
Files\Microsoft Dynamics NAV\CSIDE Client\fin.exe (or finsgl.exe depending on whether you are
running the SQL version). Click Next.

e Choose a Citrix server which will publish the application. Click Next.

e Enable the users and/or groups who can access the published application. Click Next.

e Continue with the wizard enabling any features you wish to use. Click on Finish at the end.

Install Zetadocs NAV Client through Add/Remove programs
Now you must repeat the process used to install the Zetadocs for NAV Client.
e Start the Add or Remove Programs control panel applet.
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e Click on Add New Programs then click on the CD or Floppy.

e Locate the file Setup-All.exe/Setup-Capture.exe/Setup-Delivery.exe as applicable to your version
of the software required. This will be found in the Zetadocs NAV Client folder. Be sure to select the
x86 or x64 version as appropriate. Select it and click the Open button.

e On the Run Installation Program dialog box, click Next.

e |f prompted with an Open File — Security Warning click Run.

e Zetadocs for NAV Client should install successfully.

e  Click Finish to complete the installation.

e Click Next on the Windows After Installation dialog box. Then Finish.

Complete the Installation by continuing from chapter 7
To complete your system setup please continue from chapter 7 the Zetadocs for NAV connector.

Setup printer session settings modifier
Depending on your system configuration choose between A or B below.

A: Terminal Services or Citrix Published Desktop: Create printer settings modifier short-cut.

e Browse to the Zetadocs for NAV Client install folder. By default this is “C:\Program Files\Zetadocs
NAV”

e Right-click PrinterSettingsModifier and select “Create Short-cut”.

e Right click the new short-cut and select properties.

e Inthe “Target” field add the path to the ZdNAVSetting.xml file in the install folder. By default this is
“C:\Program Files\Zetadocs NAV\ZdNAVSettings.xml”. Your resulting target value should look like
this:

“C:\Program Files\Zetadocs NAV\PrinterSettingsModifier.exe” “C:\Program Files\Zetadocs
NAV\ZdNAVSettings.xml”

e C(lick OK and select the “PrinterSettingsModifier” shortcut.

e Use Ctrl+C to copy to the clip board.

e Browse to the All Users, Start-up folder. By default this is “C:\Documents and Settings\All
Users\Start Menu\Programs\Startup” on 2003 and
“C:\Users\Default\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup” on 2008,
create it if it does not exist.

e Use Ctrl+V to paste the shortcut.

This will cause the Zetadocs Automation Subsystem printer settings to be modified for each session to the
correct values to work with Zetadocs for NAV for the current user.

B: Citrix - Published Application: Publish Microsoft NAV for use with Zetadocs Client.

e  On the Citrix server, run Citrix Access Management Console from Start | All Programs | Citrix |
Management Consoles.
e Expand Citrix Resources | Presentation Server | - Citrix farm--
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Right click on Applications and select New | Publish Application.
Give the published application a name and description. Click Next.
Choose Application and Access from server. Click Next.

You will now need to set the application path as follows:

< Zetadocs NAV> \PrintSettingsModlifier.exe < Zetadocs NAV> \ ZdNAVSettings.xml < NAV> \fin.exe
Where:

< Zetadocs NAV> is the install folder for the Zetadocs for NAV Client. The default path is “C:\Program
Files\Zetadocs NAV”

< NAV> is the install folder for the NAV C/SIDE client. The default path is “C:\Program Files\Microsoft
Dynamics NAV\CSIDE Client\fin.exe (or finsql.exe depending on whether you are running the SQL
version).

E.G. “C:\Program Files\Zetadocs NAV\PrinterSettingsModifier.exe” “C:\Program Files\Zetadocs
NAVAZdNAVSettings.xml” “C:\Program Files\Microsoft Dynamics NAV\CSIDE Client\fin.exe”

Click Next.

Choose a Citrix server which will publish the application. Click Next.
Enable the users and/or groups who can access the published application. Click Next.
Continue with the wizard enabling any features you wish to use. Click on Finish at the end.

Test the Zetadocs Client from a Published Application
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Run Program Neighbourhood from Start | Programs | Citrix | Citrix Access Clients | Program
Neighbourhood.

Open Microsoft NAV. Create a sample document by printing from a report which has been modified
for Zetadocs for NAV.

Print your sample document to the Zetadocs PDF printer.
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e Once the document has been successfully printed Zetadocs client will be started and the printed
document will appear in the document explorer window.
e Send the document via email, hard copy or fax.
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